Note

Before using this information and the product it supports, read the information in "Notices" on page 141.

This edition applies to version 5, release 1, modification 1 of the IBM Tivoli OMEGAMON XE products and to version 6, release 3, Fix Pack 1 of IBM Tivoli Management Services on z/OS (product number 5698-A79) and to all subsequent releases and modifications until otherwise indicated in new editions.

© Copyright IBM Corporation 2012, 2013.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Figures ........................................ v
Tables .......................................... vii

Chapter 1. About this publication ...... 1
Service Management Connect .......... 1

Chapter 2. Product overview ........ 3
New in this release ......................... 3
Configuration .............................. 4
Supported emulators and screen sizes ... 4
Logging on and off ......................... 4
Logging on .................................. 4
Logging off ................................ 5
Security .................................. 6
Getting help ............................... 7

Chapter 3. Workspaces .............. 9
Parts of the workspace ............... 9
Menus .................................. 13
Status indicators ....................... 15
Workspace colors ....................... 16
Help for column headings ......... 17
Screen operations ..................... 17
Action codes .......................... 17
Take Action commands .............. 18
Scrolling ............................... 19
Lateral column scrolling ......... 20
Selecting ............................... 20
Sorting ................................. 21
Filtering ................................ 22
Minimizing and maximizing subpanels ... 23
Collapsing and expanding subpanels ... 24
Closing subpanels .................. 24
Changing context .................... 24
Auto Update ........................... 25
Workspace navigation .......... 26
Zooming ............................... 26
Where am I? .......................... 26

Chapter 4. User Preferences .... 27
Customizing a user profile ........ 27
Customizing KOBSITEC as the initial workspace ... 29
Logon administration and customization ... 30

Chapter 5. Customization ...... 35
Customizing workspaces ........... 35
Workspace viewing and cloning ... 35
Cloning a workspace .................. 36
Browsing, locating and cloning a workspace ... 37
Customization of product provided workspaces ... 40
Modifying the initial workspace ... 42
Customizing a workspace .......... 43
Changing a workspace and subpanel header ... 45
Changing the order of displayed columns ... 47
Changing a column caption and width ... 48
Removing a subpanel ................ 50
Adjusting the filterable columns ... 51
Other workspace customization ... 52
Customizing status indicators ... 56
Modifying predefined thresholds ... 56
Threshold viewing and cloning ... 56
Customizing thresholds .......... 57
Cloning Thresholds .................. 59
Disabling thresholds .......... 61
Syntax for threshold specification ... 61

Chapter 6. Administration ...... 67
Runtime environment viewing .... 67
Viewing a workspace source ...... 69
Customizing the interface ..... 69
Interface profiles ..................... 69
Creating a custom interface profile ... 70
Profile viewing and cloning ....... 70
Cloning a Profile .................... 71
Locale profiles ....................... 74
Creating a custom locale profile ... 74
Locale profile keywords .......... 74
Hub connectivity administration ... 75
Validate a requested hub Tivoli Enterprise Monitoring Server ..... 75
Logon administration and customization ... 76
Correcting a failed hub server connection ... 78
Changing a hub server connection ... 81
The All Known Hubs workspace .... 83
Displaying hub overview status ... 87
Displaying products installed on a hub ... 88
Displaying Managed System Names (MSN) for a hub ... 89
Displaying Managed System Lists (MSL) for a hub ... 90
Displaying Data Retrieval Agents (DRA) for a hub ... 91
Displaying hub topology .......... 92

Appendix A. About panels .......... 95
Workspace panel definitions ........ 96
Popup panel definitions .......... 98
Guidelines for constructing panel definitions ... 99
Panel definition keywords .......... 100
Workspace keywords .......... 100
CURSOR .................................. 100
CURSORREFRESH .................... 100
HEADER (workspace) .............. 101
IMBED ................................ 101
MODE (workspace) ................. 101
NAV1TEXT ........................... 102
NAV2TEXT ........................... 102
QUERYWHEN (workspace) .... 102

© Copyright IBM Corp. 2012, 2013
Whennoheader .......... 1 0 3
Whennotext .......... 1 0 3
Subpanel keywords .......... 1 0 3
Action .......... 1 0 3
Autoselect .......... 1 0 4
Boxtop .......... 1 0 4
Boxbottom .......... 1 0 4
Colheaders .......... 1 0 4
Columns .......... 1 0 5
Columns152 .......... 1 0 5
Columns160 .......... 1 0 5
Displaycols .......... 1 0 6
Displayoption .......... 1 0 8
Expandcolaps .......... 1 0 9
Filtercols .......... 1 0 9
Filternullval .......... 1 1 0
Filterstrip .......... 1 1 0
Filterview .......... 1 1 0
Filterviews .......... 1 1 1
Filterwhere .......... 1 1 1
Footer .......... 1 1 2
Header (subpanel) .......... 1 1 2
Joinprev .......... 1 1 2
Keycols .......... 1 1 2
Lines .......... 1 1 3
Minmax .......... 1 1 3
Mode (subpanel) .......... 1 1 4
Name .......... 1 1 4
Partialcols .......... 1 1 4
Query .......... 1 1 4
Querytimeout .......... 1 1 5
Querytype .......... 1 1 5
Querywhen (subpanel) .......... 1 1 6
Scrollbar .......... 1 1 6
Scrollcols .......... 1 1 6
Scrollrows .......... 1 1 7
Skip .......... 1 1 7
Sortcols .......... 1 1 7
Space .......... 1 1 7
Startcolaps .......... 1 1 7
Startmin .......... 1 1 8
Staticcols .......... 1 1 8
Statuscols .......... 1 1 8
Text .......... 1 1 8
Tofromheader .......... 1 1 9
Type .......... 1 1 8
Vseparators .......... 1 1 9
Whendata .......... 1 1 9
Whennodata .......... 1 1 9
Zoomcols .......... 1 1 9
Popup keywords .......... 1 2 3
Displaywhen .......... 1 2 4
Querywhen (popup panel) .......... 1 2 4
Variables in panel definitions .......... 1 2 4
Variable representation .......... 1 2 4
System variables .......... 1 2 4
User-defined variables .......... 1 2 7
Supported ISPF statements .......... 1 2 8
Appendix B. Tags for formatting text 131
Appendix C. Accessibility features for OMEGAMON enhanced 3270 user interface 133
Appendix D. Associating a mouse click with the Enter key 135
Documentation library 137
Shared OMEGAMON XE publications 137
IBM Tivoli Monitoring library 138
Documentation for the base agents 139
Other sources of documentation 139
Notices 141
Trademarks 142
Privacy policy considerations 142
Index 145
Figures

1. Security system denied request message ........................................ 7
2. Workspace with detail and summary subpanels ................................ 10
3. Minimize bar with ECSA subpanel minimized to bar and MORE indicator with down arrow .... 12
4. Column heading help ................................................................. 17
5. Workspace with collapsed subpanel ............................................. 24
6. User Profile Member workspace .................................................. 27
7. User Profile Member workspace .................................................. 29
8. ITM Situation Status & Message log workspace ................................ 30
9. Hub Connectivity Administration workspace that shows a hub connection is not specified for the current profile ........................................... 31
10. Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace ......................... 32
11. Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection ............................................................. 33
12. Identify the workspace name .......................................................... 36
13. Cloning a workspace by using the File > Save As menu option ............... 36
14. Cloning a workspace - the Member Save As dialog box ......................... 37
15. Runtime Environment (Workspaces), locating the workspace member .......... 38
16. Cloning a workspace by using the File > Save As menu option ............... 39
17. Cloning a workspace - the Member Save As dialog box ......................... 39
18. User workspace data set that shows a cloned workspace ........................ 40
19. A cloned workspace is denoted by an asterisk character (*) after the workspace name ........ 40
20. A cloned workspace is denoted by an asterisk (*) after the workspace name ........ 43
21. Workspace source view of the product provided ITM Situation Status & Message Log (KOBSITEC) workspace ............................................ 44
22. Customized workspace view that shows updated workspace and subpanel headings for the ITM Situation Status & Message Log (KOBSITEC) workspace ............................................ 46
23. Customized workspace view that shows the MSN Event Source moved to the second column position .... 48
24. Customized workspace view that shows a column with a modified caption and width .... 49
25. Customized workspace view that shows the second subpanel removed from the (KOBSITEC) workspace ............................................ 51
26. Filter dialog pop-up that shows the added filter column ......................... 52
27. Runtime Environment (Configuration), locating the threshold member ............ 59
28. Cloning a threshold member by using the File > Save As menu option .................. 60
29. Cloning a threshold member - the Member Save As dialog box .................... 60
30. User threshold data set that shows a cloned profile ................................ 61
31. Runtime Environment workspace ................................................ 67
32. Data Set Information workspace ............................................... 68
33. Partitioned Dataset Summary workspace ........................................ 68
34. Lateral navigation push-buttons .................................................. 69
35. Runtime Environment (Profiles), locating the profile member ....................... 72
36. Cloning a profile by using the File > Save As menu option ....................... 72
37. Cloning a profile - the Member Save As dialog box ................................ 73
38. User profile data set that shows a cloned profile ................................... 73
39. CUADATA profile definition shown during the configuration process at installation time .... 76
40. Hub Connectivity Administration workspace that shows a hub connection is not specified for the current profile ........................................... 77
41. Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace ......................... 77
42. Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection ............................................................. 78
43. Hub Connectivity Administration workspace that shows a connectivity failure ............. 79
44. Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace ......................... 80
45. Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection ............................................................. 81
46. Hub Connectivity Administration workspace that shows an existing hub connection ........ 82
47. Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace ......................... 82
48. Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection ............................................................. 83
49. Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace ......................... 84
50. Hub Overview (KOBHBSTO) workspace ........................................ 88
51. Installed TEMS Applications (KOBAPPs) workspace ................................ 89
52. Managed Systems (KOBHBMSN) workspace .................................... 90
53. Managed System Lists (KOBHBMISL) workspace ................................ 91
54. Data Retrieval Agents (KOBHBDRA) workspace ................................ 92
55. Hub Topology workspace ......................................................... 93
56. A workspace with several subpanels ............................................ 95
57. Workspace with popup panel ..................................................... 95
58. Example of a popup panel definition ............................................ 99
## Tables

1. Example filter entries in the **Options** field. 93
2. ISPF variables supported by the enhanced 3270 interface 124
3. Supported OMEGAMON variables 125
4. Supported HTML tags 131
5. Non-HTML formatting tags 131
Chapter 1. About this publication

This publication describes how to use the OMEGAMON® enhanced 3270 user interface. Following a product overview and description of workspaces, the document progresses through user preferences, customization, and administration tasks.

After you read this publication, you should be able to use the enhanced 3270 user interface with OMEGAMON XE monitoring agents to monitor the performance of z/OS® systems, applications, and devices. You will also learn how to customize the interface to suit your requirements.

For more information about the technical changes in this edition, see “New in this release” on page 3.

Who should read this publication

This publication is for users, subject matter experts, and administrators of the enhanced 3270 user interface.

Service Management Connect

Connect, learn, and share with Service Management professionals: product support technical experts who provide their perspectives and expertise.

Use Service Management Connect in the following ways:

• Become involved with transparent development, an ongoing, open engagement between other users and IBM® developers of Tivoli® products. You can access early designs, sprint demonstrations, product roadmaps, and prerelease code.

• Connect one-on-one with the experts to collaborate and network about Tivoli and the (enter your community name here) community.

• Read blogs to benefit from the expertise and experience of others.

• Use wikis and forums to collaborate with the broader user community.
Chapter 2. Product overview

The OMEGAMON enhanced 3270 user interface is the latest generation of user interfaces for the
OMEGAMON monitoring products. Used in conjunction with OMEGAMON XE monitoring agents and
the Tivoli Enterprise Monitoring Server, you can use the enhanced 3270 user interface to monitor the
performance of the z/OS systems, applications, and devices in your environment and helps you identify
and troubleshoot problems with those monitored resources.

The enhanced 3270 user interface offers the following features:
- Plex-wide as well as single system views of data
- Autodiscovery of and autoconnection to data sources
- Dynamic behavior and operation
- Support for screen sizes up to 62 x 160
- User-customizable workspaces
- Data filtering
- Lateral and vertical scrolling
- Sorting by column

The monitoring products that support the enhanced 3270 user interface provide predefined workspaces
that you can use to quickly and easily diagnose problems with monitored resources and take action to
correct them. You can customize the workspaces to suit your requirements, and design and create your
own workspaces and navigation.

Because the enhanced 3270 user interface exploits data collected by OMEGAMON XE monitoring agents,
viewing data in the interface requires that at least one Tivoli Enterprise Monitoring Server is installed in
your environment, along with monitoring agents that support the interface. In the interface, data is
presented in workspaces. When you navigate to a workspace, one or more data queries are sent to the
Tivoli Enterprise Monitoring Server. The monitoring server collects the data from the target agent or
agents and sends the data to the interface for display.

New in this release

The following enhancements have been made to the enhanced 3270 user interface since the previous
version.
- Security authorization checks have been extended and enhanced. For more information, see “Security” on page 6.
- User preferences can be customized by using the User Profile Member workspace. For more information, see “Customizing a user profile” on page 27.
- You can use the new KOBSITEC workspace to display IBM Tivoli Monitoring Situations status
  information in the enhanced 3270 user interface. The status information is similar to the information
  provided by the Tivoli Enterprise Portal Situation Event Console, that is, situation status for current
  situations events and situation event history. For more information, see “Customizing KOBSITEC as the
  initial workspace” on page 29.
- Workspaces are introduced to support viewing and browsing the Runtime environment (RTE). For more information, see “Runtime environment viewing” on page 67.
- Workspace source can be viewed and browsed. For more information, see “Viewing a workspace source” on page 69.
- Cloning and customization
The capability to view and copy product provided workspaces, thresholds, and profiles is introduced. You modify workspaces, thresholds, and profiles by first cloning (making a copy) and then editing the copy by using a file editor such as the ISPF editor. For more information, see "Workspace viewing and cloning" on page 35, "Threshold viewing and cloning" on page 56, and "Profile viewing and cloning" on page 70.

Guidance on the customization of product provided workspaces is included. For more information, see "Customization of product provided workspaces" on page 40.

- The action bar has updated menu and context-sensitive capabilities. For more information, see "Menus" on page 13.
- The User Interface drawer is introduced. For more information, see "Drawer" on page 12.
- Hub connectivity administration is used to validate that a requested hub Tivoli Enterprise Monitoring Server is reachable through a TCP/IP connection during the operation of the OMEGAMON enhanced 3270 user interface. For more information, see "Hub connectivity administration" on page 75.

Configuration

The enhanced 3270 user interface is controlled and configured by a set of runtime libraries and parameter files. The configuration process defines the address space controls and logical VTAM connections required to run the interface.

The interface can be configured by using either the PARMGEN or the Configuration Tool method. See the IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: Common Planning and Configuration Guide for instructions on configuring the interface. See Chapter 6, “Administration,” on page 67 for information on customizing interface settings and modifying workspaces.

Supported emulators and screen sizes

The enhanced 3270 user interface can be used with any 3270 emulator that supports the APL character set. The interface supports screen sizes of 24 x 80, 32 x 80, 43 x 80, 27 x 132, and 62 x 160.

Although a 24 x 80 screen size is supported, given its limited area, use a larger screen size if possible. The minimum suggested screen size is 43 x 80.

Note: Some (non-IBM) emulators can require LOGMODE settings such as D4A32XX3.

Logging on and off

The enhanced 3270 user interface supports authorization, when you log on. A valid user ID defined to the security system in force on the system is required. Typically, this ID is a TSO ID.

Logging on

You log on to the enhanced 3270 user interface by using its Applid (for example, LOGON APPLID(OMEGUI)), and then enter your user ID and password at the logon panel. Typically, this ID is the TSO user ID. Your site might also require a group name and password. The interface also supports a pass phrase of 9 or more characters, up to the available screen width.

Before you begin

The enhanced 3270 user interface address space, the OMEGAMON XE monitoring agents for which you want data, and the hub Tivoli Enterprise Monitoring Server from which you will be requesting data, must be started before you log on to the interface. If security is configured for the interface, you need a user ID. The user ID must be defined to the system authorization facility (SAF) and can be different from the ID used to log on to the Tivoli Enterprise Portal interface.
About this task

To log on, use the following procedure:

Procedure

1. Start a new VTAM 3270 session.
2. At the VTAM logon panel, enter the following command:
   
   LOGON APPLID(applid)
   
   where applid is the VTAM Applid that is assigned to the enhanced 3270 user interface address space. The enhanced 3270 user interface logon panel is displayed:

   ![Logon Panel](image)

   Note: Security class OMEGAMON. Authentication only.

3. Enter your user ID and password (typically, this ID is one of your TSO IDs). Mixed-case IDs are supported. The interface also supports pass phrases up to the available width of the screen. Your site can also require a group name and password.

4. Press Enter. The initial workspace is displayed. By default, you see an overview workspace for all installed products that support the user interface (KOBSTART). However, a different initial workspace might be specified in your site or user profile. If a hub monitoring server is not specified in your profile, the Hub Connectivity Administration workspace is displayed. For more information, see “Logon administration and customization” on page 30.

Logging off

There are several ways to log off from the enhanced 3270 interface. Use any of the methods described.

Procedure

- From the action line or the command line of any workspace, enter EXIT, LOGOFF, QUIT, or \X.
- From the initial logon workspace, press F3 to display an Exit menu with the choice of exiting or resuming. Enter 1 or \x to exit, or 2 or R to resume working with the interface.
- From the File menu, select Exit, then press Enter.
Security

The enhanced 3270 user interface authenticates user identity by using the system authorization facility (SAF) interface. All authentication or authorization failures are logged. All Take Action requests are logged.

System Authorization Facility

The existence of the SAF user ID and its validity are always checked. The enhanced 3270 user interface also runs a number of SAF authorization checks to check whether the user has authority to do the following activities:

- Log on to this instance of the enhanced 3270 user interface
- End User activities
  - View data for a specific attribute group (table) on a specific managed system
  - Transmit a Take Action request to a specific managed system
  - Change auto-update preferences
  - Entry of any command on the command line
  - Create and modify a profile member name with the same name as the user ID of the user
  - Use a specific hub Tivoli Enterprise Monitoring Server
- Administrative activities
  - List enhanced 3270 user interface users
  - Save a data set member
  - Start or stop user interface tracing
  - Start or stop internal tracing
  - Modify (Save As) any PDS member that is named with a different user ID to that of the current user

User permissions and the amount of security that is imposed are assigned by site administrators. Authorization works as follows:

- If no SAF security class is supplied (value for RTE_SECURITY_CLASS is missing or blank), users can log on to the OMEGAMON enhanced 3270 user interface, can access data through queries, but cannot issue Take Action commands.
- If a SAF security class is supplied, but the class is not defined and active in SAF, no one can log on to the OMEGAMON enhanced 3270 user interface.
- If a SAF security class is supplied, and is defined and active in SAF, but no logon profile is defined, no one can log on to the OMEGAMON enhanced 3270 user interface.
- If a user is able to log on, and a different security class than the one used for logon is used for queries or for Take Action commands (but is not activated or resources are not defined in that security class), everyone can view data for any managed system and perform other commands and activities, but all Take Action commands are denied.
- If a security class name is configured, resource profiles must be defined to control log on, data access, and Take Actions, and users must be given access to those profiles.

Configuring security resource profiles

See the IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: Common Planning and Configuration Guide for information about how security works and how to configure security resource profiles.

Data Facility Storage Management System (DFSMS)

The following activities are separately secured by the Data Facility Storage Management System (DFSMS):
• Display a member list for a data set
• Browse the contents of a data set member
• Save a data set member

**User Experience**

When users are not authorized to run an activity, they are prevented from running the activity regardless of the attempted method, for example, whether by using a menu item, command line, or function key.

When users attempt to run an activity that they are not authorized to, a message similar to the following is displayed on their screen:

```
Figure 1. Security system denied request message.
```

The administrator can check the SYSPRINT log file to see additional details about the request that is denied. For example, for the message shown an entry similar to the following can be found in the SYSPRINT log file:

```
USER2 KOBUSCI2 SAF R15=00000008 CLASS($KOBTEST) RESOURCE(KOBUI.ADMIN.TRACE.UI.BASIC )
RC=00000008 RSN=00000000
```

**Getting help**

You can view column and menu help about the enhanced 3270 user interface.

**Column Help**

You can get help for any workspace column by positioning your cursor in the field with the column name and pressing F1. A menu is displayed containing a description of the attribute for the data that is being displayed. A question mark (?) entered in column 1 of a summary type subpanel also displays help for the column. For an example, see “Help for column headings” on page 17.

**Menu Help**

The action bar Help menu displays information about the following enhanced 3270 user interface items:

• Commands
• PFKeys
• Icons
• Navigation
• Auto Update
• About OMEGAMON

For more information about menus, see “Menus” on page 13.
Chapter 3. Workspaces

Workspaces are panels that display collected data and analytic, diagnostic, or explanatory information. Workspaces can contain up to 15 subpanels, displaying various types of data or information. Workspace panels can be overlaid by pop-up panels that present navigation or action options, help for a particular field, or additional information. You navigate among workspaces by zooming to preset destinations, entering an action code in an input field, or by selecting a destination from an action popup panel.

Parts of the workspace

A typical workspace consists of an action bar, a header, up to 15 subpanels, and a footer.

Action bar

The action bar is the top line of the workspace. The bar has an input field on the left side, and a set of dropdown menus across the length of the line. You can use the input line to enter navigation and action commands and mnemonics of up to 16 bytes. The date and time of the session is displayed to the right of the action bar.

Header

The workspace header consists of the following parts:

Command line

The command line beneath the action bar is also used to enter navigation and action commands, but allows as many bytes as can fit on your screen (that is, the number of bytes allowed depends on the size of the screen).

Panel ID

The identifier of the workspace. The panel ID is the name of the PDS member in which the workspace panel is defined. The panel ID is located in the upper left corner of the workspace below the Command line.

You can use the panel ID to navigate to a specific workspace. An alias may be assigned to a panel ID by IBM or by your site to simplify navigation.

Workspace title

A descriptive title that identifies the content of the workspace as a whole.

Auto Update status

An indicator of whether automatic refresh is in effect or not. This field is adjustable by the user. If the auto update feature is enabled, the field displays the refresh interval in effect. If the auto update feature is disabled, the field displays Off. If auto update is automatically suspended, the field displays SUS.

Plex ID

This field identifies the plex (IMSplex, Sysplex, CICSplex) for which data is being displayed. The label and purpose of this field may vary from workspace to workspace and from monitoring product to monitoring product. The field may be blank, for example in a multiproduct workspace such as KOBSTART, or if the fields are locked.
System ID

This field, under the Plex ID, identifies the subsystem, LPAR, or region for which data is being displayed. The label and purpose of this field may vary from workspace to workspace and from monitoring product to monitoring product. The field may be blank, for example in a multiproduct workspace such as KOBSTART, or if the fields are locked.

Subpanels

There are four types of subpanels: detail, summary, ISPF, and HTML.

In detail panels, multiple data points for a single resource are displayed. The name of the attributes for which data is being displayed appears to the left of the value.

In summary subpanels, data for multiple resources is presented in tabular form, one row for each resource, with columns providing values for the system or application attributes being monitored by the agent, such as Disk Name and Disk Read/Writes Per Second.

If defined thresholds are reached, data is highlighted with colors indicating the status of the item.

Summary and detail subpanels can contain some or all of the following elements:

Header

A descriptive title for the subpanel.

Collapse and Expand controls

Selecting the control collapses the contents of the subpanel so only the header is displayed. If the subpanel is collapsed, selecting the icon expands the subpanel. See “Collapsing and expanding subpanels” on page 24 for more information.
Columns ___ field (summary subpanels only)

A writeable field that indicates at which column of data the scrollable part of the display begins. Entering a column number in the field and pressing Enter scrolls the display to that column. If no further columns are available, the field is blue.

Left, right, up, down scrolling arrows (summary subpanels only)

Scrolls the width or depth of the subpanel.

Minimize, maximize, close controls

- **Minimize** removes the subpanel from the workspace and puts the subpanel title in the minimize bar at the bottom of the workspace. Placing your cursor under the title in the bar and pressing **Enter** expands the subpanel to its former position.
- **Maximize** expands the subpanel to fill the entire screen. The icon changes to indicate that the subpanel is maximized.

The **Close** control closes the subpanel entirely.

See “Minimizing and maximizing subpanels” on page 23 and “Closing subpanels” on page 24 for more information.

Rows ___ field (summary subpanels only)

Indicates at which row of data the display begins. If the field is green, entering a row number in the field and pressing **Enter** scrolls the display to that row. If no additional rows are available, the field is blue.

Subpanel footer

Contains additional information about the data in the subpanel.

ISPF and HTML subpanels consist of an optional header and text that provides additional information about the workspace, such as why the user was brought to this workspace.

Footer

The workspace footer contains a minimize bar. If subpanels are minimized, their headers appear in the bar. If there is more data available than is displayed on the screen, a MORE indicator is displayed. Up or down arrows beside the text indicate the direction of the additional data that is not currently displayed on the screen. If Trace is enabled, a TRACE indicator is displayed; however, if there is more data to be displayed, the MORE indicator takes precedence over the TRACE indicator.
Drawer

The drawer is an alternative way to go quickly to administrative workspaces, and products from the footer area. The drawer can be opened to reveal navigation icons or closed to hide the icons.

In the closed position, the drawer is signified by the Open Drawer icon <<.

To open the drawer move your cursor over the Open Drawer icon, and press Enter, or double-click the icon, if this method is enabled for your 3270 emulator session. For more information about enabling double-clicking, see Appendix D, “Associating a mouse click with the Enter key,” on page 135.

When the drawer is open, a number of icons are available. To go to the workspace or action that is associated with a specific icon, move your cursor over the icon and press Enter, or double-click the icon.

The following icons are available:

**HUB**  Use this icon to go to the Hub Connectivity Administration workspace.

**RTE**  Use this icon to go to the Runtime Environment workspace.

**NAV**  This icon opens a lateral navigation area in the footer area. In the lateral navigation area, push buttons represent products or workspaces that you can navigate to, for example, these push buttons can be used to navigate to installed products:

To go to a specific product, move your cursor over the icon and press Enter, or double-click the icon.

**Tip:**
• To open the lateral navigation area, press the PF9 key.
• When the lateral navigation area opens, the drawer closes.

When the drawer is open, the Close Drawer icon >> is available. To close the drawer, move your cursor over the Close Drawer icon >>, and press Enter, or double click the icon, if this method is enabled for your 3270 emulator session. For more information about enabling double-clicking, see Appendix D, “Associating a mouse click with the Enter key,” on page 135.

## Menus

Each workspace contains a set of menus.

You can access the menus in three ways:

1. Place your cursor on the menu item and press Enter.
2. Double-click the menu item if this method is enabled for your 3270 emulator session. For more information about enabling double-clicking, see Appendix D, “Associating a mouse click with the Enter key,” on page 135.
3. You can use fast path commands to select a menu item by entering an abbreviated command on the action line. The letters that you enter in the abbreviated fast path command are listed under each menu. For example, you can enter the fast path command v.s at the action line, as an alternative to selecting the menu option View > S Workspace Source. Similarly, you can enter the fast path command e.p at the action line, as an alternative to selecting the menu option Edit > P Preferences.

The following menus are displayed in each workspace:

**File**

The options that are enabled are context-sensitive. Some options might not be available either because they are not available from the current workspace or because they are not available in this version.

- N new
  This option is not available in this version.
- O Open
  Opens the Runtime Environment workspace.
- S Save
  This option is not available in this version.
- A Save As
  Save a copy of the current workspace.
- X Exit
  Exits the current interface session.

**Edit**

The Edit menu offers the following selections:

- S Workspace Source
  This option is not available in this version.
- T Thresholds
  This option is not available in this version.
- P Preferences
  Displays user profile information.

**View**

The View menu offers the following selections:

- F Filters
  Displays a list of filterable items for the current workspace, if any are defined.
T Thresholds
Displays the Runtime Configuration workspace for viewing Threshold definitions members. The workspace displays information for the RTE data sets that contain the threshold definition members.

Tip: Product provided threshold definition members are named IBMSITE, CUASITE, or \texttt{KppTHRESH}, where \texttt{pp} is the two-digit product code identifier; for example, M5 for the OMEGAMON XE on z/OS product.

S Workspace Source
Displays the workspace source.

H History Mode
This option is not available in this version.

Tools
The \textit{Tools} menu offers the following options:

Important: Do not use the first four options except as directed by IBM Software Support.

I Trace (User Interface)
Engages trace for the current session. You select the process that you want to enable or turn off trace on from a pop-up menu. The default trace level is 1.

A Trace (Address Space)
Engages trace for the entire address space. You select the component that you want to enable trace on from a pop-up menu. The default trace level is 1.

Important: When you engage trace, the volume of messages that are written to the output log files increases; typically JES output. If trace is engaged for an extended period, the output can exceed site limits and cause an enhanced 3270 user interface address space termination.

R Registry Refresh
Refreshes the registry that lists all managed system names, managed system lists, and data retrieval agents.

T Threshold Refresh
Refreshes the threshold definitions from disk.

U Active 3270 Users
Displays a list of active users and details about their sessions.

H Current Hub Information
Displays information about your hub connection.

P Products Installed in Hub
Displays the products that are installed on the hub.

E Runtime Environment
Displays information about the Runtime Environment (RTE).

G Global Timeout Control
Displays the workspace query timeout value.

V Internal Variables
Displays a list of internal variables.

Navigate
Use the \textit{Navigate} menu to navigate to different products. Products that are available are shown in the color white. Products that are not available are shown in the color blue. Products that are installed locally in the interface but are not available in the connected hub monitoring server are shown in the color yellow.
Z  z/OS
   z/OS summary.
C  CICS
   CICS summary.
I  IMS
   IMS summary.
D  DB2
   DB2 summary.
N  Networks
   Network health summary.
M  MQ
   MQ summary.
S  Storage
   Storage summary.

Help  The Help menu displays help for the enhanced 3270 user interface. The following topics are covered:

   Commands
       Help for commands and the command line.

   PFKeys
       Help for the Program Function (PF) keys.

   Icons
       Help for the enhanced 3270 user interface icons.

   Navigation
       Help for navigating by using commands, PF keys, icons, and pull-down menu options.

   Auto Update
       Help for the OMEGAMON Auto Update feature.

About OMEGAMON
   An About entry that lists the following information for the current enhanced 3270 user interface session:
   • Product version and level
   • User ID
   • VTAM applid
   • Jobname
   • LPAR ID
   • Operating System
   • Sysplex
   • TCP/IP host and address

---

Status indicators

Status lights are highlight colors that indicate the status of monitored system components. The status is determined by a set of thresholds applied against the component.

By default, the colors and the statuses they represent are as follows:

**GREEN**
   OKGOOD

**YELLOW**
   WARNING
Note: By default, status of OK or GOOD is not indicated (that is, there is no highlighting).

Thresholds may also be defined in terms of ranges. The default colors and the ranges they represent are as follows:

**GREEN**
Ranges 1–3

**YELLOW**
Ranges 4–6

**RED**
Ranges 7–9

The values or range represented by each status are set in threshold definitions. You can change the colors assigned to each threshold in the interface profile for your site or for individual users (see "Customizing status indicators" on page 56). Each monitoring agent provides predefined thresholds with its workspaces. You can modify these preset threshold criteria to suit your site (see "Modifying predefined thresholds" on page 56). In subsequent releases, you will be able to set your own thresholds.

**Example**

In the following example, the Performance Index values are all in the Warning range:

---

**Workspace colors**

In workspaces, colors identify types of text and fields.

The following list defines the default colors for various elements of a workspace:

**WHITE**
Boxlines, items available for selection or zooming
These colors are controlled by the interface profile in effect for the user (the KOBCUA, CUASITE, or user profile). You can modify any of these colors.

**Help for column headings**

Help is provided for column headings in workspaces.

Within a workspace, you can place your cursor on a column heading or anywhere within the column, and press **PF1** to view help about the column.

The following is an example for the Enterprise Summary **KOBSTART** workspace:

1. Place your cursor on the **LPAR Group Capacity Limit** column of the All Active Sysplexes panel.
2. Press **PF1**.

The help for **LPAR Group Capacity Limit** is displayed:

![Figure 4. Column heading help.](image)

A question mark (?) entered in column 1 of a summary type subpanel also displays help for the column.

**Screen operations**

Within a workspace, you can scroll up, down, left, and right in subpanels using PFKeys or commands, or by entering column or row numbers in input fields. In summary subpanels, you can also use scrolling icons. You can sort the data in columns and add, modify, and remove filters on eligible columns. You can also reset the context for the data displayed in the workspace.

**Action codes**

Action codes are entered in the input area associated with a field.
In summary subpanels, the items in the first column are typically selectable. To view a list of actions applicable to an item, type / on the input field in front of the item and press Enter:

The Options Menu is displayed:

The Options Menu displays the available actions and the possible navigation alternatives for that item, along with the action code for those options. Type the list number or the letter for the action in the entry field on the menu and press Enter to select an option. The actions available and the action codes associated with them vary from workspace to workspace.

If you know the letter associated with a particular action item, you can enter it directly on the workspace. Type the letter in the input field in front of an item and press Enter. Entering S selects the default action (or navigational option). You can also select the default action by placing the cursor in the input field and pressing Enter.

**Take Action commands**

You can issue certain commands from the enhanced 3270 user interface. These commands are referred to as Take Action commands.

Individual commands may be listed in the Options Menu popup. They are prefixed by a hyphen (-):
Scrolling

The enhanced 3270 user interface uses two types of scrolling: local and global. The type of scrolling that takes effect depends on the location of the cursor.

If the cursor is set in a subpanel when a scrolling command is executed, scrolling is local; that is, only the subpanel in which the cursor is located is affected. If all the subpanels in the workspace are displayed and the cursor is set outside a subpanel (for example, on the command line), scrolling applies to all the subpanels in the workspace. If there are subpanels that are not displayed (so the MORE indicator appears at the bottom of the screen), vertical scrolling with the cursor set outside the subpanels scrolls down an entire screen to display the remaining subpanels. If a subpanel is maximized, the MORE indicator at the bottom of the screen is suppressed and full screen scrolling is disabled. You can only scroll the contents of the maximized subpanel.

Use any of the following methods to scroll within all subpanels or within a specific subpanel.

- To scroll to the last or first \( n \)-number of rows or columns (where \( n \) is the maximum number of rows or columns that can be displayed on the screen), use either of the following methods:
  - Type DOWN M(AXIMUM), UP M, LEFT M, or RIGHT M on the COMMAND or action line and then press Enter.
  - Type M on COMMAND or action line and then press PF8 (down), PF7 (up), PF10 (right), PF11 (left), or use the corresponding assigned PFKeys.
- Type TOP or BOTTOM on the COMMAND or action line and then press Enter to display the last or first \( n \)-rows

- To scroll a specified number of rows or columns, use either of the following methods:
- Type *DOWN* *nnn*, *UP* *nnn*, *RIGHT* *nnn*, or *LEFT* *nnn* on the COMMAND or action line and then press *Enter*.
- Type *nnn* on the COMMAND or action line and then press PF7, PF8, PF10, PF11 (or the corresponding assigned PFKeys) to scroll down, up, right, or left.

- **Remember:** To scroll within a specific subpanel, set your cursor in the subpanel before you press *Enter* or the appropriate PFKey.

Use the following methods to scroll within a specific subpanel:
- To go to a specific column, overtype the "from" column number in the subpanel header and press *Enter*.
- To go to a specific row, overtype the “from” row number in the subpanel header and press *Enter*.
- To scroll to the next *n*-number of rows or columns, use the cursor-sensitive arrow controls in the subpanel header. Arrows highlighted in white are currently usable for the subpanel. Click on an arrow, then press *Enter* to scroll in the selected direction.

If there are subpanels that are not displayed, a MORE indicator appears at the bottom of the screen, next to the minimize bar. Arrows appear beside MORE indicator to show if there is more data above or below the data displayed, or both. Placing the cursor on an arrow and pressing *Enter* scrolls the screen in that direction.

**Lateral column scrolling**

Some columns contain more data than can be displayed in a fixed width. These columns may have lateral (left and right) scrolling enabled.

Columns with lateral scrolling enabled have left and right scrolling arrows in the column heading:

You can scroll by placing the cursor on an arrow and pressing Enter, or by placing the cursor in the data area of the column and pressing the PF10 or PF11 keys.

**Selecting**

Selecting items lets you perform actions associated with those items, such as navigating to a workspace that displays detailed information for the selected item, issuing a command that affects a selected resource. By default, selectable items are displayed in white.

In summary subpanels, the items in the first column may be selectable. Selectable items are preceded by an input field (_):

To select an action associated with the item, place the cursor on the input field using the arrow keys or the mouse and then perform one of the following actions:
• Press Enter or type S and press Enter to execute the default action associated with the item. Typically, this is navigating to a related workspace.

• Type / and press Enter to display a popup menu with a list of actions you can apply to the selected entry. On the popup menu, type the number or code of the action you want to perform and press Enter.

• If you already know the action code for the action you want to perform, type it in the input field and press Enter to perform a specific action.

• Type ! and press Enter to display a popup menu with a list of take action commands you can apply to the selected entry.

Note: Items that are selectable are zoomable, but zoomable items are not necessarily selectable. In detail subpanels, for example, items can only be zoomable. See “Zooming” on page 26 for more information.

Sorting
You can sort data in eligible columns in ascending or descending order using the sort icons.

The column headings of columns that are eligible for sorting display a sort icon. The appearance of the sort icon depends upon the status of the sort.

<table>
<thead>
<tr>
<th>Sort icon</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction VID</td>
<td>Column is sortable, but sorting is not in effect.</td>
</tr>
<tr>
<td>CPU Time</td>
<td>Sorting is in effect and column is sorted in ascending order.</td>
</tr>
<tr>
<td>CPU Time</td>
<td>Sorting is in effect and column is sorted in descending order.</td>
</tr>
</tbody>
</table>

To sort using the icons, place the cursor over the heading of column you want to sort and press Enter. If sorting is in effect, pressing Enter reverses the sort order. If sorting is not in effect, pressing Enter sorts the list is descending order. To restore the original sort order, you must F3 out of the workspace and redisplay it.
Filtering

Columns in a summary subpanel may be designated as eligible for filtering. Some of these columns may have predefined filters. You can view a list of all the eligible columns and existing filters. You can add, modify, or remove filters for any column in the list. Only the columns in the first summary panel in a workspace can be filtered.

You can view the list of filter-eligible columns by pressing PF4 or entering the command FILTER. The list of columns is displayed in a popup panel:

To enable, modify, or disable a filter:
1. Enter the number of the filter you want to modify.
   A popup menu is displayed with the details of the filter definition:

   Use UCTRAN to specify whether the uppercase translation option is to be set (Yes), or if the value is to be used as it is typed in (No). The UCTRAN option can be used to filter lower or mixed-case values. The default is Yes.
2. Take one of the following actions:
   - To add a filter, type the appropriate Compare operator and overtype N/A with the desired value, then press Enter.
   - To modify a filter, type the appropriate operator and value, then press Enter.
   - To remove a filter, erase either the operator or the value in the existing expression, then press Enter.
   If you press Enter, the filter list is redisplayed.

The following comparators are supported:
- = or EQ (equal to)
- <> or NE (not equal to)
- > or GT (greater than)
- < or LT (less than)
- >= or GE (greater than or equal to)
- <= or LE (less than or equal to)

The Value field supports strings or numbers. A trailing asterisk wildcard is supported, but not a leading asterisk. For example, C* but not *C. To indicate that a number is a substring rather than an integer, enclose the value in quotation marks. For example, in the preceding screen, specifying the value as “1234” displays all CICS regions whose names begin with the substring “1234”.

If no columns have been designated as eligible for filtering, you will see the following message after you enter the FILTER command or press F4:

```
Filter(s)
This workspace has no filters defined
```

Minimizing and maximizing subpanels
Minimizing a subpanel from its original size minimizes it to the minimize bar at the bottom of the workspace. Minimizing a subpanel allows additional subpanels, if any, to appear in the workspace. Maximizing a subpanel expands it to fill the entire screen, allowing you to see more data without scrolling.

To minimize a subpanel, set your cursor on the icon and press Enter. The header of the subpanel appears in the minimize bar.

To restore the subpanel, set the cursor on the header in the minimize bar and press Enter.

To maximize a subpanel, set the cursor on the Maximize icon and press Enter. The subpanel expands to fill the entire screen. While a subpanel is maximized, MORE and TRACE indicators are suppressed and full screen scrolling is disabled. You can only scroll the contents of the maximized subpanel. To reduce the subpanel to its original size, set the cursor on the Normalize icon and press Enter.
Collapsing and expanding subpanels

Collapsing a subpanel leaves just the header on display and allows additional subpanels, if any, to be displayed in the workspace. If a subpanel is collapsed, only the subpanel heading is displayed. Expanding the subpanel displays the data rows and columns again.

A down arrow in the left hand corner of a subpanel header indicates that the subpanel can be collapsed. Collapsing the subpanel turns the down arrow into a right arrow (see Figure 5).

To collapse a subpanel, set your cursor on the down arrow and press Enter. To expand a subpanel, set your cursor on the right arrow and press Enter.

If a collapsed subpanel contains no data, you will see the text “No Data” displayed in the right corner of the title bar. In some collapsed subpanels that contain no data, the subpanel title might be replaced by explanatory text.

Closing subpanels

You can close subpanels to increase workspace real estate or focus only on data of concern. The subpanel will reappear the next time the workspace is accessed. If you want to be able to view the subpanel again without exiting the workspace, collapse or minimize the subpanel instead of closing it.

To close a subpanel, set your cursor on the close icon in the subpanel header and press Enter.

Changing context

The two fields in the upper right corner of a workspace display the currently selected plex and subsystem or region. If these fields are displayed in green, you can overtype them to switch the context to view data for another plex or subsystem.
For example, in the workspace shown below, you can overtype the SMF ID SYS with the SMF ID for another LPAR, then press Enter to see data for that LPAR instead of SYS.

If these fields are blue, they cannot be overwritten.

**Auto Update**

The Auto Update feature refreshes the data displayed in a workspace at a set interval. By default, the feature is disabled. You can enable the feature by specifying an interval for the refresh.

The **Auto Update** field in the upper right corner of a workspace controls the refresh of data in the workspace:

![Auto Update Off]

If the feature is enabled, the **Auto Update** field displays the selected interval:

![Auto Update 005]

To turn on refresh, overtype the field with a desired interval, in seconds. To disable the refresh, overtype the interval with Off.

If the interface is left running untouched in auto-update mode, it will eventually suspend auto update. A popup appears to inform users that updates have been suspended, and the field displays SUS. The suspend interval is determined by the auto-update interval, so the larger the auto-update value, the longer the time before updating is suspended. The algorithm is \( n \times 6 \times 60 \times 8 \), which equals 8 hours when auto update runs at a 10 second interval.

The Auto-Update suspension value can be customized in the user's profile, using the AUTOSUSPEND=nnnn keyword, where nnnn is a number between 1 and 9999.
Workspace navigation

In the enhanced 3270 user interface, you can navigate between workspaces by zooming, as well as by selecting options from an action menu. You can display a trace showing where you are and how you got there, you can return to where you started, and reset the tracing.

Zooming

One or more columns in a summary subpanel, or one or more items in a detail subpanel may be "zoomable". Zooming provides context-sensitive navigation to a predefined destination workspace. Zooming might even take you to a workspace for another OMEGAMON product.

Items that are zoomable are highlighted in white. To zoom, click your cursor anywhere in the item and press Enter.

The contents of the destination workspace may be "filtered" based on the key values in the source workspace. For example, a destination workspace may show data for a specific CICSplex, Region, and Transaction ID.

Where am I?

Sometimes it is useful to know how you arrived at a particular workspace. For example, queries or processes might be driven silently to derive the data that is being displayed. The SHOWNAV or WHEREAMI commands display the current internal navigation trace table in a scrollable popup window. The table provides a history of the workspace navigation and the variables that are involved in arriving at the current workspace.

To view the navigation trace table, on the Command or action line, enter SHOWNAV or WHEREAMI.

Use the HOME command to return to the first workspace in a navigation chain. Returning to the first panel resets the navigation trace. Use the RESETNAV command to reset the trace table from the current workspace.
Chapter 4. User Preferences

The OMEGAMON enhanced 3270 user interface provides administrative workspaces to assist subject matter experts and other users to set up and customize their preferences.

Workspaces that assist subject matter experts and other users to set up and customize their preferences are:
- User profile customization
- Log on Administration and customization

Customizing a user profile

To customize your user profile, use the User Profile Member workspace.

Procedure

1. From the menu bar select Edit > Preferences. The User Profile Member workspace opens.

![User Profile Member workspace]

The User Profile Member workspace contains a number of tabbed panels that contain user profile settings that you can change and save. The following settings are available:

**Date/Time**

This panel contains the following date and time format settings:

- **Date begins with**
  - Enter **MM** for the American format, MM/DD/YYYY.
  - Enter **DD** for the European format, DD/MM/YYYY.
  - Enter **YY** for the Mathematical format, YYYY/MM/DD.

- **Date separator**
  - Enter **(Any displayable character)**

- **Time clock format**
  - Enter **24** (24 or 24)

- **Time separator**
  - Enter **1** (Any displayable character)

Figure 6. User Profile Member workspace

© Copyright IBM Corp. 2012, 2013
Date separator
Enter your preferred separator character. You can use any displayable character.

Time Clock
Enter 12 or 24 for 12 or 24 hour clock format

Time separator
Enter your preferred time clock separator character. You can use any displayable character.

Colors
This panel contains color assignments for various workspace elements and indicators. You can enter your preferred color in the input field for each item.

Session/Logon
This panel contains settings that apply to your logon session to the interface.

First workspace to be displayed
Specifies the workspace that you want to be displayed at logon, the default is KOBSTART.

First NAV1 Plex-level Value
Specifies the plex (Sysplex, CICSplex, IMSplex) for which data is displayed on the first workspace. The value is a simple text string.

First NAV2 System-level Value
Sets the system, subsystem, or region within the plex for which data is displayed. The value is a simple text string.

Engage Trace
You can choose whether to engage trace at the start of your logon session by entering Y or N.

Global Query Timeout Value
Specifies the number of seconds that a workspace waits before timing out all queries combined. Each subpanel is apportioned a percentage of this value that is based on each query definition. You can enter a number in the range of 0 - 999. If you enter 0, the timeout mechanism is disengaged.

Auto/Update
This panel contains auto update settings that determine the refresh frequency of the data that is displayed in a workspace.

Auto Update Frequency
You can enter the auto update frequency. The allowable range is 5 - 999 seconds.

Auto Update Suspend Cycle Count
You can enter the number of refresh cycles that are allowed before auto update is automatically suspended. The allowable range is 10 - 9999 refresh cycles.

Hub Check

Hub Check when no data is displayed
The interface detects when a workspace displays no data, and can automatically check the connection to the hub Tivoli Enterprise Monitoring Server. The **Hub Check when no data is displayed** setting controls the number of consecutive No Data displays before a hub connectivity check is triggered. The allowable range is 0 - 9 cycles. A setting of 0 means no hub connectivity check. Any positive number drives the hub connectivity check, and if the hub is found to be unresponsive, the interface goes to Hub connectivity administration. For more information about Hub connectivity administration, see "Hub connectivity administration" on page 75.
Limit Hub Check to Auto/Update
To limit the Hub connectivity check to when Auto Update is enabled, set to Y, otherwise set to N.

2. You can change your profile settings that are detailed in step 1 on page 27.
3. Make one of the following choices:
   • Click OK to save and view your settings for the current session only. Your settings are saved for the current session and you are returned to the workspace you were in before you set preferences.
   • Click Save if you are satisfied with your settings and want to save them permanently to a profile member. The Profile Save As dialog box opens:

4. Press Enter to save the profile to the member name in the Member Name field. If the member already exists, it is updated. If it does not exist, a new member with that name is created.

Customizing KOBSITEC as the initial workspace
The ITM Situation Status & Message log (KOBSITEC) workspace can be a useful alternative to the default initial workspace, if you use Tivoli Enterprise Portal Server situation monitoring.

About this task
You can use the ITM Situation Status & Message log (KOBSITEC) workspace to display IBM Tivoli Monitoring Situations status information in the enhanced 3270 user interface. The status information is similar to the information provided by the Tivoli Enterprise Portal Situation Event Console, that is, situation status for current situations events and situation event history. KOBSITEC also enables navigation to OMEGAMON products high-level workspace via the situation status row action selection. To change the default initial workspace KOBSTART to KOBSITEC, use the following procedure.

Procedure
• Use the procedure that is detailed in “Customizing a user profile” on page 27 to change the setting First workspace to be displayed to KOBSITEC. When you log on the KOBSITEC workspace is now displayed as the initial workspace.
• Optional: Enter =KOBSITEC in the action bar or command line and press Enter to go directly to the KOBSITEC workspace.
## Results

The ITM Situation Status & Message log workspace provides the following subpanel attributes:

- **Status**: The Tivoli Monitoring Situation event status; for example, OPEN, ACKNOWLEDGED, REOPENED.

- **Situation Name**: A unique name that identifies the Tivoli Monitoring Situation.

- **MSN Event Source**: The name of the managed system where the situation is being monitored.

- **HUB Event Time**: A time stamp that indicates the time the event occurrence or situation condition was recorded by the Hub Tivoli Enterprise Management Server.

- **Agent Event Time**: A time stamp that indicates the time the event occurrence or situation condition was observed by the originating managed system.

- **Display Item**: A related attribute that helps identify a unique instance of a situation event in the case where there are multiple instances/rows (that is, events) for a specific situation.

- **Type**: The type of situation event, that is, a pure type where the situation has no sampling interval and the related alert notification is unsolicited, or, a sampled type where the situation condition is sampled on a specified interval.

## Logon administration and customization

When you log on to the enhanced 3270 user interface for the first time, Hub Connectivity Administration can assist you to specify a hub Tivoli Enterprise Monitoring Server connection.
Procedure

1. Log on to the user interface in the standard way. For more information about logging on, see "Logging on" on page 4. If a hub monitoring server is specified in your profile, and that hub is available, a connection is made to the hub and your initial workspace is displayed. By default, the initial workspace is the Enterprise Summary (KOBSTART) workspace. If a hub monitoring server is not specified in your profile, the Hub Connectivity Administration workspace is displayed.

   ![Hub Connectivity Administration workspace](image)

   Figure 9. Hub Connectivity Administration workspace that shows a hub connection is not specified for the current profile

2. To select the NEXT icon on the Hub Connectivity Administration workspace, move your cursor to the icon and press ENTER or double-click the icon. The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known to the enhanced 3270 user interface.
Tip: You can browse overview status information about each hub from this workspace. For more information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs workspace” on page 83.

3. On the All Known Hubs (KOBHUBS) workspace, place your cursor next to a hub monitoring server name and press Enter. The Action Confirmation panel is displayed. The panel lists information about the hub monitoring server to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the action or N to cancel the action.

4. Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and shows two green information boxes that indicate a successful TCP/IP connection.
To save the hub monitoring server name to your user profile, select **SAVE**.

To use the selection for your current enhanced 3270 user interface session, select **OK**.

**Results**

Your session goes to the first workspace name specified in your logon profile, by default the Enterprise Summary (KOBSTART) workspace.
Chapter 5. Customization

The OMEGAMON enhanced 3270 user interface provides workspaces to help subject matter experts customize workspace views for site specific and required use.

Customizing workspaces

Every OMEGAMON XE product that supports the enhanced 3270 user interface provides a set of predefined workspaces that can be used to resolve common problems. These workspaces can be modified to display exactly the information that you want to most effectively use the OMEGAMON XE monitoring agents in your environment. You can also create your own custom workspaces.

Workspace viewing and cloning

The OMEGAMON enhanced 3270 user interface provides the capability to view and clone product provided workspaces.

Workspace viewing and cloning can be used to provide the user with the capability to customize the standard product defined workspaces that are delivered with the enhanced 3270 user interface. Modify or create workspaces by first cloning (copying) the workspace. Then, use a file editor such as the ISPF editor to edit the cloned workspace.

Preparing for workspace cloning

In preparation for workspace cloning by an enhanced 3270 user interface user, complete the following administrative steps:

1. Ensure that the interface user has the required authority.
   The cloning process copies a standard product provided workspace from a configuration runtime environment data set to a user workspace data set. The runtime environment data set is read only and the user workspace data set is writeable. The user that wants to clone a workspace must have the authority to create new members in the user workspace data set. The default user workspace name is <hilev>.<rtename>.UKANWENU.

2. Ensure that the user workspace data set is the first data set that is specified in the RANWENU DD statement. The user workspace data set is pointed to by the enhanced 3270 user interface started task JCL UKANWENU DD statement.
   If you ensure that the user interface data set is the first data set, workspace testing is facilitated when customization changes are applied.
   **Important:** It is important that the same <hilev>.<rtename>.UKANWENU data set is specified first in both the UKANWENU DD and RANWENU DD statements.

3. Minimize potential disruptions to other enhanced 3270 user interface users.
   Because the cloning and customization process modifies product provided workspaces, the process must be done in a configuration that is not disruptive to ongoing normal usage of the enhanced 3270 user interface. For example, a separate enhanced 3270 user interface address space with a unique instance of the user workspace data set might be employed during the customization and testing process. Following customization and testing, the changes might be deployed to a shared development or production configuration by copying the customized workspaces into a corresponding data set that is specified in the shared development or production configuration enhanced 3270 user interface started task JCL.
Related tasks:

- “Cloning a workspace”
  Make a copy of a workspace and save it to your private data set.
- “Browsing, locating and cloning a workspace” on page 37
  You can use the Runtime Environment (Workspaces) workspace to browse the available workspaces and to locate a specific workspace for cloning.

**Cloning a workspace**

Make a copy of a workspace and save it to your private data set.

**Before you begin**

You must complete some administrative steps before you clone a workspace. For more information about completing these steps, see “Preparing for workspace cloning” on page 35.

**Procedure**

1. Go to the workspace to be cloned. The workspace name is beneath the command-line entry area of the workspace display. For example, in the following workspace view the workspace name is **KOBSTART**.

2. Select **View > Workspace Source** The Partitioned Dataset Member (KOBPDSD) view opens showing a view of the KOBSTART workspace content.

3. Select **File > Save As** to clone the workspace that is being viewed. For example, to clone the KOBSTART workspace, place the cursor on **File** on the menu bar and press **Enter**. Then, from the **File** menu, select option 4, **Save As** by typing a or 4 and pressing **Enter**.

   **Fast path:** You can fast path to **File > Save As** by entering f.a in the action line.

   **Figure 12. Identify the workspace name**

   **Figure 13. Cloning a workspace by using the File > Save As menu option.**

   When you press **Enter**, the Member Save As dialog box opens:
4. Enter the workspace name that you want to use for the cloned workspace. If you are cloning a product provided workspace under the assumption that it is to supersede the product provided instance of the same workspace, the **Save As** name that you enter must be identical to the name of the product provided workspace, for example as shown in Figure 14. The saved workspace is written to the user workspace data set. The original product provided workspace is preserved intact in the runtime environment data set. When you press **Enter**, the **Save As** action is confirmed and you are returned to the Partitioned Dataset Member (KOBPDSD) view.

5. Optional: Go to the Runtime Environment (Workspaces) workspace to view your saved workspace. For more information about browsing and locating workspaces, see "Browsing, locating and cloning a workspace".

**What to do next**

When the workspace cloning is complete, the next step is to edit and test the workspace, customizing its contents to your requirements. Use a file editor such as the ISPF editor to edit the workspace.

**Related concepts:**

"Customization of product provided workspaces" on page 40
Guidance on customizing cloned workspaces.

**Related tasks:**

"Browsing, locating and cloning a workspace"
You can use the Runtime Environment (Workspaces) workspace to browse the available workspaces and to locate a specific workspace for cloning.

**Related information:**

"Preparing for workspace cloning" on page 35

**Browsing, locating and cloning a workspace**
You can use the Runtime Environment (Workspaces) workspace to browse the available workspaces and to locate a specific workspace for cloning.

**Before you begin**

You must complete some administrative steps before a workspace is cloned. For more information about these steps, see "Preparing for workspace cloning" on page 35.

**Procedure**

1. Go to the Runtime Environment (Workspaces) workspace to browse the available workspaces. There are a number of ways you can go to this workspace:
   - Select **File > Open**. To do this, place the cursor under **File** on the menu bar and press **Enter**. Then, from the **File** menu select option 2.
• Select **Tools** > **Runtime Environment** from the menu bar. The Runtime Environment workspace opens. Then, move your cursor over the **Workspaces** button and press **Enter**.

• Move your cursor over the **RTE** icon in the drawer and press **Enter**. The Runtime Environment workspace opens. Then, move your cursor over the **Workspaces** push button and press **Enter**.

When you make one of the previous three choices, the Runtime Environment (Workspaces) **KOBWENU** workspace opens. This workspace presents two workspace subpanels that provide directory lists for the user workspace data set (**UKANWENU DD**) and the runtime environment workspace data set (**RKANWENU DD**).

2. Enter the **Locate** command at the command line, specifying the workspace that you want to search for as an argument and press **Enter**. For example, if you enter **Locate KOBSTART**, the directory view positions similarly to **Figure 15**.

   **Fast path:** You can shorten the **Locate** command to **L**. For example, you can enter **L KOBSTART** to search for the KOBSTART workspace.

3. Place the cursor in the input field of the workspace name that you want to clone and press **Enter**. For example, to select the KOBSTART workspace, place the cursor in the input field that precedes the workspace name and press **Enter**. The Partitioned Dataset Member (**KOBPDSD**) view opens showing a view of the KOBSTART workspace content.

4. Select **File** > **Save As** to clone the workspace that is being viewed. For example, to clone the KOBSTART workspace, place the cursor under **File** on the menu bar and press **Enter**. Then from the **File** menu, select option 4, **Save As** by typing a or 4 and pressing **Enter**.

   **Fast path:** You can fast path to **File** > **Save As** by entering **f.a** in the action line.

![Figure 15. Runtime Environment (Workspaces), locating the workspace member.](image-url)
When you press **Enter**, the Member Save As dialog box opens:

![Member Save As dialog box](image)

**Figure 17. Cloning a workspace - the Member Save As dialog box**

5. Enter the workspace name that you want to use for the cloned workspace. If you are cloning a product provided workspace under the assumption that it is to supersede the product provided instance of the same workspace, the **Save As** name that you enter must be identical to the name of the product provided workspace, for example as shown in Figure 17. The saved workspace is written to the user workspace data set. The original product provided workspace is preserved intact in the runtime environment data set. When you press **Enter**, the **Save As** action is confirmed and you are returned to the Partitioned Dataset Member (KOBPDS) view.

6. Press **PF3 (End)** to return to the Runtime Environment (Workspaces) **KOBWENUS** workspace.

**Results**

The workspace directory view for the user workspace data set now lists the cloned workspace:
Note: When you clone a product provided workspace, the cloned instance of the workspace is used by the enhanced 3270 user interface. Cloned or user customized workspaces are identified by an asterisk (*), which is displayed after the workspace name:

![Image of workspace data set]

*Figure 18. User workspace data set that shows a cloned workspace*

What to do next

When the workspace cloning is complete, the next step is to edit and test the workspace, customizing its contents to site requirements. Use a file editor such as the ISPF editor to edit the workspace.

Related concepts:

“Customization of product provided workspaces”

Guidance on customizing cloned workspaces.

Related information:

“Preparing for workspace cloning” on page 35

Customization of product provided workspaces

Guidance on customizing cloned workspaces.
Before customizing a workspace, you must first clone it. For more information about cloning a workspace, see “Cloning a workspace” on page 36.

Use a file editor such as the ISPF editor to customize a workspace. Save the cloned workspace in the user workspace data set, that is, the data set pointed to by the enhanced 3270 user interface started task JCL UKANWENU DD statement.

**Important:** Product provided workspaces rely on both the workspace content and supporting REXX code to control context and navigation. Customization changes must avoid modifications that might have unintended results; for example; loss of context.

The following examples are workspace customization actions that a user might want to perform.

- Change the order of columns that are displayed in a summary data subpanel.
- Change the columns that are displayed. For example, remove some columns in a summary subpanel, and eliminate some of the attribute values in a detailed data subpanel.
- Change the workspace header.
- Change the workspace default (on entry) cursor position.
- Change the workspace default sort columns.
- Change the statically defined columns in a summary subpanel.
- Change the Agent filter that is specified in a subpanel query.
- Add local Filters to a summary subpanel.
- Change the number or order of subpanels that are displayed in the workspace.

You can achieve these types of customization by editing and changing workspace definition statements and associated keywords in the cloned workspace source. For more information, see “Customizing a workspace” on page 43.

**Tip:** Consider the following things before you change workspace definitions or view the source definition for a specific workspace:

- The absence of workspace definitions statements and or associated keywords (modifiers) is usually an indication that defaults are being used. For example, in the DISPLAYCOLS statement, there is no requirement for the specification of the CAPTION or WIDTH keywords. These keywords would more likely be used when the defaults are not adequate or preferable.
- The syntax that is used in the workspace definition language is important. Keyword spelling, column name spelling, commas, spaces, quotation marks, parentheses, and other syntax cannot be ignored or excluded; for example, quotation marks and parentheses must be balanced. Although the enhanced 3270 user interface provides comprehensive parsing of the workspace source definitions statements, runtime errors and in some cases unexpected results might occur if the syntax is incorrect. For more information about the workspace definition language, see “Workspace panel definitions” on page 96.
- The workspace definition language specifications employ the internal column name to refer to a specific application product and table column/attribute. Taking note of the displayed workspace column order position along with the workspace DISPLAYCOLS definition (specified column order position) can be useful as a technique for correlating displayed columns with their corresponding internal column names.

**Remember:** When customizing product provided workspaces, when the changes are deployed for use by a wider audience, the changes affect all users of a given enhanced 3270 user interface address space. Consider the other users when customizations of this type are done. The customization must benefit all of your users.
Related tasks:

"Cloning a workspace” on page 36
Make a copy of a workspace and save it to your private data set.

Modifying the initial workspace

By default, the OMEGAMON enhanced 3270 user interface is configured to specify the Enterprise Summary (KOBSTART) workspace as the initial workspace displayed after a user logs on. You can change which workspace is displayed when you first log on, or customize the Enterprise Summary workspace to better suit your needs.

About this task

Customizing the initial workspace involves two tasks:
• Creating a custom definition for the workspace
• Modifying the user's logon profile to specify the custom definition

The definition of the Enterprise Summary workspace imbeds a subpanel for each product that supports the enhanced 3270 user interface. The default imbed statements in the KOBSTART workspace definition are:

<table>
<thead>
<tr>
<th>Imbed statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMBED=KM5STRRTI</td>
<td>Imbed for OMEGAMON XE on z/OS</td>
</tr>
<tr>
<td>IMBED=KCPSTRRTI</td>
<td>Imbed for OMEGAMON XE for CICS on z/OS</td>
</tr>
<tr>
<td>IMBED=KGWSTRRTI</td>
<td>Imbed for OMEGAMON XE for CICS Transaction Gateway on z/OS</td>
</tr>
<tr>
<td>IMBED=KDPSTRRTI</td>
<td>Imbed for OMEGAMON XE for DB2/PE on z/OS</td>
</tr>
<tr>
<td>IMBED=KIPSTRRTI</td>
<td>Imbed for OMEGAMON XE for IMS on z/OS</td>
</tr>
<tr>
<td>IMBED=KMQSTRRTI</td>
<td>Imbed for OMEGAMON XE for Messaging on z/OS</td>
</tr>
<tr>
<td>IMBED=KS3STRRTI</td>
<td>Imbed for OMEGAMON XE for Storage on z/OS</td>
</tr>
<tr>
<td>IMBED=KN3STRRTI</td>
<td>Imbed for OMEGAMON XE for Mainframe Networks</td>
</tr>
</tbody>
</table>

Subpanels are displayed only for products that are installed. However, you might not want to see data for all of those products, or you might want to display additional subpanels. You can delete some of the imbedded subpanels and specify other subpanels that you want to imbed. Complete the following steps to customize the workspace definition.

Procedure

1. Copy or clone the product-provided KOBSTART member and rename it as appropriate, for example ZOSFWS. Use the workspace viewing and cloning feature of the interface to complete this step. For more information about workspace viewing and cloning, see “Workspace viewing and cloning” on page 35.
2. Copy or clone the product-provided KOBCUA member and rename it as appropriate: CUASITE for a site profile or user_id for a user-specific profile. Use the workspace viewing and cloning feature of the interface to complete this step. For more information about workspace viewing and cloning, see “Workspace viewing and cloning” on page 35.
3. Edit the copied instance to apply the required customization. For example, you might modify the list of imbeds to delete the KCPSTRRTI, KGWSTRRTI, KDPSTRRTI, KIPSTRRTI imbed statements. These changes create an initial workspace that contains data for only the OMEGAMON XE on z/OS, OMEGAMON XE for Storage, and OMEGAMON XE for Mainframe Networks products. For more information about customizing workspaces, see “Customization of product provided workspaces” on page 40.
4. Save your modified workspace.
5. Modify any appropriate logon profile members to specify the modified workspace definition as the initial workspace. In this example, you change the logon profile setting from FIRSTWS=KOBSTART to FIRSTWS=ZOSFWS.

6. Save your updated logon profile members.

**Results**

When you log on to the enhanced 3270 user interface using any of the modified profiles, the ZOSFWS workspace is displayed.

**Customizing a workspace**

Complete some preparation steps before customizing a workspace

**Before you begin**

Identify and clone the workspace to be customized. For more information about locating and cloning a workspace, see “Browsing, locating and cloning a workspace” on page 37. In the procedure that follows, the starting point is a cloned workspace. The workspace that is used as an example is the ITM Situation Status & Message Log (K0BSITEC) workspace. When you successfully clone a workspace, it is identified by an asterisk (*), which is displayed after the workspace name, as shown in the following example:

![Figure 20. A cloned workspace is denoted by an asterisk (*) after the workspace name](image)

**About this task**

This task lists the preparation steps that you must complete each time that you want to customize a cloned workspace.

**Procedure**

Preparation steps:
1. Go to the cloned workspace. For example, the Situations Status and History (K0BSITEC) workspace.
2. Go to the workspace source view by selecting **View > Workspace Source** from the workspace view. The contents of the workspace source, (KOBSITEC) in this example is displayed in the Partitioned Dataset Member (KOBPDSD) workspace view.

3. Start an ISPF file editor session in parallel to your enhanced 3270 user interface session. To start an ISPF editor session, use a TSO logon, then locate and edit the workspace to be customized from your user workspace data set. For example, the KOBSITEC workspace in the user workspace data set (hilev.rtename.UKANWENU).

   **Customization steps:**
   4. Choose and complete the customization that you want from the following choices:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change a workspace and subpanel header</td>
<td>See “Changing a workspace and subpanel header” on page 45</td>
</tr>
<tr>
<td>Change the order of displayed columns</td>
<td>See “Changing the order of displayed columns” on page 47</td>
</tr>
<tr>
<td>Change a column caption and width</td>
<td>See “Changing a column caption and width” on page 48</td>
</tr>
<tr>
<td>Remove a subpanel</td>
<td>See “Removing a subpanel” on page 50</td>
</tr>
<tr>
<td>Adjust the number of filterable columns and filter location</td>
<td>See “Adjusting the filterable columns” on page 51</td>
</tr>
</tbody>
</table>

   **What to do next**

   For more information about other definition statements that can be used to customize workspaces, see “Other workspace customization” on page 52.
Related tasks:
“Browsing, locating and cloning a workspace” on page 37
You can use the Runtime Environment (Workspaces) workspace to browse the available workspaces and to locate a specific workspace for cloning.
“Cloning a workspace” on page 36
Make a copy of a workspace and save it to your private data set.

**Changing a workspace and subpanel header**
Customize a workspace by changing the workspace and subpanel headers.

**Before you begin**
Follow the preparation steps that are detailed in “Customizing a workspace” on page 43.

**Procedure**
1. To change the workspace header statement, use the ISPF file editor session. For example, in the K0BSITEC workspace you can find the workspace header definition statement just after the `<WORKSPACE>` tag statement:

   ```
   000014 /*****************************************
   000015 <WORKSPACE>
   000016 HEADER='ITM Situation & Message log'
   ```

   For example, you might change the header definition as follows:

   ```
   000014 /*****************************************
   000015 <WORKSPACE>
   000016 HEADER='Situation Status and History'
   ```

2. To change subpanel headers, use the ISPF file editor session. For example, in the K0BSITEC workspace, further on in the workspace source, you can find the first subpanel header definition statement:

   ```
   000021 000022 /*******************************
   000023 */
   000024 /* SUBPANEL 1
   000025 */
   000026 /*******************************
   000027 000028 <SUBPANEL>
   000029 TYPE=SUMMARY
   000030 HEADER='Current Situation Event status'
   000031 TOFROMHEADER=Y
   ```

   For example, you might change the first subpanel header definition as follows:

   ```
   000021 000022 /*******************************
   000023 */
   000024 /* SUBPANEL 1
   000025 */
   000026 /*******************************
   000027 000028 <SUBPANEL>
   000029 TYPE=SUMMARY
   000030 HEADER='Current Situation Alerts'
   000031 TOFROMHEADER=Y
   ```

   Further on in the example workspace source, you can find the second subpanel header definition statement:
For example, you might change the second subpanel header definition as follows:

```
000128 /**************************
000129  **
000130  ** SUBPANEL 2 -
000131  **
000132  ***********************
000133
000134 <SUBPANEL>
000135 TYPE=SUMMARY
000136 HEADER='Situation Alerts History'
000137 TOFROMHEADER=Y
```

3. Use the ISPF file editor session to save your workspace source changes.

4. Press **PF3 (End)** in your enhanced 3270 user interface session to close the workspace source view. As the **PF3 (End)** action is processed, a refreshed view of the modified workspace is displayed, that is, the KOBSITEC workspace in this example:

![Customized workspace view](image)

**Figure 22. Customized workspace view that shows updated workspace and subpanel headings for the ITM Situation Status & Message Log (KOBSITEC) workspace**

**Tip:** While the KOBSITEC workspace is refreshed when a **PF3 (End)** action is processed, a refresh might not occur for a different workspace. If a refresh does not occur, you can exit and reenter the modified workspace to see your changes.
Changing the order of displayed columns
Customize a workspace by changing the order of the displayed columns.

Before you begin
Complete workspace customization preparation. For more information about these preparation steps, see "Customizing a workspace" on page 43.

Procedure
1. Use the ISPF file editor session to locate the DISPLAYCOLS workspace definition statement. For example, in the KOBSITEC workspace, scroll beyond the DISPLAYCOLS statement to find the first <SUBPANEL> tag statement:

   ```plaintext
   000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7),
   000080 SITNAME(CAPTION='Situation_Name',WIDTH=30),
   000081 ORIGINNODE(CAPTION='MSN_Event_Source'),
   000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),
   000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),
   000084 ATOMIZE(WIDTH=30,SCROLL),
   000085 TYPE(CAPTION='Type')'
   ```

2. Use the ISPF file editor session to change the order of the display columns. You might want to change the order of display columns. For example, to move the MSN Event Source header definition from the third column position to the second column position, adjust the DISPLAYCOLS statement as follows:

   ```plaintext
   000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7),
   000080 ORIGINNODE(CAPTION='MSN_Event_Source'),
   000081 SITNAME(CAPTION='Situation_Name',WIDTH=30),
   000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),
   000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),
   000084 ATOMIZE(WIDTH=30,SCROLL),
   000085 TYPE(CAPTION='Type')'
   ```

3. Use the ISPF file editor session to save your workspace source changes.
4. Press **PF3 (End)** in your enhanced 3270 user interface session to close the workspace source view. As the **PF3 (End)** action is processed, a refreshed view of the modified workspace is displayed, that is, the KOBSITEC workspace in this example:
Tip: The KOBSITEC workspace is refreshed following a PF3 (End) action. A different workspace might not be refreshed following a PF3 (End) action. If a refresh does not occur, you can exit and reenter the modified workspace to see your changes.

Changing a column caption and width
Customize a workspace by changing a column caption and width.

Before you begin
Complete workspace customization preparation. For more information about preparation steps, see "Customizing a workspace" on page 43.

Procedure
1. Use the ISPF file editor session to locate the DISPLAYCOLS workspace definition statement. For example, scroll beyond the first <SUBPANEL> tag statement in the KOBSITEC workspace to find the DISPLAYCOLS statement:

   ```
   000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7),
   000080 SITNAME(CAPTION='Situation_Name',WIDTH=30),
   000081 ORIGINNODE(CAPTION='MSN_Event_Source'),
   000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),
   000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),
   000084 ATOMIZE(WIDTH=30,SCROLL),
   000085 TYPE(CAPTION='Type')'
   ```

2. Change a column heading caption name. By default, the column heading caption is defined by the Object Definition Interchange (ODI) definition. However, it is possible to specify an override in the DISPLAYCOLS statement. For example, in the KOBSITEC workspace subpanel definition, to change the Situation Name caption to say Name, you can adjust the DISPLAYCOLS specification as follows:
3. Change a column width. You might want to adjust the space on the screen that is available for a specific column. For example, in the modified KOBSITEC workspace subpanel definition, to change the Name column width, you might adjust the DISPLAYCOLS specification as follows:

000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7),
000080 SITNAME(CAPTION='Name',WIDTH=32),
000081 ORIGINNODE(CAPTION='MSN_Event_Source'),
000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),
000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),
000084 ATOMIZE(WIDTH=30,SCROLL),
000085 TYPE(CAPTION='Type')'

4. Use the ISPF file editor session to save your workspace.

5. Press PF3 (End) in your enhanced 3270 user interface session to close the workspace source view. As the PF3 (End) action is processed, a refreshed view of the modified workspace is displayed, that is, the KOBSITEC workspace in this example:

![Customized workspace view](image)

**Figure 24. Customized workspace view that shows a column with a modified caption and width**

**Tip:** The KOBSITEC workspace is refreshed following a PF3 (End) action. A different workspace might not be refreshed following a PF3 (End) action. If a refresh does not occur, you can exit and reenter the modified workspace to see your changes.
What to do next

In the example, the first caption change in the modified KOBSITEC workspace introduced an inconsistency between the first and second subpanel views because both panels contain a Situation Name column. You might want to apply the same changes to the second panel for consistency. You can apply the same changes to the second subpanel by scrolling down in the editor to the next DISPLAYCOLS statement and repeating the procedure.

Removing a subpanel

You can customize a workspace to remove a workspace subpanel that is not of interest to you.

Before you begin

Complete workspace customization preparation. For more information preparation steps, see “Customizing a workspace” on page 43.

About this task

For more information about subpanel start and end statements, see “Number and order of workspace subpanels” on page 55. The following procedure details the removal of a subpanel from a workspace.

Procedure

1. Use the ISPF file editor session to locate the second <SUBPANEL> workspace definition statement. For example, in the KOBSITEC workspace, scroll to the SUBPANEL 2 heading to find the second <SUBPANEL> statement:

```
000102 /*-----------------------------------------------*/
000103 /***/
000104 /** SUBPANEL 2 - Message Log */
000105 /** */
000106 /***/
000107 /**-----------------------------------------------*/
000108 <SUBPANEL>
000109 TYPE=SUMMARY
000110 HEADER='Situation Alerts History'
000111 TOFROMHEADER=Y
000112 SCROLLBAR=Y
```

2. Add a <WORKSPACEEND> tag statement before the <SUBPANEL> tag statement. The <WORKSPACEEND> tag statement signifies the end of the workspace eliminating the following <SUBPANEL> definition:

```
000102 /*-----------------------------------------------*/
000103 /***/
000104 /** SUBPANEL 2 - Message Log */
000105 /** */
000106 /***/
000107 /**-----------------------------------------------*/
000108 <WORKSPACEEND>
000109 <SUBPANEL>
000110 TYPE=SUMMARY
000111 HEADER='Situation Alerts History'
000112 TOFROMHEADER=Y
000113 SCROLLBAR=Y
```

3. Use the ISPF file editor session to save your workspace source changes.

4. Press PF3 (End) in your enhanced 3270 user interface session to close the workspace source view. As the PF3 (End) action is processed, a refreshed view of the modified workspace is displayed, that is, the KOBSITEC workspace in this example:
Tip: The KOBSITEC workspace is refreshed following a PF3 (End) action. A different workspace might not be refreshed following a PF3 (End) action. If a refresh does not occur, you can exit and reenter the modified workspace to see your changes.

Adjusting the filterable columns

Customize a workspace by adjusting the number of filterable columns and the filter location.

Before you begin

Complete workspace customization preparation. For more information about preparation steps, see "Customizing a workspace" on page 43.

About this task

For more information about filterable columns and filter definitions, see "Local or agent filter definitions" on page 54. The following procedure details how to adjust the number of filterable columns in a workspace. The procedure uses the ITM Situation Status & Message Log (KOBSITEC) workspace as an example.

Procedure

1. Use the ISPF file editor session to locate the FILTERCOLS workspace definition statement. For example, in the KOBSITEC workspace scroll towards the end of the first subpanel definition to find the FILTERCOLS statement:

```plaintext
000084 ATOMIZE(WIDTH=30,SCROLL),
000085 TYPE(CAPTION='Type')'
000086 FILTERCOLS='SITNAME'
000088 SORTCOLS=ALL
```

Figure 25. Customized workspace view that shows the second subpanel removed from the (KOBSITEC) workspace
2. Modify the FILTERCOLS definition statement to add another filterable column. For example, in the KOBSTYPE workspace, use the ISPF editor to make the following update:

```
000084 ATOMIZE(WIDTH=30,SCROLL),
000085 TYPE(CAPTION='Type')'
000086
000087 FILTERCOLS='SITNAME, ORIGINNODE'
000088
000089 SORTCOLS=ALL
```

3. Optional: Add the FILTERWHERE=LOCAL statement to specify that filtering is locally applied. For example, in the KOBSTYPE workspace, use the ISPF editor to make the following update:

```
000084 ATOMIZE(WIDTH=30,SCROLL),
000085 TYPE(CAPTION='Type')'
000086
000087 FILTERCOLS='SITNAME, ORIGINNODE'
000088 FILTERWHERE=LOCAL
```

4. Use the ISPF file editor session to save your workspace source changes.

5. Press PF3 (End) in your enhanced 3270 user interface session to close the workspace source view. As the PF3 (End) action is processed, a refreshed view of the modified workspace is displayed.

   **Tip:** The KOBSTYPE workspace is refreshed following a PF3 (End) action. A different workspace might not be refreshed following a PF3 (End) action. If a refresh does not occur, you can exit and reenter the modified workspace to see your changes.

6. Press PF4 or enter the FILTER command on the command line to start the filters dialog. The filters dialog pop-up, shows the filterable columns, as shown in this example:

```
Command ==> KOBSTYPE
```

```
Filter(s)
1. Situation Name............. n/a
2. MSN Event Source........... n/a
```

```
Status
Closed MS_OFFLINE
Open MS_OFFLINE
Open MS_OFFLINE
Open MS_OFFLINE
```

```
Figure 26. Filter dialog pop-up that shows the added filter column
```

### Other workspace customization

Learn about other workspace customizations and related workspace definition parameters.

The following information explains some common workspace definition statements that can be used to customize product provided workspaces. For an example of a detailed procedure to customize a workspace, see “Customizing a workspace” on page 43.

### The initial and refresh cursor position for workspaces

The initial (on-entry) workspace cursor position is specified by the CURSOR= workspace definition statement. For example, CURSOR=HOME specifies that the initial cursor location is in the menu bar command field.
The CURSORREFRESH= workspace definition statement determines the cursor position behavior when the workspace is refreshed or when you return to the workspace, for example, after you enter PF3 (End). For example, CURSORREFRESH=ASIS specifies that the cursor position remains unchanged when you refresh or return to a workspace.

The possible values for the CURSOR= and CURSORREFRESH= statements are as follows:

**HOME**  
Row 00, Column 1

**COMMANDLINE**  
The cursor appears after the command-line prompt, **Command ===>**

**SUBPANEL**  
The cursor appears in the first selectable field of the first subpanel.

**ASIS**  
The cursor remains on the workspace wherever the user placed it.

**Statically defined columns**

Statically defined columns remain static during lateral scroll operations. These columns are usually the primary identification columns for a specific summary subpanel data row. For example, in the case of the KOBSITEC workspace, the Status and Situation Name columns are defined as static. The statically defined columns are controlled by the STATICCOLS= subpanel definition statement. Thus STATICCOLS=2 specifies that the two leftmost columns in a subpanel display are defined as static; that is, the first two columns that are specified in the subpanel DISPLAYCOLS statement as shown in the following excerpt from the KOBSITECworkspace definition:

```
STATICCOLS=2
DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7),
SITNAME(CAPTION='Situation Name',WIDTH=30),
ORIGINNODE(CAPTION='MSN_Event_Source'),
GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),
LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),
ATOMIZE(WIDTH=30,SCROLL),
TYPE(CAPTION='Type')'
```

**Number of columns displayed**

The columns that are displayed in a specific workspace are specified by the DISPLAYCOLS= workspace definition statement. To remove a column from the workspace display, remove its specification in the DISPLAYCOLS definition. To remove the Type column from the KOBSITEC workspace, remove the TYPE(CAPTION='Type') specification from the DISPLAYCOLS definition as shown in the example:

```
STATICCOLS=2
DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7),
SITNAME(CAPTION='Situation Name',WIDTH=30),
ORIGINNODE(CAPTION='MSN_Event_Source'),
GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),
LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),
ATOMIZE(WIDTH=30,SCROLL)
```

**Important:** The closing quotation mark (') that follows the TYPE column specification is not dropped. It is moved to the end of the ATOMIZE column definition. The closing quotation mark signifies the end of the DISPLAYCOLS definition statement.

**Allotted subpanel row count**

For workspaces that provide multiple subpanel displays, there might be cases where it is preferable to adjust the screen space. For example, you might modify the minimum number of rows that are allotted to...
a specific subpanel. This can be illustrated by using the KOBSITEC workspace as an example. The KOBSITEC workspace provides two subpanels, the first subpanel provides a list of Open situations, the second subpanel provides a situation alerts history list. As currently defined, if a user logs on to the interface with the 3270 model 5 emulation mode (27 rows), only the history (second) subpanel headers are displayed when the data rows in the first subpanel exceed five rows. The maximum rows that are allotted to a specific subpanel are defined by the subpanel LINES$nn$ parameter statements as shown in the following excerpt from the KOBSITEC workspace first subpanel definition:

| LINES24=4  |
| LINES32=8  |
| LINES43=12 |
| LINES62=20 |
| LINES90=25 |

Tip: The $nn$ in LINES$nn$ represents the maximum available screen lines for a specific 3270 terminal.

To change the default space that might be allotted to the first workspace subpanel, for example, where most enhanced 3270 user interface users are using low maximum line emulation modes (such as a 3270 model 2 with 24 available lines), you might adjust the LINES24 definition to LINES24=2. This change reduces the screen space that is allotted to the first subpanel and frees up two lines for use by the second subpanel. Alternatively, if the second subpanel is used infrequently and you want more space for the first subpanel, the alternative adjustment might be applied; that is, adjust the LINES24 definition to LINES24=8, allowing up to eight rows of detailed data to be viewed in the first subpanel. This example might be considered extreme. The enhanced 3270 user interface recommended minimum screen size is 43x80, for example, a 3270 model 4 with 43 available lines.

**Workspace sort columns**

The workspace subpanel sortable columns are specified by the SORTCOLS= definition statement. Given that the sort indexes are constructed after row data is retrieved and before the workspace is rendered, the product provided workspaces employ discretionary use of this definition statement, especially in cases where the anticipated returned row set can produce many rows. The product provided workspaces are designed to anticipate the most common use cases.

If, after you use the enhanced 3270 user interface for some time, you find that more sortable columns will improve the usability of a specific workspace, you might consider expanding the SORTCOLS= definition. For example, for the KOBSITEC workspace, if the current SORTCOLS= definition is SORTCOLS='SITNAME', to expand the definition to also include other subpanel columns such as, the MSN Event Source and HUB and Agent Event Time columns, you might change the definition to SORTCOLS='SITNAME, ORIGINNODE, GBLTMTMP, LCLTMSTMP'.

The SORTCOLS definition statement must be defined with discretion, giving thought to potential loading costs. Although it is possible to define SORTCOLS=ALL to enable sorting on any subpanel column, this option is best avoided unless there is a certainty that the retrieved data comprises few data rows.

Note that the SORTCOLS specification can have limited use when a column display value is derived from an internal enumerated list, that is, where the display value is derived from the translation of an internal value. In this case, the sort index is produced from the internal column value. As a result, the column display values might seem to be grouped, but not necessarily in the expected display order.

**Local or agent filter definitions**

The workspace subpanel filterable columns is specified by the FILTERCOLS= definition statement. The following considerations are for using the FILTERCOLS definition statement:

- FILTERCOLS specifications support only the data result row set for the first workspace subpanel that defines the FILTERCOLS statement.
There might be cases where a workspace provides multiple subpanels that share a retrieved data row set, that is, a reusable query. In that case, the filters specification supports all subpanels that share the specific result row set.

The FILTERCOLS workspace operates in conjunction with the FILTERWHERE= definition statement to specify where the filter is applied, either after the data is collected and returned to the enhanced 3270 user interface, or at the agent, during data collection and before the data is returned to the enhanced 3270 user interface. The default FILTERWHERE= definition is FILTERWHERE=AGENT, that is, filter at the agent.

When a FILTERCOLS statement is defined along with FILTERWHERE=AGENT (the default), the filters are applied at the agent. As a result, a FILTERCOLS statement with FILTERWHERE=AGENT does affect the load that is incurred for data retrieval. Assuming the filters are effective, they reduce the amount of data that is collected and returned to the enhanced 3270 user interface.

The FILTERCOLS statement must be used with discretion as they are not always effective. For example, they are most usable with column values that contain text strings. However, their use is limited for a numeric column value or a column value that is derived from an internal enumerated list, that is, where the display value is derived from the translation of an internal value.

For more information about adjusting the filterable columns, see “Adjusting the filterable columns” on page 51.

Remember: There are other workspace definition statements, for example, FILTERVIEW(S) and FILTERSTRIP, that are related to filters that can be specified in the product provided workspaces. Filter definition statements can be complex and changes to product-provided workspace filter definitions must be applied with discretion to avoid unintended side-effects.

**Number and order of workspace subpanels**

The workspace subpanel definition start is specified by the presence of a subpanel start <SUBPANEL> tag statement. The subpanel definition end is specified in one of the following ways:

1. An implicit end that is defined by a <WORKSPACEEND> tag
2. An explicit end that is defined by a <SUBPANELEND> tag
3. An implicit end that is defined by a subsequent <SUBPANEL> tag that signifies the start of another subpanel

Remember: The <WORKSPACEEND> tag signifies the end of the workspace definition.

For more information about removing a subpanel, see “Removing a subpanel” on page 50.

The following considerations are about the subject of removing and or reordering workspace subpanels:

- Given that the subpanel definition boundaries are defined by the <SUBPANEL> and <SUBPANELEND> tag statements or by an implicit end of subpanel, you can make a subpanel order change by moving a block of all lines that define a specific subpanel from one location in the workspace definition to another location.

Remember: For product provided workspaces, the order of workspaces can matter. For example, the retrieved data result set for workspace A might be shared by workspace B. Another example is when workspace B depends on a value that is set by workspace A. Another case is for a silent workspace, that is, a workspace that is not displayed but contributes to the navigation scenario. For example, a silent workspace can run intermediate steps that are required for a subsequent process. Take these considerations into account when customizing a workspace that for example, removes, adds, or reorders subpanels within a specific workspace.
Workspace panel definitions - reference

For more information about workspace definition statements that might have content and order implications, see "Workspace panel definitions" on page 96.

Customizing status indicators

Columns in the enhanced 3270 user interface workspaces use colors to highlight the status of data based on thresholding criteria. If no criteria are set for a status column, the column is displayed in the default status unknown color.

You can change the colors that are associated with a particular status or range in the interface profile, by setting the values for the CUASTATUS keywords.

The CUASTATUS keywords control the color assignments for attributes for which thresholds are defined. When thresholds are defined, one of six states or one of nine range values can be assigned to the item. The state that is assigned to the item when the threshold is reached is reflected in a status indicator. The following colors can be assigned as status indicators: red, white, blue, green, yellow, turquoise, and pink.

The SHOWOKGOOD keyword controls the display of a status indicator for the OKGOOD state. By default, the value for this keyword is N0 to minimize the number of colors in the workspace. However, in some workspaces, you might prefer to display the status.

The possible states and ranges, with default values, are listed here:

<CUASTATUS>
OKGOOD=GREEN
WARNING=YELLOW
CRITICAL=RED
IDLE=BLUE
HIGHLIGHT=TURQUOISE
UNKNOWN=BLUE

SHOWOKGOOD=N0
RANGE1=GREEN
RANGE2=GREEN
RANGE3=GREEN
RANGE4=YELLOW
RANGE5=YELLOW
RANGE6=YELLOW
RANGE7=RED
RANGE8=RED
RANGE9=RED

Modifying predefined thresholds

Workspaces reflect the status of data on the basis of thresholding criteria. Each product that supports the enhanced 3270 user interface provides predefined-thresholds. You can view and modify these thresholds to more accurately reflect your site and user criteria.

Threshold viewing and cloning

The OMEGAMON enhanced 3270 user interface provides the capability to view and clone threshold members.

Threshold viewing and cloning can be used to customize the standard threshold members that are delivered with the enhanced 3270 user interface.

Preparing for threshold member cloning

In preparation for threshold member cloning by an enhanced 3270 user interface user, complete the following administrative steps:
1. Ensure that the user has the required authority.

The cloning process copies a standard product-provided threshold member from a configuration runtime environment data set to a user threshold member data set. The runtime environment data set is a read only data set, the user threshold member data set is a writeable data set. The user that wants to clone a threshold member must have the authority to create new members in the user threshold member data set. The default user threshold member data set name is `<hilev>.<rtnname>.RKANPARU`.

**Tip:** For security reasons, you might not be able to grant users write or update authorization to the `<hilev>.<rtnname>.RKANPARU` data set. In that case, complete the following steps:

a. Create an alternative data set with attributes that match the `<hilev>.<rtnname>.RKANPARU` data set attributes.

b. Change the enhanced 3270 user interface started task JCL to include the alternative data set in the UKANPAR DD statement data set concatenation.

c. Grant users authorization to this data set.

d. Create the `user ID` custom threshold members in this data set.

2. Ensure that the user threshold member data set is the first data set that is specified in the RKANPAR DD statement. The user threshold member data set is the data set that is pointed to by the enhanced 3270 user interface started task JCL RKANPARU DD statement.

If you ensure that it is the first data set, threshold member testing is facilitated when customization changes are applied.

**Important:** Be sure that you specify the same `<hilev>.<rtnname>.RKANPARU` or alternative data set first in both the UKANPARU DD and RKANPAR DD statements.

3. Minimize potential disruptions to other enhanced 3270 user interface users.

Because the cloning and customization process modifies product provided thresholds, it must be done in a configuration that is not disruptive to ongoing normal usage of the enhanced 3270 user interface. For example, a separate enhanced 3270 user interface address space with a unique instance of the user threshold member data set might be used during the customization and testing process. After the customization and testing, the changes might be deployed to a shared development or production configuration by copying the customized threshold members into a corresponding data set that is specified in the shared development or production configuration enhanced 3270 user interface started task JCL.

**Related tasks:**

"Customizing thresholds"

Each product has its predefined thresholds in a KppTHRSH member of the TKANPAR data set. For example, OMEGAMON XE for CICS on z/OS has a KCPTHRSRSH member, and OMEGAMON XE on z/OS has a KM5THRSH member. Create your own threshold members to customize these thresholds.

"Cloning Thresholds" on page 59

Use the Configuration workspace to make a copy of a threshold member and save it to a user-defined thresholds data set.

**Customizing thresholds**

Each product has its predefined thresholds in a KppTHRSH member of the TKANPAR data set. For example, OMEGAMON XE for CICS on z/OS has a KCPTHRSRSH member, and OMEGAMON XE on z/OS has a KM5THRSH member. Create your own threshold members to customize these thresholds.

**About this task**

You can customize site or user specific thresholds by creating override threshold members for the site or for a specific user. These site or user override threshold members are not intended to be modified copies of the default members. Ideally, these custom members should include only the changes that you want to make. These custom members must be named CUASIT, for site-wide thresholds, or `user ID`, for user specific thresholds. The member name `user ID` is the users TSO/SAF user ID.
You can also customize a subset of product provided thresholds by cloning a threshold member named KppTHRSH that is a complete copy of the original predefined threshold member. You update this copy with your changes and it then replaces the original predefined threshold member. The product code is pp.

To determine the threshold or thresholds that apply to each workspace and subpanel, for each product whose thresholds you want to change, check the KppTHRSH member for comments similar to those in the following screen capture:

```
000009 ************************************************************************
000010 * TABLE : KCPPLX *
000011 * *
000012 * PANEL ID: KCPPLXS - ENTERPRISE CICSplex SUMMARY *
000013 * SUBPANEL: 1 - ALL ACTIVE CICSplexes *
000014 ************************************************************************
000015 IF ( OMCICS.KCPPLX.TRANRATE GT 1000/MIN OR
000016 OMCICS.KCPPLX.TRANRATE LT 100/MIN
000017 )
000018 THEN DO
000019 STATUS ( CRITICAL 9 )
000020 ENDDO
000021 IF ( OMCICS.KCPPLX.TRANRATE EQ 900/MIN<>1000/MIN OR
000022 OMCICS.KCPPLX.TRANRATE EQ 100/MIN<>300/MIN
```

**Remember:** There is no runtime validation of threshold syntax. If you customize thresholds and they are failing, check the SYSPRINT log for errors.

**Procedure**

1. Locate and clone the threshold member or members that contain the threshold or thresholds that you want to modify. Use one or more of the following choices when creating cloned threshold members.
   - Create a cloned member named user ID for user-level thresholds. The user ID member must include only the subset of thresholds that you want to modify for a specific user. If you use user ID for the custom thresholds, you must have a user profile for the same ID in the UKOBDATF data set.
   - Create a cloned member named CUASITE for a site-wide thresholds. The CUASITE member must include only the thresholds that you want to modify on a site-wide basis.
   - Create a cloned member named KppTHRSH to modify product specific thresholds. This KppTHRSH member must be a complete copy of the original predefined threshold of the same name.

   For more information about cloning a threshold member, see “Threshold viewing and cloning” on page 56.

2. Edit the new threshold member to change threshold definitions. Use a file editor such as the ISPF editor to do this. Use the information about threshold syntax to edit the definition.

3. To reload the threshold definitions, from the Tools menu in the enhanced 3270 user interface, select option 4, Refresh Thresholds, alternatively, issue the operator command:

   `/F ui_stc_name,THRESHREFRESH`

4. Log off and log on.

**Results**

The user interface establishes the profile in effect for the current session as follows:

- The interface looks for a profile member with the user ID.
- If no profile member is found with the user ID, the interface looks for the CUASITE member.
- If no CUASITE member is found, the interface looks for the KOBCUA member.

The name of the first profile member that is found is used to establish thresholds from the same-named member in the PDSs in the user interface DD: allocation specified by the THRESHOLDS_SOURCE environmental variable, or DD:RKANPAR if the environmental variable is not specified.
Thresholds are applied in the following order: userid, CUASITE, KppTHRSH.

**Cloning Thresholds**

Use the Configuration workspace to make a copy of a threshold member and save it to a user-defined thresholds data set.

**Before you begin**

You must complete some administrative steps before a threshold member is cloned. For more information about these steps, see "Threshold viewing and cloning" on page 56.

**Procedure**

1. Identify the threshold member that you want to clone.
2. Go to the Runtime Environment (Configuration) workspace to browse the available profiles. There are a number of ways you can go to the Runtime Environment (Configuration) workspace:
   - From the menu bar, select **Tools > Runtime Environment**. The workspace opens. Then, move your cursor over the **Thresholds** button and press **Enter**.
   - Move your cursor over the RTE icon in the drawer and press **Enter**. The Runtime Environment workspace opens. Then, move your cursor over the **Thresholds** button and press **Enter**.

   The Runtime Environment workspace presents two workspace subpanels that provide directory lists for the user threshold member data set (UKANPAR DD) and the runtime environment profiles data set (RANPAR DD).

3. On the command line, enter the Locate command. Specify the threshold member name that you want to search for as an argument and press **Enter**. The directory view is positioned in the context of the threshold member name that you entered. The Locate command can be shortened to **L**. For example, if you enter **L KM5THRSH** on the command line and press **Enter**, the view is positioned similarly to **Figure 27**.
4. Place the cursor in the input field of the profile name that you want to clone and press Enter. For example, to select the KM5THRSH profile, place the cursor in the input field that precedes the profile name and press Enter. The Partitioned Dataset Member (KOBPD5D) view opens showing a view of the KM5THRSH profile content.

5. To clone the threshold member that is being viewed, select File > Save As. For example, to clone the KM5THRSH profile that is being viewed in the previous step, place the cursor under File on the menu bar and press Enter. Then, from the File menu select option 4, Save As by typing a or 4 and pressing Enter.

**Fast path:** You can fast path to File > Save As by entering f.a in the action line.

![Figure 28. Cloning a threshold member by using the File > Save As menu option.](image)

When you press Enter, the Member Save As dialog box opens:

![Figure 29. Cloning a threshold member - the Member Save As dialog box.](image)

6. Enter the threshold member name that you want to use for the cloned threshold member. If you are cloning a product-provided threshold member to supersede the product provided instance of the same workspace, the Save As name that you enter must be identical to the name of the product provided-threshold member, as shown in Figure 29. The saved threshold member is written to the user threshold data set. The original product-provided threshold member is preserved intact in the runtime environment data set. When you press Enter, the Save As action is confirmed and you are returned to the Partitioned Dataset Member (KOBPD5D) view.

7. Press PF3 (End) to return to the Runtime Environment (Configuration) KOBPROFS workspace.

**Results**

The profile directory view for the user profile data set now lists the cloned profile, as shown in the following example:
What to do next

When the threshold member cloning is complete, edit and test the threshold member, customizing its contents to user requirements. To do this use a file editor such as the ISPF editor.

Disabling thresholds

Disable threshold specifications to eliminate status indicators but leave the unmodified threshold specification in place.

Procedure

To disable a threshold, edit the definition to specify `STATUS(NOSTATE NORANGE)`. The evaluation still takes place but no data is highlighted in the workspace if the threshold criteria are met.

Syntax for threshold specification

Use the syntax, values, and parameters described here to modify predefined thresholds.

Specification of thresholds uses the following syntax:
Parameters

Each threshold specification consists of six required elements and three optional elements that are used when a complex threshold is specified:

**IF keyword**

This keyword indicates the beginning of the threshold specification. Internal parsing considers all text between IF statements as a threshold specification. Only the first column in the IF statement is statused if it evaluates positively.

**Left parenthesis – (**

An optional left parenthesis is used to help group connected thresholds in a complex threshold specification. Specification of the left parenthesis is optional, but if specified it is treated based on the normal rules of operator precedence. That is, the highest level of precedence among parentheses and AND and OR operators. Each left parenthesis must be matched in the complex threshold specification by a corresponding right parenthesis or errors will be flagged during parsing.

Note: This parenthesis MUST be preceded and succeeded by at least one blank.

**application_name.table_name.column_name**

This triplet must follow the IF keyword with each of the three components delimited by a period. The triplet must be contiguous, that is, must contain no embedded blanks.

**Comparator**

This 1-2 byte specification must follow the application.table_name.column.name triplet. Valid comparators are:

<table>
<thead>
<tr>
<th>Comparator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ</td>
<td>compare equal</td>
</tr>
<tr>
<td>=</td>
<td>compare equal</td>
</tr>
<tr>
<td>NE</td>
<td>compare not equal</td>
</tr>
<tr>
<td>!=</td>
<td>compare not equal</td>
</tr>
<tr>
<td>GT</td>
<td>compare greater than</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Comparison value or range of values

This value must follow the comparator with the following formats supported:

- The value is considered a string if enclosed by double-quotes. Up to 70 characters may be specified.

Note: If a comparator other than EQ or “=” is used against a string the assumption is that a numeric string value is being thresholded. Currently, the UI data value and the threshold value are right-justified before comparison in these situations. This will provide expected threshold comparison results for numeric values that are specified with the same number of decimal places, scaling units but no parsing of the string is attempted in the evaluation to “normalize” the strings.

- Decimal integer, preceded by an optional sign character (+ or -), in the range -2^63 + 1 through 2^63 – 1, that is, -9,223,372,036,854,775,807 to +9,223,372,036,854,775,807. A decimal point may be inserted in any position, including as first or last in the value: that is, 1234. and .1234 are valid.

- Hexadecimal value in the range 0x8000000000000000 through 0x7FFFFFFFFFFFFFF. After the 0x prefix, 1–16 hexadecimal digits can be specified; for example, 0x3F is valid.

- Optionally, a range of values may be specified using a <> symbol immediately after and contiguous to the 1st decimal or hexadecimal value. The second, upper value in the range must follow the same specification rules as the first value in the range though a mixture of decimal and hexadecimal values can be specified if desired. The second value must immediately and contiguously follow the range symbol.

Note: The use of the <> symbol may be replaced by a compound IF statement such as IF (a.b.c >= value1 AND a.b.c <= value2).

- A suffix specifying the units that apply to the numeric value(s) can optionally be specified. The unit characters must immediately follow, and be contiguous with, the numeric value they apply to. Valid unit specifications are:

  - K scales the numeric value by a factor of 1024
  - M scales the numeric value by a factor of 1024*1024
  - G scales the numeric value by a factor of 1024*1024*1024
  - T scales the numeric value by a factor of 1024*1024*1024*1024
  - P scales the numeric value by a factor of 1024*1024*1024*1024*1024
  - E scales the numeric value by a factor of 1024*1024*1024*1024*1024*1024

  - ms milliseconds, scales the numeric value to seconds by a factor of 1000

  - csec centiseconds, scales the numeric value to seconds by a factor of 100

  - sec seconds, no scaling

  - /sec units per second, scales to rate per hour internally (*3600)
units per minute, scales to rate per hour internally (*60)

units per hour, no scaling

percentage, no scaling

Right parenthesis – )

An optional right parenthesis is used to help group connected thresholds in a complex threshold specification. Specification of the right parenthesis is optional but if specified will be treated based on the normal rules of operator precedence. That is, the highest level of precedence amongst parentheses and AND and OR operators. Each right parenthesis must be matched in the complex threshold specification by a corresponding left parenthesis or errors will be flagged during parsing.

Note: This parenthesis MUST be preceded and succeeded by at least one blank.

Connector AND and OR keywords

The connector between any two individual thresholds, or parenthesized groups of thresholds, must be an AND or an OR keyword. If both are used in a complex threshold, normal rules of precedence and associativity apply. That is, AND has higher precedence than OR if no parentheses are used or both connectors are contained within a single left and right parentheses pair. Associativity is left to right.

THEN DO keywords

THEN DO must be specified after the threshold IF statements with a corresponding terminating ENDDO keyword. The THEN DO and ENDDO keywords are specified before and after one or more of the STATUS, ZOOMDEST or HELPDEST keywords and keyword values.

STATUS keyword

STATUS is an optional keyword that can follow the comparison DO THEN keywords.

(status_state, status_range)

This is a parenthesized, space-delimited pair of two keyword parameters that designate one or two statuses for interpretation by the user Interface. Both designation types must be specified. Specific keywords indicating that one or more of the status designations does not apply to the current threshold (NOSTATE or NORANGE) are used in place of an actual value. At least one blank must be specified between the STATUS keyword and the left parenthesis.

Note: The status_state value takes precedence over the status_range specified if both are specified.

• status_state sets the state to be interpreted by the user interface. Valid specifications are:
  – GOOD
  – WARNING
  – CRITICAL
  – IDLE
  – NOSTATE

• status_range sets a value in the range 0 through 9 (0 is equivalent to the NORANGE keyword) to augment the column data in the user interface subpanel. Valid specifications are:
  – Numeric value in the range 0 through 9
  – NORANGE

ENDDO keywords

ENDDO must be specified after the threshold STATUS statements with a corresponding initiating THEN DO keyword pair.
Acceptable formats

Hexadecimal
0xH - 0xHHHHHHHHHHHHHHH
0XH - 0XHHHHHHHHHHHHHHH
1-16 hexadecimal digits

Decimal
(+/-)(.)nnnnnnnnnnnnnnnnn - (+/-)nnnnnnnnnnnnnnnnn(.)
1-19 decimal digits with decimal point in any position including 1st or last character position

Scaling suffix
(1024) K (kilobytes), M (megabytes), G (gigabytes), T (terabytes), P (petabytes), E (exabytes)

Percentage
%

Time suffix
ms, csec, sec

Rate
/sec, /min, /hr

String
1-70 characters enclosed by double quotes
Chapter 6. Administration

The OMEGAMON enhanced 3270 user interface provides workspaces to help administrators to view and customize the interface and to validate hub monitoring server connections.

The following workspaces assist administrators:
- Runtime Environment (RTE) viewing
- Workspace source viewing
- Profile customization
- Hub connectivity administration

### Runtime environment viewing

Use the Runtime Environment workspace to view the Runtime environment and its partitioned data set members.

#### Procedure

1. Go to the Runtime Environment workspace to view the Runtime environment. There are a number of ways you can go to the Runtime Environment workspace:
   - Select **Tools > Runtime Environment**. Do this action by placing the cursor under **Tools** on the menu bar and pressing **Enter**. Then, from the **File** menu select option 8.
   - Move your cursor over the **RTE** icon in the drawer and press **Enter**.

The Runtime Environment **KOBJCLS** workspace opens. The workspace presents a lists of data sets in the Runtime JCL.

![Runtime Environment workspace](image-url)
Use the scrolling arrows or the PF7 and PF8 keys to scroll through the list of available data sets.

2. Optional: Place your cursor on the input field before a data set, type i and press Enter to see more information about a data set. The Data Set Information workspace opens and shows you information about the data set, as shown in the following example:

![Figure 32. Data Set Information workspace](image)

3. Optional: Place your cursor on the input field before a data set name and press Enter to browse the members of a data set. The Partitioned Dataset Summary workspace opens, as shown in the following example:

![Figure 33. Partitioned Dataset Summary workspace](image)

**Restriction:** JES data sets are listed in the Runtime Environment workspace but cannot be browsed.

4. Optional: Place your cursor on the input field before a data set member name and press Enter to view the data set source.

5. Press PF3 (End) until you return to the Runtime Environment workspace.

6. Use the lateral navigation buttons on the Runtime Environment workspace to go to workspaces that show views of both user and runtime data sets for workspaces, profiles, and thresholds.
Tip: The Exit button returns you to your logon workspace.

Related tasks:
“Cloning a workspace” on page 36
Make a copy of a workspace and save it to your private data set.
“Cloning a Profile” on page 71
Use the Profiles workspace to make a copy of a profile and save it to the user profiles data set.
“Cloning Thresholds” on page 59
Use the Configuration workspace to make a copy of a threshold member and save it to a user-defined thresholds data set.

Viewing a workspace source

Use a menu selection to view the source for a workspace.

Procedure

1. Go to the workspace whose source you want to view.
2. Select View > Workspace Source The Partitioned Dataset Member (KOBPDSD) view opens showing a view of the workspace source. Use the function keys or the cursor sensitive arrow controls to scroll through the source view.

What to do next

If you want to modify the workspace source, you can first clone (make a copy) the workspace and then use a file editor such as the ISPF editor to edit the cloned workspace. For more information about cloning and customization of workspaces, see “Workspace viewing and cloning” on page 35 and “Customization of product provided workspaces” on page 40.

Customizing the interface

The appearance of various components of the interface are controlled by an interface profile. The interface profile controls the color assigned to various elements of the interface, the actions assigned to PFKEYs, the language in which information is present, and the initial workspace displayed after you log on. IBM supplies a default profile named KOBCUA. You can create site-specific or individual user profiles by copying and renaming the default profiles and changing the default values to suit your preferences. You can also create site-specific locale profiles for users at different locations.

For more information about locale profiles, see “Locale profiles” on page 74.

Interface profiles

Interface profiles, also referred to as logon profiles, control the appearance of workspaces and the source from which data is collected. There are three types of interface profiles: IBM default, site, and user.

Interface profiles specify session configuration values for the following workspace properties:
• Locale (which controls display formats for date and time, monetary values, and separators)
• The color of workspace elements such as headers, borders, and text
• The color of status indicators
• The initial workspace a user sees
• The hub monitoring server from which data is collected
• The number of cycles before the auto update is suspended.

The default KOBCUA profile contains session configuration defaults.

You can create a site-defined profile to define settings that are different from the IBM-supplied defaults. This customized profile becomes the default for all enhanced 3270 interface sessions at the installation. It takes precedence over the IBM-supplied profile. The installation-defined profile must be named CUASITE.

You can create a user profile to customize users’ individual sessions. The user-defined profile takes precedence over the installation- and IBM-supplied profiles. Name the user profile with the user ID that will be used to log on to the interface. Users can use the User Profile Member workspace to customize their profiles. For more information about customizing a user profile, see “Customizing a user profile” on page 27.

The IBM-supplied profile is always available and cannot be changed. You must create one or more custom profiles based on the IBM-supplied profile and use them to specify the hub monitoring server from which data is to be collected for display in the enhanced 3270 user interface.

To create custom site and user interface profiles, copy the IBM-supplied KOBCUA profile to a private read/write data set. For more information about creating a custom profile, see “Creating a custom interface profile.”

Creating a custom interface profile

Create custom interface profiles to specify site or individual preferences for display colors, the initial workspace, and the source for the data that is displayed.

Custom profiles are stored in the &hilev.&midlev.UKOBDATF data set, which is created during configuration of the interface.

Procedure
1. In the UKOBDATF data set, create a member with the name CUASITE (for a site profile) or with the user ID that will be used to log on to the enhanced 3270 user interface with the profile (for a user profile). This is usually a TSO user ID. Use the profile viewing and cloning feature to create the member. For more information about profile viewing and cloning, see “Profile viewing and cloning.”
2. Edit the member and modify it to reflect the site or user preferences.
3. To activate the changes log off the interface and then log back on again.

Profile viewing and cloning

You can use the OMEGAMON enhanced 3270 user interface to view and clone user profiles.

Use Profile viewing and cloning to customize the standard user profiles that are delivered with the enhanced 3270 user interface.

Preparing for profile cloning

In preparation for profile cloning by a user complete the following administrative steps:
1. Ensure that the user has the required authority.
   The cloning process copies a standard product-provided profile from a configuration runtime environment data set to a user profile data set. The runtime environment data set is a read only data set, the user profile data set is a writeable data set. The user that wants to clone a profile must have the authority to create new members in the user profile data set. The default user profile name is &hilev.&rtnename.UKOBDATF.
2. Ensure that the user profile data set is the first data set that is specified in the RKOBPROF DD statement. The user profile data set is the data set that is pointed to by the enhanced 3270 user interface started task JCL UKOBDATF DD statement.
   
   If you ensure that it is the first data set, it facilitates profile testing when customization changes are applied.

   **Important:** Be sure that you specify the same `<hilev>.<rtename>.UKOBDATF` data set in both the UKOBDATF DD and RKOBPROF DD statements.

3. Minimize potential disruptions to other enhanced 3270 user interface users.
   
   Because the cloning and customization process modifies product provided profiles, it must be done in a configuration that is not disruptive to ongoing normal usage of the enhanced 3270 user interface. For example, a separate enhanced 3270 user interface address space with a unique instance of the user profile data set might be used during the customization and testing process. After the customization and testing, the changes might be deployed to a shared development or production configuration by copying the customized profiles into a corresponding data set that is specified in the shared development or production configuration enhanced 3270 user interface started task JCL.

**Related tasks:**

"Cloning a Profile"

Use the Profiles workspace to make a copy of a profile and save it to the user profiles data set.

**Cloning a Profile:**

Use the Profiles workspace to make a copy of a profile and save it to the user profiles data set.

**Before you begin**

You must complete some administrative steps before a profile is cloned. For more information about these steps, see "Profile viewing and cloning" on page 70.

**Procedure**

1. Identify the profile to be cloned.

2. Go to the Runtime Environment (Profiles) workspace to browse the available profiles. There are a number of ways you can go to Runtime Environment (Profiles) workspace:
   - From the menu bar, select **Tools > Runtime Environment**. The Runtime Environment workspace opens. Then move your cursor over the **Profiles** button and press **Enter**.
   - Move your cursor over the **RTE** icon in the drawer and press **Enter**. The Runtime Environment workspace opens. Then move your cursor over the **Profiles** button and press **Enter**.

   The Runtime Environment (Profiles) **KOBPROFS** workspace opens. This workspace presents two workspace subpanels that provide directory lists for the user profile data set (UKOBDATF DD) and the runtime environment profiles data set (RKOBPROF DD).
3. Place the cursor in the input field of the profile name that you want to clone and press **Enter**. For example, to select the KOBCUA profile, place the cursor in the input field that precedes the profile name and press **Enter**. The Partitioned Dataset Member (KOBPDSD) view opens showing a view of the KOBCUA profile content.

4. To clone the profile that is being viewed, select **File > Save As**. For example, to clone the KOBCUA profile, place the cursor under **File** on the menu bar and press **Enter**. Then, from the **File** menu select option 4, **Save As** by typing a 4 and pressing **Enter**.

**Fast path:** You can fast path to **File > Save As** by entering f.a in the action line.

---

**Figure 35. Runtime Environment (Profiles), locating the profile member**

**Figure 36. Cloning a profile by using the File > Save As menu option**

When you press **Enter**, the Member Save As dialog box opens:
5. Enter the profile name that you want to use for the cloned profile. A typical site administration task is to clone the KOBCUA profile to create a site-defined profile that must be named CUASITE. In this example CUASITE is entered in the New Name field. The saved CUASITE profile is written to the user profile data set. The original IBM-provided KOBCUA profile is preserved intact in the runtime environment data set. Because the CUASITE profile is a special case, it is also written to the runtime environment data set and it takes precedence over the IBM-provided KOBCUA profile for all users of the installation. If a name other than CUASITE is entered in the New Name field, the saved profile is written only to the user profile data set. To take precedence over the IBM-provided KOBCUA profile and the site CUASITE profile for a specific user, name the profile with the user ID of the specific user. When you press Enter, the Save As action is confirmed and you are returned to the Partitioned Dataset Member (KOBPDSD) view.

6. Press PF3 (End) to return to the Runtime Environment (Profiles) KOBPROFS workspace.

Results

The profile directory view for the user profile data set now lists the cloned profile, as shown in the following example:

<table>
<thead>
<tr>
<th>Name</th>
<th>Conc#</th>
<th>Size</th>
<th>Created</th>
<th>Changed</th>
<th>Time</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUASITE</td>
<td>0</td>
<td>121</td>
<td>2013/03/29</td>
<td>2013/03/29</td>
<td>08:25:54</td>
<td>MTRUS</td>
</tr>
</tbody>
</table>

Figure 38. User profile data set that shows a cloned profile
What to do next

When the profile cloning is complete, edit and test the profile, customizing its contents to user requirements. Use a file editor such as the ISPF editor to edit the profile.

Remember: Your users can use the User Profile Member workspace to set many of their profile settings directly. For more information about this workspace, see Customizing a user profile on page 27.

Locale profiles

The locale profile controls the display of date, time, currency symbol, and thousandth separator. IBM supplies a default profile, KOBENUS, that defines display characteristics that are based on United States English. You can create profiles that specify different display characteristics.

A locale profile is a member of the data set allocated to the RKOBPROF DD statement. The name of the member must be KOBlocale_id, where locale_id is the 4-character identifier that is specified in the interface profile for the session, for example, in the member KOBENUS, ENUS is the identifier that denotes an English (United States) profile.

Creating a custom locale profile

Create custom locale profiles to specify your preferences for the date and time format, the currency symbol, and the thousands separators.

Custom profiles are stored in the &hilev.&midlev.UKOBDATF data set.

Procedure

1. In the UKOBDATF data set, create a member with the name KOBcccc, where cccc is the 4-character locale ID, for example KOBEUR0 for a profile with European formats. Use the profile viewing and cloning feature of the interface to complete this step. For more information about profile viewing and cloning, see Profile viewing and cloning on page 70.
2. Edit the member and modify it to reflect the user preferences. See Locale profile keywords for keyword descriptions and possible values.
3. To activate the changes, log off and back on to the interface.

Remember: If you add a new DD statement for the profile definitions, you must recycle the interface to activate the changes.

What to do next

After you create the custom profile, update any site or user profiles that you want to reference the new profile. For this example, you specify LOCALEID=EURO in the site or user profiles. Code RKANWEUR DD in your procedure and concatenate the data sets with the workspaces to it.

Locale profile keywords

Settings in the locale profile are configured using keyword=value pairs. The keywords are grouped into two stanzas: LOCALE and ACTIONBAR.

The <LOCALE> stanza contains the following keywords:

- LOCALEDESC: A description of the profile.
- DATEFORMAT: Three date formats are supported:
  - MM/DD/YYYY (the default)
  - DD/MM/YYYY (European)
• YYYY/MM/DD (global)

**TIMEFORMAT**
Time format can be 12 (default) or 24

**CURRENCY**
Not currently implemented.

**THOUSANDPOS**
Not currently implemented.

**SCALING**
Not currently implemented.

**MICROSECOND**
Not currently implemented.

The locale profile also contains an `<ACTIONBAR>` stanza that define the menus and menu options in the action bar that appears at the top of workspaces. These definitions cannot be changed.

---

**Hub connectivity administration**

Hub connectivity administration is used to validate that a requested hub Tivoli Enterprise Monitoring Server can be reached through a TCP/IP connection during the operation of the OMEGAMON enhanced 3270 user interface.

Hub connectivity administration provides information about the user interface address space that you are running in, on what LPAR, and, in what Sysplex. If your current profile does not specify a hub monitoring server for your user interface address space, hub connectivity administration assists you in locating all the available hub monitoring servers in your Sysplex. When you locate the available hub monitoring servers, hub connectivity administration then helps you to select and make a good connection to the hub. When you establish a good hub connection, the connection produces useful data on the user interface.

Hub connectivity administration also provides you with the following information:

- A status overview of every hub monitoring server that is known to the user interface
- The Managed System Names and Managed System Lists that are known for each hub monitoring server
- The starting point for access to the IBM Tivoli Monitoring Service Index, Tivoli Monitoring Service Consoles, and Tivoli Monitoring SOAP servers that are known for each hub monitoring server.

**Validate a requested hub Tivoli Enterprise Monitoring Server**

While you are interacting with the OMEGAMON enhanced 3270 user interface, a hub Tivoli Enterprise Monitoring Server data source is needed to handle SQL queries that are issued by the user interface workspaces that you want to display.

During the installation of the enhanced 3270 user interface, part of the configuration process is to specify the hub monitoring server, which includes the name of the monitoring server, the IP address, and port number that the SQL queries are sent. For example, as shown in the following screen capture:
When you log on to the user interface, the hub monitoring server specifications are retrieved from your profile, and an attempt is made to connect to that hub. If the connection attempt is successful, the initial workspace panel for your profile is displayed, for example, the Enterprise Summary (KOBSTART) workspace.

If the hub monitoring server connection attempt fails, the Hub Connectivity Administration workspace is displayed, as shown in Figure 43 on page 79. This workspace notifies you that a failure occurred and the possible reason for the connection failure.

These are some of the reasons for failed connections to a requested hub monitoring server:

- The name of the hub monitoring server is incorrect (names are case-sensitive).
- The hub monitoring server IP address is incorrect.
- The hub monitoring server TCP/IP port number is incorrect.
- The hub monitoring server is not operational (not started or is having communications problems).
- TCP/IP or UNIX System Services (USS) on the z/OS system that is running the user interface address space is not configured to allow TCP/IP communications between the interface and the hub monitoring server.
- A TCP/IP firewall is preventing successful communications between the interface and the hub monitoring server.

**Logon administration and customization**

When you log on to the enhanced 3270 user interface for the first time, Hub Connectivity Administration can assist you to specify a hub Tivoli Enterprise Monitoring Server connection.

**Procedure**

1. Log on to the user interface in the standard way. For more information about logging on, see "Logging on" on page 4. If a hub monitoring server is specified in your profile, and that hub is available, a connection is made to the hub and your initial workspace is displayed. By default, the initial workspace is the Enterprise Summary (KOBSTART) workspace. If a hub monitoring server is not specified in your profile, the Hub Connectivity Administration workspace is displayed.
2. To select the NEXT icon on the Hub Connectivity Administration workspace, move your cursor to the icon and press Enter or double-click the icon. The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known to the enhanced 3270 user interface.

Figure 40. Hub Connectivity Administration workspace that shows a hub connection is not specified for the current profile

Figure 41. Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace
Tip: You can browse overview status information about each hub from this workspace. For more information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs workspace” on page 83.

3. On the All Known Hubs (KOBHUBS) workspace, place your cursor next to a hub monitoring server name and press Enter. The Action Confirmation panel is displayed. The panel lists information about the hub monitoring server to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the action or N to cancel the action.

4. Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and shows two green information boxes that indicate a successful TCP/IP connection.

   a. To save the hub monitoring server name to your user profile, select SAVE.
   b. To use the selection for your current enhanced 3270 user interface session, select OK.

Results

Your session goes to the first workspace name specified in your logon profile, by default the Enterprise Summary (KOBSTART) workspace.

Correcting a failed hub server connection

Use Hub Connectivity Administration to assist you in locating all of the available Tivoli Enterprise Monitoring Server data sources. Hub Connectivity Administration helps you to correct any failed connection situations that prevent you from accessing the OMEGAMON enhanced 3270 user interface and your subsequent product workspaces.

About this task

When you log on to the user interface, if the hub monitoring server connection attempt fails, the Hub Connectivity Administration workspace is displayed and notifies you that a failure occurred and the possible reason for the connection failure. The workspace helps you to correct the connection failure and
to save a corrected profile to prevent future failures.

**Tip:** If this is your first time logging on to the user interface and a hub monitoring server is not specified in your profile, you see the Hub Connectivity Administration workspace but with a different message that states the reason for the failure. If the message indicates that your current profile does not have a hub specified, see “Logon administration and customization” on page 30.

**Procedure**

1. On the Hub Connectivity Administration workspace that shows the connectivity failure, select the **NEXT** icon by moving your cursor to the icon and pressing **Enter** or moving your mouse to the icon and selecting it. The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known to the user interface.
Tip: You can browse overview status information about each hub from this workspace. For more detailed information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs workspace” on page 83.

2. On the All Known Hubs (KOBHUBS) workspace, place your cursor next to a hub monitoring server name and press Enter. The Action Confirmation panel is displayed. The panel lists information about the hub monitoring server to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the action or N to cancel the action.

3. Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and shows two green information boxes that indicate a successful TCP/IP connection.

Figure 44. Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace
To save the hub monitoring server name to your user profile, select the SAVE icon.

To use the selection for your current user interface session, select the OK icon.

**Results**

Your session goes to the first workspace name specified in your logon profile, by default the Enterprise Summary (KOBSTART) workspace.

**Changing a hub server connection**

Use Hub Connectivity Administration to change your existing hub connection.

**Before you begin**

If you have not yet successfully connected to a hub monitoring server, see “Correcting a failed hub server connection” on page 78.

**About this task**

When you are logged on to the user interface, and are successfully connected to a hub monitoring server, you can use Hub Connectivity Administration to browse other hub connections that are available. While browsing the available hubs, you can select and connect to a different hub. Finally you can use the workspace to save the newly specified hub connection to your profile, either for the current session only, or to your profile for future sessions.

**Procedure**

1. Go to the Hub Connectivity Administration workspace. To go to Hub Connectivity Administration workspace, select Tools > Current Hub Information from the menu bar or move your cursor over HUB in the drawer and press Enter. The Hub Connectivity Administration workspace is displayed.
2. On the Hub Connectivity Administration workspace, select the NEXT icon by moving your cursor to the icon and pressing Enter or moving your mouse to the icon and selecting it. The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known to the user interface.
The existing hub connection is highlighted as shown in the screen capture.

**Tip:** You can browse overview status information about each hub from this workspace. For more detailed information about the All Known Hubs (KOBHUBS) workspace, see "The All Known Hubs workspace."

3. On the All Known Hubs (KOBHUBS) workspace, select a different hub by placing your cursor next to a hub monitoring server name and press Enter. The Action Confirmation panel is displayed. The panel lists information about the new hub monitoring server to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the action or N to cancel the action.

4. Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and shows two green information boxes that indicate a successful TCP/IP connection.

   a. To save the hub monitoring server name to your user profile, select the SAVE icon.
   b. To use the selection for your current user interface session, select the OK icon.

**Results**

Your session goes to the first workspace name specified in your logon profile, by default the Enterprise Summary (KOBSTART) workspace.

**The All Known Hubs workspace**

You can use the All Known Hubs workspace to view status information about each of the available hub Tivoli Enterprise Monitoring Servers in your Sysplex.

Use the All Known Hubs workspace to select and connect to an available hub monitoring server. The connection procedure is detailed in other topics. For more information about the connection procedure, see "Changing a hub server connection" on page 81, "Correcting a failed hub server connection" on page 78, and "Logon administration and customization" on page 30.
You can use the All Known Hubs workspace to view valuable status information about each hub monitoring server that can help you decide the hub to use for your monitoring activities.

The workspace can be scrolled vertically and horizontally to view all of the available hubs and their status information. You can use PF10 and PF11 keys to scroll horizontally and PF7 and PF8 keys to scroll vertically. The workspace also contains vertical and horizontal arrow keys that you can use for scrolling. Select an arrow and press Enter to scroll in this way.

![Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace](image)

**Figure 49. Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace**

### Hub status information

The following fields are displayed for every hub in the All Known Hubs workspace

**Hub Name**

The name that is given to a hub monitoring server during IBM Tivoli Monitoring configuration of a runtime environment (RTE).

**Hub Connect Status**

A text value that indicates whether a TCP connection can be established between the enhanced 3270 user interface address space and the specific hub monitoring server and whether an SQL query can be issued to the hub monitoring server. This TCP connection is attempted and then immediately closed. The TCP port number that is used is the port number that is assigned to this hub monitoring server during Tivoli Monitoring configuration of an RTE (typically port number 1918). Check the user interface REXX log (RKANRXLG DD name) for more details if the status is not Success.

The text values in the Hub Connect Status field can be as follows:

- **Success**
  - The TCP connect and a query completed at the Hub.

- **Data Failure**
  - A TCP send or receive failed with the Hub.
Timed Out
A TCP connect cannot complete in the allotted time.

Connect Fail
The TCP connect cannot complete.

TCP Failure
TCP cannot connect because of a failure with a TCP socket or select call.

Query Failed
A TCP connect was successful, but an SQL query to the Hub did not complete.

Cannot Access
The TCP port number to access the Hub cannot be determined.

SAF Denied
The status cannot be determined because the user does not have security authorization to connect to the specified Hub.

**ITM Service Index Status**
A text value that indicates whether a TCP connection can be established between the enhanced 3270 user interface address space and the IBM Tivoli Monitoring Service Index component that is running at the specific hub monitoring server and whether the Tivoli Monitoring Service Index data can be retrieved. The TCP port number that is used is the HTTP port number that is assigned to this hub monitoring server during Tivoli Monitoring configuration of an RTE (typically port number 1920). Check the user interface REXX log (RKANRXLG DD name) for further details if the status is not Success.

The text values in the **ITM Service Index Status** field can be as follows:

Success
The TCP connect and Service Index retrieval completed at the Hub.

Data Failure
A TCP send or receive failed with the Hub.

Timed Out
A TCP connect and data retrieval did not complete in the allotted time.

Connect Fail
The TCP connect cannot complete.

TCP Failure
TCP cannot connect because of a failure with a TCP socket or select call.

No HTTP Port
The TCP port number that is needed to access the HTTP Server at the Hub cannot be determined.

Did Not Try
Because of previous connectivity failures an attempt is not made to find the value.

SAF Denied
The status cannot be determined because the user does not have security authorization to connect to the specified Hub.

**SOAP Status**
A text value that indicates whether a TCP connection can be established between the enhanced 3270 user interface address space and the IBM Tivoli Monitoring SOAP server component that is running at the specific hub monitoring server and whether sample SQL query data can be retrieved. The TCP port number that is used is the HTTP port number that is assigned to this hub monitoring server during Tivoli Monitoring configuration of an RTE (typically port number 1920). Check the user interface REXX log (RKANRXLG DD name) for further details if the status is not Success.
The text values in the **SOAP Status** field can be as follows:

**Success**
- The TCP connect and SOAP query completed at the Hub.

**Data Failure**
- A TCP send or receive failed with the Hub.

**Timed Out**
- A TCP connect and data retrieval did not complete in the allotted time.

**Connect Fail**
- The TCP connect cannot complete.

**TCP Failure**
- TCP cannot connect because a failure with a TCP socket or select call.

**No HTTP Port**
- The TCP port number that is needed to access the HTTP Server at the Hub cannot be determined.

**Did Not Try**
- Because of previous connectivity failures an attempt is not made to find the value.

**SAF Denied**
- The status cannot be determined because the user does not have security authorization to connect to the specified Hub.

**Hub Connect Time**
- The number of seconds it took to complete the TCP connection to the hub monitoring server. A value of **n/a** indicates the TCP connect cannot be attempted.

**Hub Time (bar graph)**
- A small horizontal bar graph that shows the Hub Connect Time. This field is highlighted by colors that depend on the threshold settings for the KOBHUBS table, which you can adjust.

**ITM Service Index Time**
- The number of seconds it took to retrieve the IBM Tivoli Monitoring Service Index from the hub monitoring server. A value of **n/a** indicates the TCP connect cannot be attempted.

**Srvc Time (bar graph)**
- A small horizontal bar graph that shows the Tivoli Monitoring Service Index Time. This field is highlighted by colors that depend on the threshold settings for the KOBHUBS table, which you can adjust.

**SOAP Time**
- The number of seconds it took to run a simple SOAP SQL query at the hub monitoring server. A value of **n/a** indicates the TCP connect cannot be attempted.

**SOAP Time (bar graph)**
- A small horizontal bar graph that shows the SOAP Time. This field is highlighted by colors that depend on the threshold settings for the KOBHUBS table, which you can adjust.

**HTTP Port**
- The TCP port number that is used with HTTP to access the IBM Tivoli Monitoring Service Index and the SOAP server. If there is no port number configured, the text value **Missing** is shown.

**HTTPS Port**
- The TCP port number that is used with HTTPS to access the Tivoli Monitoring Service Index and the SOAP server. If there is no port number configured, the text value **Missing** is shown. HTTPS is a version of HTTP that supports authentication and encryption.
Hub DRA Count
The number of Data Retrieval Agents (DRAs) used by the enhanced 3270 user interface for this particular hub monitoring server.

Hub TCP/IP Host Name
The host name of the TCP/IP interface in use by the hub monitoring server.

Hub IP Address
The IP address in use by the hub monitoring server to which all user interface requests are directed.

Hub Port
The TCP port number in use by the hub monitoring server to which all user interface requests are directed. The port number is typically 1918.

Hub Start Date
The date that the hub monitoring server job was started.

Hub Start Time
The time of day that the hub monitoring server job was started.

Hub Job Name
The job name (z/OS system) or task name (Windows, UNIX, or Linux systems) under which the hub monitoring server is running.

Hub System Name
The operating system name under which the hub monitoring server is running.

Hub System Type
The operating system type under which the hub monitoring server is running. Typical values: z/OS;01.13.00, Linux;2.6.9-67.EL or Win2008;6.0-SP2.

Displaying hub overview status
You can use the Hub Overview workspace to see overview status about a specific hub Tivoli Enterprise Monitoring Server.

About this task
This procedure shows you how to view status information about a specific hub monitoring server.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 83.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Hub Overview (KOBHBSTO) workspace:

- Place your cursor next to the hub monitoring server name that you are interested in, type / and press Enter, then select Status Overview for Hub from the Options menu.
- Place your cursor next to the hub monitoring server name that you are interested in, type 0 and press Enter.

The Hub Overview workspace is displayed.
Displaying products installed on a hub
You can use the Installed TEMS Applications workspace to see the products that are installed on a specific hub Tivoli Enterprise Monitoring Server.

About this task
This procedure shows you how to view all of the installed products on a specific hub is available from this workspace.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 83.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Installed TEMS Applications (KOBAPPS) workspace:

- Place your cursor next to the hub monitoring server name that you are interested in, type / and press Enter, then select Products installed in this Hub from the Options Menu.
- Place your cursor next to the hub monitoring server name that you are interested in, type P and press Enter.

The Installed TEMS Applications workspace is displayed.
Displaying Managed System Names (MSN) for a hub
You can use the Managed Systems workspace to see Managed System Names for a specific hub Tivoli Enterprise Monitoring Server.

About this task
An important characteristic of a hub monitoring server is the Managed System Names (MSNs) that are managed by that hub. These Managed Systems are the entities that are being monitored by Tivoli Monitoring agents. This procedure shows you how to view the Managed System Names (MSNs) that are managed by a specific hub.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 83.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Managed Systems (KOBHBMSN) workspace:

- Place your cursor next to the hub monitoring server name that you are interested in, type / and press Enter, then select MSNs known by Hub (Managed System Names) from the Options Menu.
- Place your cursor next to the hub monitoring server name that you are interested in, type N and press Enter.

The Managed Systems workspace is displayed:
Displaying Managed System Lists (MSL) for a hub
You can use the Managed Systems workspace to see Managed System Lists for a specific hub Tivoli Enterprise Monitoring Server.

About this task

This procedure shows you how to view all of the Managed System Lists (MSLs) for a specific hub is available from this workspace.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 83.

Procedure

From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Managed System Lists (KOBHMBSL) workspace:

- Place your cursor next to the hub monitoring server name that you are interested in, type / and press Enter, then select MSLs known by Hub (Managed System Lists) from the Options Menu.
- Place your cursor next to the hub monitoring server name that you are interested in, type L and press Enter.

The Managed System Lists workspace is displayed.
You can use the Data Retrieval Agents (DRA) workspace to see the data retrieval agents for a specific hub
Tivoli Enterprise Monitoring Server.

### About this task

Data Retrieval Agents (DRA) are enhanced 3270 user interface components that manage the SQL queries
sent from the user interface address space to a hub monitoring server. The DRA components do not
gather performance data from Managed Systems: They manage the interactions between the user
interface and the hub monitoring server address spaces. DRA components run within the hub monitoring
server, Remote Tivoli Enterprise Monitoring Servers, and Tivoli Enterprise Monitoring Agents. DRA
components are only on z/OS systems.

For more information about the All Known Hubs workspace, see "The All Known Hubs workspace" on
page 83.

### Procedure

From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Hub
Overview (KOBHBDR) workspace:

- Place your cursor next to the hub monitoring server name that you are interested in, type / and press
  Enter, then select DRAs connected to Hub from the Options Menu.
- Place your cursor next to the hub monitoring server name that you are interested in, type A and press
  Enter.

The Data Retrieval Agents (DRA) workspace is displayed.
Displaying hub topology
You can use the Hub Topology workspace to see information about nodes that are known to the hub monitoring server.

About this task
This procedure shows you how to view and filter information about nodes that are known to the hub monitoring server.

For more information about the All Known Hubs workspace, see "The All Known Hubs workspace" on page 83.

Procedure
1. From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Hub Overview (KOBHBDRA) workspace:
   - Place your cursor next to the hub monitoring server name that you are interested in, type / and press Enter, then select **Topology: Nodes known to this Hub** from the Options Menu.
   - Place your cursor next to the hub monitoring server name that you are interested in, type T and press Enter.

   The Hub Topology workspace is displayed.
2. Optional: To see only online nodes, type a non-blank character in the **Online** field and leave the **Offline** field empty.

3. Optional: To see only offline nodes, type a non-blank character in the **Offline** field and leave the **Online** field empty.

4. Optional: To see both online and offline nodes, type a non-blank character in both the **Offline** and **Online** fields.

**Tip:** You can clear the **Online** and **Offline** fields by typing a space in them.

5. Optional: To limit the rows that are displayed, type `include=value`, `exclude=value`, or both in the **Options** field. The *value* string must match part of a row value for the row to be included or excluded from the workspace display. If you want to use embedded blanks as part of the *value* string, you must enclose the entire *value* string in single or double quotations. The case of the *value* string (uppercase or lowercase) must match the row data exactly. The `include` and `exclude` keywords can be in lowercase or uppercase. Empty spaces are not allowed on either side of the equal sign.

The following table contains some example **Options** entries:

<table>
<thead>
<tr>
<th>Filter condition</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show only rows that contain DB2.</td>
<td>include=DB2</td>
</tr>
<tr>
<td>Show only rows that contain M5 preceded and followed by an empty space. For example, the Prd (Product) column entries in the workspace for the M5 product.</td>
<td>include=' M5 '</td>
</tr>
<tr>
<td>Show only Hub or remote monitoring servers but exclude any at version=06.23.03</td>
<td>include=' EM ' exclude=06.23.03</td>
</tr>
<tr>
<td>Show only nodes on Windows systems.</td>
<td>include=' Win'</td>
</tr>
</tbody>
</table>
Appendix A. About panels

Workspaces are composed of two types of panels: workspace panels and popup panels.

Workspace panels are typically used to present data. A workspace panel can contain up to 15 subpanels. Each subpanel in a workspace can contain data from a different attribute group or even a different application. Subpanels can be linked to other workspace panels using context-sensitive links, so that the data displayed in the target workspace reflects values in the linked-from workspace (see Figure 56).

Figure 56. A workspace with several subpanels

Popup panels overlay workspace panels and are typically used to provide navigation, action options, or help for a particular field, or additional information about actions (see Figure 57). Popup panels are also used to confirm an action.

Figure 57. Workspace with popup panel
Workspace and popup panels are created using panel definitions. Panel definitions are members of a dataset allocated to RKANWENU (the default for English; the ddname is dependent upon the locale ID). The name of a data set member is the name of the panel it defines.

A panel definition consists of one or more stanzas that specify the panel type or elements and keyword = value pairs that specify the appearance and content of the panel.

### Workspace panel definitions

Workspaces panel definitions consist of an opening and closing stanza tag and a set of keywords that specify the global properties and content of the workspace. A workspace panel definition can contain up to 15 subpanel definitions. Subpanel definitions specify navigation and display options for the subpanel and the data query. Subpanels can be linked to other workspace panels using links, so that the data displayed in the target workspace reflects values in the linked-from workspace.

A workspace panel definition begins with a `<WORKSPACE>` tag as the first noncomment line and ends with a `<WORKSPACEEND>` tag. In addition to a set of supported keywords that specify global settings for the workspace, a workspace definition can contain the following stanzas:

**ALIASCOMMANDS**

`<ALIASCOMMANDS>` `<ALIASEND>`

In an ALIASCOMMANDS stanza, the aliases for workspace panel IDs to be used in fastpath navigation are defined. By default, alias commands apply only to the current panel. For the aliases to persist, the scope must be set to GLOBAL. If the scope is global, after an alias has been set, it is available to every subsequent panel until the alias is either updated or deleted.

The use of `<ALIASEND>` it prevents subsequent SET statements from generating alias variables instead of normal variables.

**ONENTRY**

`<ONENTRY>` `<ONENTRYEND>`

An ONENTRY stanza contains SET statements that are executed only once, when the workspace is loaded during "forward" navigation. This prevents the statements from being redriven, for example, when a filter is invoked.

**SUBPANEL**

`<SUBPANEL>`

Subpanel definitions are introduced by a `<SUBPANEL>` statement. Subpanels do not require a corresponding `<SUBPANELEND>` statement. The occurrence of a new `<SUBPANEL>` tag or a `<WORKSPACEEND>` tag functions as an indication of the end of the preceding subpanel.

In each subpanel, you can control the type of subpanel (summary, detail, text, action), the number of lines and rows that are displayed, the data that is queried, and the columns that are displayed. You can specify what controls are available (such as scrolling and minimizing and maximizing subpanels) and define navigation options for drilldown to other workspace or popup panels. The order of some keywords is restricted.

Subpanels may contain several types of stanzas:

**ISPF**

`<ISFPANEL>` `<ISFPANELEND>`

ISPF stanzas support a subset of the standard ISPF statements. See "Supported ISPF statements" on page 128.

**PROLOG and EPILOG**

`<PROLOG>` `<PROLOGEND>` and `<EPILOG>` `<EPILOGEND>`
PROLOG and EPILOG stanzas optionally bracket a QUERY keyword and allow for the definition of local variables and for pre- and post-processing of the queried data using REXX EXECs. PROLOG and EPILOG stanzas can contain the following elements:

- SET commands
- REXX EXEC commands
- ZOOMCOLS=&vvarname statements

ONACTION

<ONACTION><ONACTIONEND>

This stanza is executed once when the workspace is first displayed during forward navigation. ONACTION stanzas can contain the following elements:

- SET commands.

SET commands coded in an ONACTION stanza are executed directly after key column assignment when an action is driven from the subpanel (see “KEYCOLS” on page 112).

Used with the system variable ZFILTERnn, SET commands in the ONACTION stanza can be used to create filters for columns that have been designated as eligible using the FILTERCOLS keyword. For example:

<ONACTION>
SET ZFILTER01=CICSNAME=C*
SET ZFILTER02=SOS=1
SET ZFILTER03=TASKS>100
<ONACTIONEND>

- REXX exec calls. For example:

<ONACTION>
CALL MYREXX
<ONACTIONEND>

Example

Here is an example of a simple workspace panel definition:

WORKSPACE>
HEADER='Address Spaces for Service Class'
NAV1TEXT='Plex ID'
NAV2TEXT='SMF ID'
SET ZOMEGNAV2=''
SET ZOMEGLOCK1=NO
SET ZOMEGLOCK2=YES
IMBED=KM5NAV1

/********************************************************************/
/* */
/* SUBPANEL 1 - Address Spaces for Service Class */
/* */
/********************************************************************/

<SUBPANEL>
HEADER='Service Class &CLSNAME'
TYPE=SUMMARY
>Data Query
QUERYTYPE=ROUTER
QUERYMODE=LIVE
QUERYREGTYPE=DRA
QUERY='SELECT MADDSPC.ORIGINNODE, MADDSPC.ASNAME, MADDSPC.VSYSTEMNAM, MADDSPC.ASID, MADDSPC.ASRCNAME, MADDSPC.VELOCITY, MADDSPC.PAGERATE, MADDSPC.ASSTOR, MADDSPC.ASESTOR, MADDSPC.IORATE, MADDSPC.CPUPCNT, MADDSPC.IFAPCNT, MADDSPC.IFCPCNT, MADDSPC.SUPPCNT, MADDSPC.SUCPCNT, MADDSPC.CLSNAME,

Appendix A. About panels 97
FROM KM5.MADDSPC,
WHERE ORIGINNODE='&PLEXORIG',
AND MADDSPC.CLSNAME='&CLSNAME',
ORDER BY VELOCITY DESC;
/**
 * Data Status
 */
/**
 * Session Data Row Key Fields
 */
/**
 * Default list of fields to display
 */
STATICCOLS=2
SORTCOLS="ASNAME,ASID,PAGERATE,ASCSTOR,ASESTOR,IORATE,CPUPCNT,
IFAPCNT,IFCPCNT,SUPPCNT,SUCPCNT,VELOCITY'
DISPLAYCOLS="ASNAME,ASID(HEXDISP),VSYSTEMNAM(W=4),
ASRCNAME,CPUPCNT,VELOCITY,ASCSTOR,ASESTOR,IORATE,
PAGERATE,IFAPCNT,IFCPCNT,SUPPCNT,SUCPCNT'
/**
 * Navigation Options
 */
/**
 * ACTION=ASNAME(?,"Help Assistance",KOCHELP1)
 */
/**
 * SUBPANEL 1 END
 */
<WORKSPACEEND>

Popup panel definitions

Popup panels overlie a portion of a workspace panel. Popup panels are typically used to display navigation or action options, to supply information for a particular field, or to provide additional information about actions. Popup panels are also used to confirm actions. Popup panels are linked to a subpanel through an ACTION setting in a subpanel definition.

Popup panel definitions begin with <POPUP> and end with <POPUPEND>. Popup panels may contain a header, free-form text, and a subpanel.

Popup panels suspend Auto update in the parent workspace: until the popup panel is dismissed, the Auto update field in the workspace displays SUS instead of Off or Interval.

Popup panels can contain variables. The variables must be set in the parent workspace or in a previously accessed workspace.

As in workspace definitions, stanzas that define subpanels are introduced by a <SUBPANEL> statement. A corresponding <SUBPANELEND> statement is not required. Unlike workspace panels, which may contain up to 15 subpanels, popup panels can contain only one subpanel. Moreover, subpanels in popup panels cannot contain the QUERY keyword or PROLOG and EPILOG stanzas. Subpanels may contain ONACTION and ISPF stanzas. As in subpanels, ONACTION stanzas may contain SET commands and REXX exec calls. See "Supported ISPF statements" on page 128 for more information allowable ISPF statements.

Example 1

The following example shows the use of a subpanel with actions defined, an ISPF )LIST statement with the POPUPACTIONS argument, with the width of the popup panel specified. The POPUPACTIONS argument displays the actions defined in the popup panel in a numbered list, in a popup panel with a width of 50 characters.
Example 2

This is a sample popup panel action, which takes the actions defined in the subpanel from which the popup panel is invoked and inserts them after the text in the )BODY statement. A color variable is used to apply color to text:

```plaintext
/* OMEGAMON ACTION CHARACTER LIST */
/* */
<POPUP>
<ISPFPANEL>
)ATTR
0 TYPE(TEXT) SKIP(ON) COLOR(&ZCLRTEXT))
)LIST PANELACTIONS
)BODY WIDTH(50)
   Action Command Menu
   Select an action and then press Enter.

   )INIT
   )PROC
   )END
<ISPFPANELEND>
<POPUPEND>
```

Figure 59. Example of action popup that inserts actions from the subpanel definition

Guidelines for constructing panel definitions

Panel definitions are constructed according to specific guidelines. You should be aware of these guidelines if you are constructing a panel definition from scratch, instead of copying and modifying an existing definition:

- The first non-comment line of a workspace panel definition must contain a <WORKSPACE> tag. The first noncomment line of a popup panel must contain a <POPUP> tag.
The end of a workspace panel definition must be marked by a corresponding `<WORKSPACEEND>` tag. The end of a popup panel definition must be marked by a corresponding `<POPUPEND>` tag. Anything after this tag is ignored.

**Note:** If you do not specify an end tag, the end of the file is the interpreted as the end of panel definition. Since the rest of the file is ignored, using an explicit end tag allows you to ignore part of the file, for example if you are testing a panel definition.

Any text values that contain a space must be enclosed in single or double quotation marks. If text contains a single quotation mark, it must be enclosed in double quotation marks. Any comma-delimited list (for example, `DISPLAYCOLS='CICSPLEX,PLEXRATE,PLEXCPUP'`) must also be enclosed in quotation marks.

Some keywords must be specified in a particular order (see “Panel definition keywords”). Comments (`/*`) are allowed anywhere in the definition.

Comment lines and blank lines are ignored.

---

**Panel definition keywords**

Keyword/value pairs are used to define the properties of panels. There are keywords that affect the workspace as a whole, and subpanel keywords that apply only to specific subpanels.

**Workspace keywords**

The keywords in this section define global properties for workspace panels.

**CURSOR**

Defines the default cursor position on an initial workspace.

**CURSOR=[HOME | COMMANDLINE | SUBPANEL | ASIS]**

**Possible values**

- **HOME**
  
  Row 00, Column 1

- **COMMANDLINE**
  
  Cursor appears after Command `==>`.

- **SUBPANEL**
  
  Cursor appears in first selectable field of the first subpanel.

- **ASIS**
  
  The cursor remains on the workspace wherever the user placed it.

**Default value**

HOME

**Example**

CURSOR=COMMANDLINE

**CURSORREFRESH**

Defines where the cursor position is after a workspace has been refreshed.

**Possible values**

- **HOME**
  
  Row 00, Column 1

- **COMMANDLINE**
  
  Cursor appears after Command `==>`
**SUBPANEL**

Cursor appears in first selectable field of the first subpanel.

**ASIS**

The cursor remains on the workspace wherever the user placed it.

**Default value**

ASIS

**Example**

CURSORREFRESH=SUBPANEL

**HEADER (workspace)**

The text to be displayed at the top of the workspace.

**Possible values**

Any text up to 46 characters. Any characters that exceed the maximum length are truncated. The text is case-sensitive.

**Default value**

No header is displayed.

**Example**

The following example illustrates the use of the HEADER keyword to define text “Enterprise Overview” as the workspace header.

HEADER='Enterprise Overview'

shows

```
Command ==> ________________________________________
          KOBLOGON                             Enterprise Overview
```

**IMBED**

Specifies a subpanel definition to be imbedded. Can be used to reuse a subpanel in several workspaces, or to imbed a subpanel definition provided by another product.

**IMBED** = [subpanelid | &panelid]

This keyword is placed at the location where the imbedded subpanel will appear, if available. This keyword requires a standalone subpanel definition in a separate PDS member. The member must consist of only the <SUBPANEL> stanza containing the subpanel definition. You can imbed multiple subpanel members.

**Possible values**

- `subpanelid`: the name of the PDS member that contains the subpanel definition
- `&panelid`: a variable set to the member name

**Default value**

None

**Example**

IMBED=&imbwait

**MODE (workspace)**

Specifies that the workspace should not be displayed. This keyword is used to “hide” a workspace that is used to collect data for a workspace that is displayed subsequently or to silently perform an action.
Use of MODE=SILENT disables any other display-oriented keywords in the workspace definition, such as DISPLAYCOLS, SCROLLBAR, and MINMAX. A workspace that is specified as SILENT must create a new variable called ZDESTID which contains the panel ID of the destination workspace. This can be accomplished either in a REXX EXEC, or in a workspace definition by specifying SET ZDESTID=panelid. Although MODE is a <WORKSPACE> setting, SET ZDESTID is a <SUBPANEL> setting.

**Possible values**
- SILENT

**Default value**
- None

**Example**
```
<WORKSPACE>
  MODE=SILENT
<SUBPANEL>
  SET ZDESTID=KCPPRgd
<WORKSPACEEND>
```

**NAV1TEXT**
Specifies the text used to label the field that filters for data from a specific plex.

**Valid values**
- Any text up to 8 characters. Any additional characters are truncated.

**Default value**
- Plex ID

See also: "NAV2TEXT"

**Example**
```
NAV1TEXT='CICSPLEX'
```

**NAV2TEXT**
Specifies the text used to label the field that allows a subsystem filter (such as a region or LPAR) to be placed on the data.

**Possible values**
- Any text up to 8 characters. Additional characters are truncated.

**Default value**
- Sys ID

See also: "NAV1TEXT"

**Example**
```
NAV2TEXT='Region'
```

**QUERYWHEN (workspace)**
Forces data collection for all subpanels within the workspace when the workspace is returned to using backwards navigation.

**QUERYWHEN= RETURN**

By default, data collection is driven only when the Enter key is pressed and no screen operations are requested. Screen operations include pulldown or popup panels, collapsing and expanding, minimizing and maximizing, scrolling, or backwards navigation.
WHENNOHEADER
Replaces the entire subpanel header with the specified text when rows are empty and the subpanel is collapsed.

WHENNOHEADER="text"

If there is no data returned in a subpanel, the subpanel is automatically collapsed and the header displays the text “No data”. You can override the header with alternative text, up to a maximum of 64 characters.

Example
WHENNOHEADER="No data is available because the task has ended"

WHENNOTEXT
Replaces the text “No data” when there is no data in the rows and a subpanel is collapsed.

WHENNOTEXT="text"

If there is no data returned in a subpanel, the subpanel is automatically collapsed and the header displays the text “No data”. You can replace “No data” alternative text, up to a maximum of 15 characters.

Example
WHENNOTEXT="task has ended"

Subpanel keywords
The keywords in this section define the properties of a subpanel. The keywords must be preceded by the <SUBPANEL> tag. A <SUBPANELEND> tag is optional. The occurrence of another <SUBPANEL> or a <WORKSPACEEND> tag is taken as the close of the subpanel definition.

ACTION
In a summary subpanel, defines a list of navigation and action options from which a user can select. You can define up to 16 actions for a selectable field for a subpanel. A popup panel with a list of all possible options is dynamically defined. A default action can be defined. These options are displayed in a popup when a user enters a slash (/) on the selectable row associated with the actions.

ACTION=columnname(action_character,"action_text_description",destination_panelid[,DEFAULT][,CONFIRM])

where:

columnname
    is the name of the column with which the action is associated.

action_character
    is the character associated with the action

action_text_description
    is a description of the action to be taken, enclosed in single or double quotation marks.

destination_panelid
    is the panel ID of the workspace to which users are taken. Specify NULLDEST for no navigation.

DEFAULT
    defines the action as the implicit navigation behavior. If only one action is specified, it is taken as the default. If multiple actions are defined for a subpanel, one must be defined as the default.

CONFIRM
    Invokes a confirmation popup panel (KOBCONFM) before proceeding to the specified panel ID.
ENTER

ENTER can be used instead of an action character. Using ENTER changes the behavior of a popup panel so that the Enter key can implement navigation instead of data collection and redisplay. The destination panel ID can be any workspace or popup panel or the special keyword END. END indicates navigate backwards (save and PF3). If a REXX EXEC sets the ZDESTID in an ONACTION stanza, the ENTER key options are ignored, and the popup panel is redisplayed with any updates that the REXX EXEC may have made.

Example 1

This example illustrates an action selection menu:

ACTION=HUBNAME(?,"Help Assistance",KOCHELPI,DEFAULT)
ACTION=HUBNAME(S,"Select a hub",KOBPANE1)
ACTION=HUBNAME(K,"Kill a hub",KOBPANE2,CONFIRM)

Example 2

These examples illustrates the use of the ENTER and END keywords:

ACTION=(ENTER,,MYNEXTWS)

or

ACTION=(ENTER,,END)

These two examples are mutually exclusive.

AUTOSELECT

For subpanels with MODE=SILENT that contain a query, automatically selects the first data record returned from the query. If you specify AUTOSELECT, you do not need to specify MODE=SILENT.

BOXTOP

Determines whether a top border is displayed for a subpanel.

Possible values

NO, YES

Default value

YES

Example

BOXTOP=NO

BOXBOTTOM

Determines whether a bottom border is displayed for a subpanel.

Possible values

NO, YES

Default value

YES

Example

BOXBOTTOM=NO

COLHEADERS

Determines whether column headings are displayed. This setting applies only to SUMMARY displays.
Possible values

N, Y, n, where N means that no column headings are displayed, Y means that column headings are displayed, and n is 1, 2, or 3 indicating how many lines are allowed for the column header.

Default value

Y, 2

Example

COLHEADERS=Y, 3

COLUMNS

Determines how many columns are displayed.

Possible values

DYNAMIC

The width of an individual column, and therefore the number of columns displayed, is determined by the width of the column header or the data, whichever is larger. If the column is defined in DISPLAYCOLS with the BAR option, the width may be also be controlled.

MAXIMUM

The maximum number of columns available for your screen size:

- 7 for a screen size of 80
- 10 for a screen size of 132
- 14 for a screen size of 160

Optionally, you can specify a number of columns fewer than the maximum, by specifying MAX-n.

N

An integer in the range 1 through x, where x is the maximum number of columns for the screen size.

Default value

DYNAMIC

Example

COLUMNS=6

COLUMNS132

Specifies how many columns should appear on screen if the screen is 27x132. Use this keyword to adjust for screen size if you have specified a specific number of columns using the COLUMNS keyword.

COLUMNS132=nn

Maximum value

10

Example

To limit the number of columns displayed in a 27x132 screen to 5:

COLUMNS132=5

COLUMNS160

Specifies how many columns should appear on-screen if the screen is 62x160. Use this keyword if you have indicated a specific number of columns using the COLUMN keyword.

COLUMNS160=nn
Maximum value 14

Example

To specify 10 columns:

```
COLUMNS160=10
```

**DISPLAYCOLS**

Lists the columns that are returned from the QUERY command that are to be displayed on the subpanel. Columns containing integers or percentages can be displayed in either numeric or analog (bar graph) form.

This setting must be specified after the QUERY statement for the subpanel.

**Possible values**

- ALL displays all columns specified in the query
- A comma-separated list of column names specified in the query, enclosed in single quotes.

```
column_name
```

If the column width is dynamic (COLUMN=DYNAMIC) and the data is an integer or a timestamp, you can optionally specify a display format:

```
column_name(options),column_name(options),column_name(options)
```

The display options available depend upon the data type of the column:

- The following options can be used for columns of any data type:

  ```
  Width=n.nn or Width=n.%
  ```
  Specifies the width of the column of data in number of characters or as a percentage of the number of characters that can appear on the screen. For example, \( W=16 \) or \( W=25\% \).

  ```
  CAPTION=&varname or 'textstring'
  ```
  Specifies the column caption that overrides the column caption for the attribute being graphed. Use the SET command to specify the value for the variable name.

  ```
  INDENT
  ```
  Indents a caption in a detail subpanel. For example:

  ```
  DISPLAYCOLS='SYSTEMID,CICSNAME(ASCII),WSERVCLAS,
  WPERFINDX(CAPTION="Region's Worst Perf. Index"),
  CPUNIXT(INDENT),TODUPOT,TRANRATE,PCNTMT,
  ENOWAIT(INDENT),REMQUEUE,SOS(INDENT),
  STGVIOL(CAPTION="Stg. Violations last hour"),
  AIDS,ICES(INDENT),
  CSTRINGW,CBUFFW,WSFAULT,WSTIMOUT,
  CICSTODB(TIME),VERSION(INDENT)'
  ```

results in the following subpanel:

![Subpanel Example](image)

- If the column contains Date/Time (T,16) data, you can use the following format options for the display:
**DATETIME**

Displays YY/MM/DD HH:MM:SS

**DATE**

Displays as YY/MM/DD

**TIME**

Displays as HH:MM:SS

**None**

Data is shown in any of the following formats, based on the value:

- 12m 31d
- 31d 23h
- 23h 59m
- 59m 59s
- 59.1234s
- 1.12345s

For example:

```
DISPLAYCOLS='CICSPLEX,PLEXRATE,EIBTIME(DATETIME),PLEXMAXT'
```

- If the column is an IPV6 address, then the options are:

  **None**

  Displays the IPV6 according to normal rules

  **IPV6**

  Displays an IP address with the ::ffff: stripped off

  Example: `DISPLAYCOLS=HUBIPADDRESS(IPV6)`

- If the column contains integer data, you can use the following options:

  **BAR**

  Displays an integer as an analog horizontal bar. The bar is green if the value is 33% or less of the column width; yellow up between 33% and 66% of the column width; and red if the value is over 66% of the column width.

  Control the bar display with the following options:

  **THRESH=NO**

  Suppresses color indicators for thresholds.

  **UNIT=nnn**

  Specifies how many integers a single character represents. The default is 1. Decimal places are not supported.

  For example:

  ```
  SET KOB_HEADER="Graphical Display"
  DISPLAYCOLS='CICSPLEX,PLEXRATE,PLEXCPUP,PLEXCPUP(W=22%,BAR,UNIT=20,CAPTION=&KOB_HEADER),PLESOS,PLEXMAXT,PLEXENQW,PLEXHSCI'
  ```

  **HEXDISP**

  Converts values to hexadecimal for display. HEXDISP supports an offset. For example, if you have an integer field column containing the decimal value 254:

  - `(HEXDISP)` displays 000000FE
  - `(HEXDISP+1)` displays 0000FE
  - `(HEXDISP+2)` displays 00FE
  - `(HEXDISP+3)` displays FE
HEXVAR
Converts values being passed in variables set by KEYCOLS to hexadecimal. For example,
\texttt{column\_name(HEXVAR)}

BKMG (Bytes to Kilo to Mega to Giga).
Converts values expressed in bytes to kilobytes, megabytes, or gigabytes, as appropriate. For example, \texttt{column\_name(BKMG)}.

KMGT
Converts values expressed in kilobytes to megabytes, gigabytes, or terabytes, as appropriate. For example, \texttt{column\_name(KMGT)}.

NOUNIT
No units are displayed. For example, \texttt{column\_name(NOUNIT)}.

PERCENT
Appends a percent symbol (%) after the value on the screen.
- If the column contains strings or enumerations:
  \texttt{ALIGNRIGHT}
  Align text to the right hand side of the column.
- If the column contains just text strings:
  \texttt{ASCII}
  Forces an ASCII translation of a field prior to display.

SCROLL
Enables cursor-sensitive lateral scrolling. Supported only for strings, where WIDTH= (or \texttt{W=} is specified. Places left and right arrows in the column heading. Pressing PF10 or PF11 in the data area of a lateral data scroll column also performs lateral data scrolling for just that column. For example, the following subpanel definition:
\begin{verbatim}
DISPLAYCOLS='HUBNAME(W=20,SCROLL.),
DRAIPAD(IPV6,W=16,SCROLL),
HUBIPAD(IPV6,W=16,SCROLL),
HUBPORT(ALIGNRIGHT)
\end{verbatim}

produces the following subpanel:

\begin{figure}
\centering
\includegraphics[width=\textwidth]{subpanel.png}
\caption{Example subpanel with lateral data scrolling.}
\end{figure}

\begin{table}
\centering
\begin{tabular}{|c|c|c|c|}
\hline
\textbf{Hub-TEMS Name} & \textbf{DRA IP Address} & \textbf{Hub-TEMS Port Number} \\
\hline
megahub14 & 9.42.46.22.10930 & 9.37.37.197 & 25104 \\
megahub14 & 9.42.46.22.20930 & 9.37.37.197 & 25104 \\
megahub14 & 9.42.46.22.30930 & 9.37.37.197 & 25104 \\
megahub14 & 9.42.46.114.3105 & 9.37.37.197 & 25104 \\
megahub14 & 9.42.46.114.2990 & 9.37.37.197 & 25104 \\
\hline
\end{tabular}
\caption{Example subpanel data.}
\end{table}

Default value
\texttt{ALL}

DISPLAYOPTION
Removes all units from every column in DISPLAYCOLS.

Note: DISPLAYCOLS \texttt{column(KMGT)} overrides a DISPLAYOPTION=NOUNIT statement.

Default value
\texttt{NOUNIT}

Possible values
\texttt{NOUNIT}
Example
DISPLAYOPTION=NOUNIT

EXPANDCOLAPS
Determines whether or not the subpanel can be collapsed and expanded. If a subpanel is collapsed, only the subpanel heading is displayed.

A value of YES causes a down arrow to appear in the left corner of the subpanel header. Placing a cursor on the down arrow and pressing Enter collapses the panel so only the subpanel heading line is visible, and turns the down arrow into a right arrow. Placing the cursor on the right arrow expands the subpanel again.

Possible values
YES, NO

Default values
YES

If Yes is specified, you must specify a subpanel HEADER, so that the expand and collapse icons are available.

EXPANDCOLAPS=YES

enables a subpanel to be collapsed so only the header is displayed, as in the following example where the LPAR Utilization subpanel is collapsed:

FILTERCOLS
Specifies columns to which filtering has been or can be applied.

This keyword must be specified after the QUERY statement for the subpanel. Filters are set in the ONENTRY stanza of the workspace panel definition, using SET ZFILTERnn commands.

FILTERCOLS='columnname,columnname'
Possible values
A comma-delimited list of column names, with a maximum of 10 columns.

Default value
None

Example
FILTERCOLS='CICNAME,SOS,TRANRATE,AIDS,WORKSET,CPUUTIL'

FILTERNULLVAL
Specifies whether or not predicates in a query should be removed if their values are unresolved variables.

FILTERNULLVAL=KEEP | REMOVE

Possible values

KEEP
Keeps all predicates in a query even if the values of the predicates are unresolved variables.

REMOVE
Removes all predicates in a query if the values of the predicates are unresolved variables.

Default value
KEEP

Example
FILTERNULLVAL=REMOVE

FILTERSTRIP
Specifies whether or not filtering removes all predicates from the existing query.

FILTERSTRIP=YES | NO

Possible values

YES
Filtering removes all predicates except for SYSTEM.PARMA and ORIGINNODE from the existing query.

NO
Filtering retains all existing predicates and dynamically appends the filter predicates.

Default value
NO

Example
FILTERSTRIP=YES

FILTERVIEW
In subpanels that are reusing data from another subpanel, indicates which ZVIEWnn filter definition, or "view", to use.

FILTERVIEW=n

Parameters

Possible values
1 to maximum number of possible reuses

Default value
None
Example

The following subpanel definition describes a subpanel that has 2 filtered views of a single query. The subpanel definition uses the FILTERVIEW keyword to indicate what view the subpanel is associated with.

```
<SUBPANEL> Subpanel containing the live query
NAME=SUBPANEL1
QUERY='SELECT A,B,C FROM APP.TABNAME
/*****************************/
FILTERVIEWS=2 Number of filtered views of this query in this workspace
/*****************************/

<SUBPANEL> Next subpanel
QUERY=REUSE(SUBPANEL1) This reaccesses data collected by SUBPANEL1
/*****************************/
FILTERWHERE=LOCAL
FILTERVIEW=1 ZVIEWnn system variable containing filter predicates
<ONENTRY>
SET ZVIEW01=AIDS=1,SOS<>NO Can be set/altered programmatically
<ONENTRYEND>
/*****************************/

<SUBPANEL> Next subpanel
QUERY=REUSE(SUBPANEL1) This reaccesses data collected by SUBPANEL1
/*****************************/
FILTERWHERE=LOCAL
FILTERVIEW=2 ZVIEWnn system variable containing filter predicates
<ONENTRY>
SET ZVIEW02=CICSNAME=>CICSABCD,MAXOSCOR<=999 Can be set/altered programmatically
<ONENTRYEND>
/*****************************/
```

FILTERVIEWS

Indicates the number of filtered re-uses of the data in this subpanel by other subpanels in this workspace.

- **FILTERVIEWS=n**
  - **Possible values:** 1 to maximum number of subpanels
  - **Default value:** None

See also “FILTERVIEW” on page 110.

Example

See example for “FILTERVIEW” on page 110.

FILTERWHERE

Specifies where filtering is applied.

- **FILTERWHERE=AGENT | LOCAL**

Parameters

**Possible values**

- **AGENT** Filtering dynamically modifies the SQL to include filter predicates and drives collection.
**LOCAL**
Filtering applies filter predicates to an existing row-set.

**Default value**
AGENT

**Example**
FILTERWHERE=LOCAL

**FOOTER**
Specifies that a footer is displayed at the bottom of a subpanel.

**Possible values**
A text string of up to 68 characters, enclosed in quotation marks. You can use variables in the string. The value is case-sensitive.

**Default value**
None

**Example**
FOOTER='Welcome to &ZSYSID'

**HEADER (subpanel)**
The text to be displayed at the top of the subpanel.

**Possible values**
Any text up to 63 characters. Any characters that exceed the maximum length are truncated. The text is case-sensitive.

**Default value**
No header is displayed.

**Example**
HEADER='Details for Address Space'

**JOINPREV**
Determines whether to adjoin a subpanel to the previous subpanel.

**Possible values**
YES, NO

**Default value**
NO

**Example**
JOINPREV=YES

**KEYCOLS**
Creates a variable of the same name for any columns in a query and assigns the value of the variable to this name. Creating a variable allows fields that uniquely identify a row of data to be saved for a subsequent query (drilldown) using that row of data. KEYCOLS is invoked only after a row of data is selected. This setting must be specified after the subpanel's QUERY statement.

**Possible values**
ALL
displays all the columns specified in the query.
One or more column names specified in the query
Use a comma-delimited list to specify more than one column name. Enclose the list in quotation marks.

**Note:** Using ALL results in increased overhead.

**Default value**
None

`KEYCOLS='HUBNAME, LPAR, TRANSID'`

allows these variables to be used in a future query such as:

```
SELECT ... WHERE HUBNAME=&HUBNAME AND LPAR=&LPAR AND TRANSID=&TRANSID
```

**LINES**
Determines the number of data rows displayed in a subpanel. The value can be expressed as an absolute number or as percentage of the available workspace, or can be set to adjust dynamically to the data and space available.

**Possible values**

- **An integer in the range 1 - 56**
  The number of rows of data requested. Six lines are dedicated to the workspace header, including subpanel header, column headings, and separator lines.

- **A percentage in the range 1% - 100%**
  **DYNAMIC**
  The subpanel uses the available space of the 3270 session.
  The first subpanel is allocated as many rows as it has data. Each subsequent panel is allocated as many of the remaining lines as are available.

**Default value**
DYNAMIC

**Examples**

```
LINES=33% or LINES=10
```

**MINMAX**
Determines whether or not the subpanel can be minimized, maximized, and closed.

**Note:** Maximize is currently disabled.

**Possible values**

- YES, NO

**Default value**
YES

If Yes is specified, you must specify a subpanel HEADER, so that the minimize and maximize icons are available.

**Example**

```
MINMAX=YES displays the minimize, maximize, and close boxes in the upper right corner of the subpanel.
```
**MODE (subpanel)**
Indicates that a subpanel should not be displayed. This keyword is used to "hide" a subpanel that is used to run a query, establish variables, or perform an action required by a subsequent panel.

**MODE=SILENT**

**NAME**
Assigns a unique name to a subpanel. Naming a panel allows you to reuse its query.

A subpanel name is 3 to 8 characters, beginning with an uppercase alphabetical character.

**Example**
The following example shows four subpanel definitions with each panel assigned a distinct name (ALPHA, BETA, GAMMA, and DELTA).

```xml
<SUBPANEL> This is subpanel #1 with a query
NAME=ALPHA This is its name
QUERY="SELECT .........
</SUBPANEL>

<SUBPANEL> This is subpanel #2 with a query
NAME=BETA This is its name
QUERY="SELECT .........
</SUBPANEL>

<SUBPANEL> This is subpanel #3 with no query
NAME=GAMMA This is its name
QUERY=REUSE(ALPHA) Re-using first query
</SUBPANEL>

<SUBPANEL> This is sub-panel #4 with no query
NAME=DELTA This is its name
QUERY=REUSE(BETA) Re-using second query
</SUBPANEL>
```

**PARTIALCOLS**
The dynamic columns feature attempts to put as much information on the screen as possible, which can result in the rightmost column being displayed as only a partial column. To see the whole column, you would need to scroll right. If you would rather not see a partial column, code **PARTIALCOLS=NO**.

**Possible values**
- YES, NO

**Default value**
- YES

**Example**
PARTIALCOLS=NO

**QUERY**
The SQL query that will be used to collect data from the application.

**Possible values**
- A valid SQL SELECT statement
- REUSE(subpanel_name)
  uses the data retrieved by the query in the specified subpanel.

All columns (attributes) in a query must be from the same table (attribute group). Variables can be used anywhere in the QUERY statement, but only columns specified in a preceding panel can be used as variables.

**Note:** Variables can be used anywhere in the QUERY statement. Column names do not need to be preceded by table names.
Default value
None

Example 1: Queries with SELECT statement
QUERY='SELECT CICSPLEX, PLEXCPU, PLEXSOS, PLEXRATE, PLEXMAXT, PLEXENQW, PLEXHSCI, FROM OMICS.PLEX'
QUERY='SELECT TRANID, TASKNO, RTYPE, RNAME, STATE, CPUTIME, SUSPTIME, ELAPTIME, USED16, USED816, ATCHTIME, TIMEOFSU, SUSPDUE, FACTYPE, FACID, ORIGTRID, UMBTRID, QUEUE, FIRSTPGM, CURRPGM, USERID, EXECCMD, PURGEABL, PURGSTAT, SUSPTYPE, UOWSTATE, FROM OMICS.CICSTRD,
WHERE ORIGINNODE = "&SYSTEMID.&CICSNAME"
AND CICSTRD.TRANID = "&TRANID"
AND CICSTRD.TASKNO = "&TASKNO"

Example 2: Reused query
<SUBPANEL> This is subpanel #1 with a query
NAME=ALPHA This is its name
QUERY="SELECT ..........
</SUBPANEL>

<SUBPANEL> This is subpanel #2 with a query
NAME=BETA This is its name
QUERY="SELECT ..........
</SUBPANEL>

<SUBPANEL> This is subpanel #3 with no query
NAME=GAMMA This is its name
QUERY=REUSE(ALPHA) Re-using first query

QUERYTIMEOUT
Specifies the amount of time, in seconds, that can elapse before a query expires if no data is returned. The default is 10 seconds.

Possible values
1 - 99

Default value
10

Example
QUERYTIMEOUT=30

QUERYTYPE
The type of query to be used. This setting is valid only if QUERYMODE=LIVE.

Possible values
  REGISTRY
  ROUTER
  INTERNAL
  PDS
  REXX

Default value
ROUTER

Example
QUERYTYPE=ROUTER
QUERYWHEN (subpanel)
Forces data collection when the default behavior is to not drive data collection, or suppresses collection until user types in information.

QUERYWHEN= [ENTER | RETURN | MIN | COLLAPSE | ZQUERY]

Possible values
- ENTER
  Drives query when Enter key is pressed
- RETURN
  Drives query when user returns to the workspace.
- MIN
  Drives query when subpanel is minimized.
- COLLAPSE
  Drives query when subpanel is collapsed.
- ZQUERY
  Suppresses a query until the user types something in, even when the Enter key has been pressed. For example, you might want to suppress a Take Action command or Get Response query until the user has actually entered some kind of command. So, the REXX EXEC that builds the data field used in the query will also set the variable ZQUERY=YES. The subpanel in question is be coded with QUERYWHEN=ZQUERY, so it will only be driven when the variable is set (that is, a positive value like YES). If ZQUERY is null, the query is not driven.

Default value
By default, no data collection is driven when subpanels are scrolled, expanded, collapsed, or minimized. No collection is driven during when pulldown or popup panels are being displayed, and no collection is driven during backward navigation.

Example
QUERYWHEN=COLLAPSE

SCROLLBAR
Determines whether the subpanel displays the right, left, up, and down arrows for scrolling. This setting applies only to SUMMARY type displays.

Possible values
  YES, NO

Default value
  YES

Example
SCROLLBAR=YES displays

SCROLLCOLS
Suppresses column FROM TO indicators if only one column is displayed and no scrolling is required.

SCROLLCOLS=NO
**SCROLLROWS**
Suppresses row FROM TO indicators if only one row is displayed and no scrolling is required.

`SCROLLROWS=NO`

**SKIP**
The number of rows to skip before the first data row.

*Possible values*  
0 - 2  

*Default value*  
0  

*Example*

`SKIP=1`

**SORTCOLS**
Lists the columns that are returned from the QUERY command that are eligible to be sorted. This value must be specified after the subpanel's QUERY statement.

*Possible values*  
- ALL (displays all columns specified in the query)  
- A comma-separated list of column names specified in the query, enclosed in single quotes  
- None  

*Default value*  
None  

*Example*

`SORTCOLS='CICSPLEX,PLEXRATE,PLEXCPUP'`

**SPACE**
The number of blank lines between rows of data.

*Possible values*  
0-2, optionally followed by the ONBREAK control (ONBREAK=columnname). The ONBREAK control indicates that a space should be inserted only when the value in a particular column changes in the following row.

*Default value*  
0  

*Example*

`SPACE=1,ONBREAK=UOWID`

**STARTCOLAPS**
Determines whether or not the subpanel is collapsed when the workspace is initialized.

*Possible values*  
YES, NO  

*Default value*  
NO
Example

STARTCOLAPS=YES

STARTMIN
Determines whether or not the subpanel is minimized when the workspace is initialized.

Possible values
YES, NO

Default value
NO

Sample

STARTMIN=YES

STATICCOLS
Specifies the number of static columns of a subpanel. These columns stay in place while a user scrolls right or left. This setting applies only to SUMMARY type subpanels and must be specified after the subpanel’s QUERY statement. Applies to the column order indicated in the DISPLAYCOLS statement, unless DISPLAYCOLS is ALL, in which case the order of the columns is the same as specified in the query.

Possible values
A number in the range 0–n, where n is the maximum number of columns that will fit on the screen, minus 1. If the number of static columns exceeds the screen capacity, scrolling is disabled.

Default value
0

Example

STATICCOLS=2

STATUSCOLS
Specifies which columns in a summary are assessed for status. This setting must be specified after the subpanel’s QUERY statement.

Possible values
ALL

Names of one or more columns returned by the QUERY command. Use a comma-delimited list for more than one name, enclosed in quotation marks.

Important: Using ALL results in increased overhead. Use ALL only for Overview-type subpanels, if at all.

NO

Tip: Using NO bypasses assessing status for the subpanel, reducing overhead.

Default value
None

Sample

STATUSCOLS='PAGERATE,CPUUTIL'

TEXT
Specify the content of subpanels of TYPE=TEXT.
The text that follows TEXT= can include a small set of HTML and proprietary markup tags (see Appendix B, “Tags for formatting text,” on page 131). If the text consists of more that one word, it must be enclosed in single quotation marks. Variables can be used in the text.

**Example**

The following definition illustrates the use of HTML and proprietary tags in the definition of a subpanel:

```
<SUBPANEL>
  TYPE=TEXT
  MINMAX=NO
  EXPANDCOLAPS=N
  BOXBOTTOM=NO
  TEXT='<color=yellow
  <H1><center>Existing Hub Connection Unavailable</H1></color>
  <br>
  Your current profile
  <color=white>(&ZPROFILE)</color>
  specified TEMS
  <color=white>&ZHUBNAME</color>
  using port number
  <color=white>&ZHUBPORT.</color>
  The initial attempt to contact it has failed
  for one of the following reasons:
  <ul>
    <li>It is no longer running or online </li>
    <li>Some of the above information is no longer valid</li>
  </ul>
  <p>
  This Connectivity dialog will assist you in locating all available
  TEMS data sources within your Sysplex.
  Select the
  <color=white>NEXT</color>
  pushbutton to proceed. If your 3270 emulator is not
  enabled for mouse click operations,
  place your cursor on the NEXT pushbutton and press ENTER.
  <br>
```

produces the following subpanel:

![Existing Hub Connection Unavailable](image)

**TOFROMHEADER**

Determines whether to display a header that indicates how many rows and columns the subpanel is displaying, out of the total number of rows and columns. Applicable only to SUMMARY type displays.

**Possible values**

- YES, NO

**Default value**

- YES
Example

TOFROMHEADER=YES shows

| Columns | 2 to 6 of 6 | | Rows | 1 to 4 of 8 |

TYPE
Determines the formatting of the subpanel.

TYPE=[SUMMARY|DETAIL|TEXT|ACTION|PUSHBUTTON|TABDIALOG]

Possible values

SUMMARY
Displays queried data for multiple targets (such as plexes, LPARs, and address spaces) in tabular form, with each column displaying the values for a particular property, or attribute, for each target (Figure 60).

DETAIL
Displays queried data for a selected target in columns of attribute/value pairs (Figure 61 on page 121). In detail subpanels, all data is right-aligned.

TEXT
Allows use of freeform text and a subset of HTML formatting tags. Text is entered using the TEXT= keyword. No QUERY or QUERY-related keywords can be used with subpanels of this type.

ACTION
For use with workspaces specified MODE=SILENT. Allows actions, like queries, to be executed from the panel, without the users seeing the panel. The panel is invoked as many times as selections are passed to it.

PUSHBUTTON
Use this type to code one or more reverse video push-buttons. This type is a special version of <ISPFPANEL> that supports the PS (Point and Shoot) field type.

TABDIALOG
Use this type value to implement subpanel tabs. This type require the special keyword TAB. An example is shown in Figure 64 on page 122.

Default value
SUMMARY

Example 1: TYPE=SUMMARY

Specifying TYPE=SUMMARY results in a subpanel like the one in Figure 60.

Example 2: TYPE=DETAIL

Specifying TYPE=DETAIL results in a subpanel like the one in Figure 61 on page 121.
Example 3: TYPE=TEXT

Specifying TYPE=TEXT results in a subpanel like the one shown in Figure 62.

Example 4: TYPE=ACTION

Example 5: TYPE=PUSHBUTTON

Specifying TYPE=PUSHBUTTON results in a subpanel like the one shown in Figure 63.

Example 6: TYPE=TABDIALOG

Figure 64 on page 122 specified by using TYPE=TABDIALOG.
**VSEPARATORS**
Determine whether or not a subpanel displays vertical separators between columns.

**Possible values**
- YES
- NO

**Default value**
YES

**Example**

```plaintext
VSEPARATORS=NO
```

**WHENDATA**
Determines whether to expand, maximize, or shrink a subpanel when the subpanel has data to display.

**Possible values**
- Expand
- Maximize
- Shrink. The row count of the subpanel is dynamically decreased to the number of rows of collected data and subpanel is automatically expanded if collapsed, or maximized if minimized.

**Default value**
Shrink

**Note:** If Expand is specified, code EXPANDCOLLAPSE=Y, so users can collapse the subpanel.

**Example**

```plaintext
WHENDATA=M
```

**WHENNODATA**
Determines whether to collapse, minimize, or shrink a subpanel when the subpanel has no data to display.
Possible values
- Collapse
- Minimize
- End (close)

If no data is retrieved on the initial query or entry to the workspace, the subpanel is "deleted" and any query it contains is not run again on a refresh until the panel is reentered.
- Shrink (the number of rows in the subpanel is dynamically decreased to null when there is no data).
- Hide. Use instead of End if you want the subpanel to reappear when data is available again.

Default value
Collapse

Note: If Collapse is specified, code EXPANDCOLLAPSE=Y so users can expand the subpanel.

Example
WHENNODATA=COLLAPSE

ZOOMCOLS
Specifies the columns that can be selected for cursor-sensitive navigation (zooming) to another panel. The target panel ID for each column is specified immediately after the column name. In columns that are zoomable, the text is white. This setting must be specified after the subpanel's QUERY statement.

When the cursor is placed on the field for which zooming is defined and user presses ENTER, forward navigation occurs, except when column 1 in a summary panel is selectable. In this case, the subpanel ACTION statements define the destination. By default, S and its associated panel ID are used when column 1 is implicitly selected, but a workspace developer can indicate DEFAULT on any action statement.

Possible values
- None
- A comma-delimited list of names of one or more columns specified in DISPLAYCOLS, followed by the name of a target workspace in parentheses
- In a PROLOG or EPILOG stanza, a variable

Default value
None

Example 1: multiple columns with multiple destinations
In this example, multiple columns are assigned multiple destinations:
ZOOMCOLS='CICSPLEX(KOCCICS1),PLEXRATE(KOCOVER1),PLEXCPUP(KOCTRAN1)'

Example 2: a variable in an EPILOG stanza
In this example, a developer-supplied REXX EXEC called MYEXEC sets a variable X = COLUMN1(DEST01),COLUMN2(DEST02) inside of MYEXEC. The zoom is then dynamically assigned to those columns.
<EPILOG>
EXEC MYEXEC
ZOOMCOLS=X
<EPILOGEND>

Popup keywords
The keywords described in this section are used in popup panels.
**DISPLAYWHEN**
Causes a popup panel to be redisplayed when you return to the popup panel from a called workspace or action.

**DISPLAYWHEN** = **RETURN**

**Example**
The popup panel that lists the filter summary uses DISPLAYWHEN to redisplay the list when the Filter Details popup panel is closed. The filter popup panel also uses QUERYWHEN to redisplay the calling workspace:

**QUERYWHEN** (popup panel)
In a popup panel, forces data collection in the calling workspace when the popup panel is closed.

**QUERYWHEN** = **RETURN**

By default, data collection occurs only when the Enter key is pressed and no screen operations are requested. (Screen operations include pulldown or popup panels, collapsing and expanding, minimizing and maximizing, scrolling, or backwards navigation.)

---

**Variables in panel definitions**
Some panel definition keywords (such as HEADER, TRAILER, QUERY, ACTION) allow the use of variables. The enhanced 3270 user interface supports both system and user-defined variables.

**Variable representation**
The enhanced 3270 user interface supports the standard z/OS variable format: &varname

For example,
```plaintext
HEADER='PLEX:&ZSYSPLEX VER(&ZOMEGVRM) LPAR:&ZSYSID'
```

which results in the following string appearing in the header:
```plaintext
PLEX:LPAR400J VER(V700) LPAR:SP22
```

---

**System variables**
The enhanced 3270 user interface supports the use of both ISPF and OMEGAMON-specific system variables. These variables are discovered automatically.

Table 2 lists the supported ISPF variables. These variables are documented in ISPF Reference Summary (SC34-4816), Chapter 6. System Variables.

**Table 2. ISPF variables supported by the enhanced 3270 interface**

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZUSER</td>
<td>User ID</td>
</tr>
</tbody>
</table>
Table 2. ISPF variables supported by the enhanced 3270 interface  (continued)

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZSYSID</td>
<td>LPAR name</td>
</tr>
<tr>
<td>ZSYSPLEX</td>
<td>Sysplex name</td>
</tr>
<tr>
<td>ZAPPLID</td>
<td>Applid of application</td>
</tr>
<tr>
<td>ZIPADDR</td>
<td>IP address</td>
</tr>
<tr>
<td>ZIPPORT</td>
<td>IP port</td>
</tr>
<tr>
<td>ZSPLIT</td>
<td>Split-screen mode in effect (YES or NO)</td>
</tr>
<tr>
<td>ZTS</td>
<td>Multicultural support time separator character (:)</td>
</tr>
<tr>
<td>ZSCREENW</td>
<td>Screen width</td>
</tr>
<tr>
<td>ZSCREEND</td>
<td>Screen length</td>
</tr>
<tr>
<td>ZDATEF</td>
<td>Date MM/DD/YYYY</td>
</tr>
<tr>
<td>ZSTDYEAR</td>
<td>4-digit year YYYY</td>
</tr>
<tr>
<td>ZYEAR</td>
<td>2-digit year YY</td>
</tr>
<tr>
<td>ZMONTH</td>
<td>2-digit month MM</td>
</tr>
<tr>
<td>ZDAY</td>
<td>2-digit day DD</td>
</tr>
<tr>
<td>ZDAYOFWK</td>
<td>Full word day of week</td>
</tr>
<tr>
<td>ZJDATE</td>
<td>Julian date YY.DDD</td>
</tr>
<tr>
<td>ZJ4DATE</td>
<td>Julian date with 4 digit year YYYY.DDD</td>
</tr>
<tr>
<td>ZCS</td>
<td>Currency symbol</td>
</tr>
<tr>
<td>ZTHS</td>
<td>Thousands separator</td>
</tr>
<tr>
<td>ZTIME</td>
<td>5-digit time HH:MMM</td>
</tr>
<tr>
<td>ZCMDLINE</td>
<td>Contains whatever is entered on the command line, in all upper case.</td>
</tr>
<tr>
<td>ZCMDLINEMC</td>
<td>Contains whatever is entered on the command line, in mixed case.</td>
</tr>
</tbody>
</table>

Table 3 lists the OMEGAMON-specific variables that are supported by the enhanced 3270 user interface.

Table 3. Supported OMEGAMON variables

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZJOBNAME</td>
<td>Started task name</td>
</tr>
<tr>
<td>ZVTAMNETID</td>
<td>VTAM net ID</td>
</tr>
<tr>
<td>ZVTAMSSCP</td>
<td>VTAM subsystem control point</td>
</tr>
<tr>
<td>ZIPHOSTNAME</td>
<td>IP host name</td>
</tr>
<tr>
<td>ZOMEGVRM</td>
<td>OMEGAMON version level</td>
</tr>
<tr>
<td>ZOMEGLVL</td>
<td>OMEGAMON build level</td>
</tr>
<tr>
<td>ZDOW</td>
<td>3-letter day of week</td>
</tr>
<tr>
<td>ZACTIONFILTER</td>
<td>Optionally set by a REXX EXEC to an array of one or more alphanumeric characters that map to the ACTION command characters.</td>
</tr>
<tr>
<td><strong>ZFILTERnn</strong></td>
<td>Specifies the filter for filtering at the agent (where FILTERWHERE=AGENT). <em>nn</em> is a 2-digit number from 01 to 10. The value of the variable must be a column name followed by a comparator, followed by a value. Column names can be 1 to 10 characters, with no trailing blanks. Comparators can be one of the following four symbols: =, &lt;, &gt;, or &lt;&gt;, with no trailing blanks. Values can be alphanumeric and can currently support a trailing asterisk. For example: SET ZFILTER01=CICSNAME=C* SET ZFILTER02=SOS=1 SET ZFILTER03=TASKS&gt;100</td>
</tr>
<tr>
<td><strong>ZHEADER</strong></td>
<td>For header in message popup panels. Supports up to 46 bytes. For use with ZMESSAGE.</td>
</tr>
<tr>
<td><strong>ZMESSAGE</strong></td>
<td>General purpose message service for display on screen. Supports up to 256 bytes. For use with ZHEADER.</td>
</tr>
<tr>
<td><strong>ZOMEGLOCK1</strong></td>
<td>If the value is set to N, unlocks the plex field in the workspace so the value can be overtyped. As you navigate forward, the new value is perpetuated and the field is locked again.</td>
</tr>
<tr>
<td><strong>ZOMEGLOCK2</strong></td>
<td>If the value is set to N, unlocks the system field in the workspace so the value can be overtyped. As you navigate forward, the new value is perpetuated and the field is locked again.</td>
</tr>
<tr>
<td><strong>ZOMEGNAV1</strong></td>
<td>The plex for which data is being displayed.</td>
</tr>
<tr>
<td><strong>ZOMEGNAV2</strong></td>
<td>The system, region, or subsystem for which data is being displayed.</td>
</tr>
<tr>
<td><strong>ZQUERY</strong></td>
<td>Engages or disengages a query being driven. The REXX EXEC that builds the data field used in the query also sets ZQUERY=YES. The subpanel is coded with QUERYWHEN=ZQUERY so it is driven only when the variable is set (that is, with a positive value like YES). If ZQUERY is null, the query is not driven.</td>
</tr>
<tr>
<td><strong>ZSELACTION</strong></td>
<td>Passed into a REXX EXEC in an ONACTION stanza, contains the single character entered by the user. (May be null if user pressed PF3.)</td>
</tr>
<tr>
<td><strong>ZVIEWSnn</strong></td>
<td>Specifies the filter for filtering existing data (where FILTERWHERE=LOCAL). <em>nn</em> is a 2-digit number from 01 to 10. The value of the variable must be a column name followed by a comparator, followed by a value. Column names can be 1 to 10 characters, with no trailing blanks. Comparators can be one of the following four symbols: =, &lt;, &gt;, or &lt;&gt;, with no trailing blanks. Values can be alphanumeric and can currently support a trailing asterisk. For example: SET ZVIEW01=CICSNAME=C* SET ZVIEWS02=SOS=1 SET ZVIEWS03=TASKS&gt;100</td>
</tr>
<tr>
<td><strong>ZCLRBOXL</strong></td>
<td>Color variable for box lines.</td>
</tr>
<tr>
<td><strong>ZCLRABAR</strong></td>
<td>Color variable for the action bar.</td>
</tr>
</tbody>
</table>
ZCLRCMDL Color variable for command line
ZCLRABKW Color variable for action bar keywords
ZCLRPANH Color variable for panel header
ZCLRPKEY Color variable for panel keywords
ZCLRPID Color variable for panel ID
ZCLRPANT Color variable for panel trailer
ZCLRSUBH Color variable for subpanel header
ZCLRTXT Color variable for standard text
ZCLRCOLH Color variable for column headers
ZCLRPB Color variable for push buttons
ZCLRGOOD Color variable for status OK/Good
ZCLRWARN Color variable for status Warning/caution
ZCLRERRC Color variable for status Error/Critical

Note: Use color variables instead of hard coding a color in an ISPF attribute

User-defined variables

The enhanced 3270 user interface supports the use of user-defined variables. Variables can be created and set anywhere in a workspace definition using a SET statement. In addition, columns names specified using the KEYCOLS keyword in a previously invoked workspace can be used as variables in subsequent panels, without using a SET statement.

Variables can be set anywhere in a definition, but they are processed differently depending upon where the SET statement appears.

- Variables set in an ALIASCOMMANDS stanza can be used in fastpath commands from that workspace, if SCOPE=LOCAL, or from any workspace after they have been defined until they are deleted, if SCOPE=GLOBAL.
- Variables set in PROLOG stanzas are assigned during PROLOG execution. Assignment occurs after any imbeds and before data collection. If a REXX exec is also present, the SET commands are evaluated according to their placement, before, or after, the REXX EXEC call.
- Variables set in EPILOG stanzas are assigned during EPILOG execution. Assignment occurs after data collection or status assessment and before the screen is constructed. If a REXX exec is also present, the SET commands are evaluated according to their placement, before, or after, the REXX EXEC call.
- Variables set in an ONACTION stanza are executed directly after key column assignment, and just before any navigation that results from an action command. (Key columns are assigned before navigating forward if any action command is driven from a particular subpanel.)
- Variables set anywhere else are processed when the workspace is loaded.

Variable names may consist of up to 16 characters.

Note: Do not create variables that begin with Z (or z). That letter is reserved for system variables.

Variable data may consist of up to 64 characters and can be set to specified values or to other variables. For example:

SET &var1=mytext
SET &var2=&colname

There is a limit of 20 deferred SET commands for a workspace. (Deferred SET commands are those in PROLOG, EPILOG, and ONACTION stanzas.)
Example: column names as variables

Column names specified using the KEYCOLS keyword in a previously invoked panel can be used as variables in subsequent panel definitions, without using a SET statement. For example, if the following column names have been set in a previous panel:

```
KEYCOLS='TRANID,USERID,TASKNO,TERMID,CICSNAME,SYSTEMID,ORIGINNODE'
```

one or more of these names can be used as variables in a header, query, or any text in a panel navigated to from the first panel. For example:

```
HEADER='Details for Transaction &TRANID Task &TASKNO'
QUERY='SELECT TRANID, TASKNO, RTYPE, RNAME, STATE, CPUTIME, SUSPTIME, ELAPTIME, CICSTRD.USEDA16, USEDB16, ATCHTIME, TIMEOFSU, SUSPDUE, FACTYPE, FACID, ORIGTRID, UMBTRID, QUEUE, FIRSTPGM, CURRPGM, USERID, EXECCMD, PURGEABL, PURGSTAT, SUSPTYPE, UOWSTATE, FROM OMCICS.CICSTRD, WHERE ORIGINNODE = "&SYSTEMID.&CICSNAME" AND CICSTRD.TRANID = "&TRANID" AND CICSTRD.TASKNO = "&TASKNO".'
```

Supported ISPF statements

The enhanced 3270 user interface supports a subset of ISPF statements.

The following statements are supported in an ISPF stanza in a subpanel or popup panel:

- )LIST
- )BODY
- )INIT
- )ATTR
- )PROC
- )PNTS
- )END

LIST supports the following arguments:

- POPUPACTION
  Lists the actions in a subpanel in the popup panel definition.

- PANELACTION
  Lists the actions in the subpanel from which the popup panel was invoked.

- DYNAMIC
  Lists actions from dynamically generated list, such as a list generated by a REXX exec.

- TRACETABLE
- STACK

BODY supports the following arguments:

- WIDTH (n)
- WINDOW (DYNAMIC|width,depth)

)ATTR supports the following field types:

- INPUT
- OUTPUT
- TEXT
• PS (Point-and-Shoot)

)ATTR supports the following keywords:
• CAPS
• COLOR
• HILITE
• JUST
• INTENS
• SKIP

)INIT supports up to 32 system (Z) variables.
Appendix B. Tags for formatting text

The enhanced 3270 user interface supports the use of a small subset of HTML tags and some proprietary tags that can be used to format the text specified using the TEXT keyword in a subpanel of TYPE=TEXT.

Note that formatting is not required. Freeform text is supported in these subpanels.

**HTML tags**

The enhanced 3270 user interface supports use of the HTML tags shown in Table 4.

<table>
<thead>
<tr>
<th>Type</th>
<th>Tagging</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading</td>
<td><code>&lt;h1&gt;&lt;/h1&gt;</code></td>
<td>Text enclosed by h1 tags is displayed in all capitals and is followed by a line break. The text can be centered using a <code>&lt;center&gt;</code> tag. For example: <code>&lt;h1&gt;&lt;center&gt;TEXT IN CAPS&lt;/h1&gt;</code></td>
</tr>
<tr>
<td>Paragraph</td>
<td><code>&lt;p&gt;&lt;/p&gt;</code></td>
<td>Inserts two line breaks (that is, an empty line) before the text.</td>
</tr>
<tr>
<td>Unordered list</td>
<td><code>&lt;ul&gt;&lt;/ul&gt;</code></td>
<td>Displays the list items between the tags in a bulleted list.</td>
</tr>
<tr>
<td>Ordered list</td>
<td><code>&lt;ol&gt;&lt;/ol&gt;</code></td>
<td>Displays the list items between the tags in a sequentially numbered list.</td>
</tr>
<tr>
<td>List items</td>
<td><code>&lt;li&gt;&lt;/li&gt;</code></td>
<td>Contains the text for an entry in a bulleted or numbered list.</td>
</tr>
<tr>
<td>Line break</td>
<td><code>&lt;br&gt;</code></td>
<td>Forces a line break. Can be used to create an empty line.</td>
</tr>
<tr>
<td>Hypertext link</td>
<td><code>&lt;a href=&quot;panelid&quot;&gt;&lt;/a&gt;</code></td>
<td>Text enclosed by the <code>&lt;a&gt;</code> (anchor) tags is white (selectable) and underlined. Cursoring over the text and pressing Enter displays the workspace referenced. Only links to other workspace panels are supported.</td>
</tr>
<tr>
<td>Emphasis</td>
<td><code>&lt;em&gt;&lt;/em&gt;</code></td>
<td>Text enclosed by the tags is underlined.</td>
</tr>
<tr>
<td>Comment</td>
<td><code>&lt;!– –&gt;</code></td>
<td>Text is not displayed.</td>
</tr>
</tbody>
</table>

Spaces between words within tags are preserved, so spaces can be used to align text.

**Additional tags**

The enhanced 3270 user interface supports the proprietary formatting tags shown in Table 5.

<table>
<thead>
<tr>
<th>Type</th>
<th>Tagging</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td><code>&lt;color=color&gt;&lt;/color&gt;</code></td>
<td>Can be placed around any word or element. The color is in effect until the end tag or the end of the subpanel if there is no end tag. Any color name supported by the 3270 interface is supported.</td>
</tr>
<tr>
<td>Alignment</td>
<td><code>&lt;center&gt;</code></td>
<td>Centers text. The center alignment is in effect until the end tag for the element.</td>
</tr>
</tbody>
</table>

**Example**

The following example shows the use of the TEXT keyword to specify the text to appear in the subpanel.
<h1><center>This is a centered H1 Header</center></h1>
<br>
Welcome to SYSPLEX &ZSYSPLEX. 

Appendix C. Accessibility features for OMEGAMON enhanced 3270 user interface

Accessibility features help users who have a disability, such as restricted mobility or limited vision, to use information technology products successfully.

The major accessibility features in this product enable users in the following ways:

• Use assistive technologies, such as screen-reader software and digital speech synthesizer, to hear what is displayed on the screen. Consult the product documentation of the assistive technology for details on using those technologies with this product.
• Operate specific or equivalent features using only the keyboard.
• Magnify what is displayed on the screen.

In addition, the product documentation was modified to include the following features to aid accessibility:

• All documentation is available in both HTML and convertible PDF formats to give the maximum opportunity for users to apply screen-reader software.
• All images in the documentation are provided with alternative text so that users with vision impairments can understand the contents of the images.

Accessibility features

The following list includes the major accessibility features supported by the OMEGAMON enhanced 3270 interface:

• Keyboard-only operation
• Interfaces that are commonly used by screen readers
• Keys that are discernible by touch but do not activate just by touching them
• Industry-standard devices for ports and connectors
• The attachment of alternative input and output devices


Navigating the interface using the keyboard

Standard shortcut and accelerator keys are used by the product and are documented by the terminal emulator product. See the documentation provided by your terminal emulator for more information.

Magnifying what is displayed on the screen

The enhanced 3270 user interface can be used with any 3270 emulator that supports the APL character set. The interface supports screen sizes of 24 x 80, 32 x 80, 43 x 80, 27 x 132, and 62 x 160. Choose the resolution that best suits your requirements.

Interface information

The OMEGAMON enhanced 3270 user interface supports all the accessibility features supported by your emulator. If you are using IBM Personal Communications, you can find information on its accessibility features at http://publib.boulder.ibm.com/infocenter/pcomhelp/v6r0/index.jsp?topic=/
IBM and accessibility

See the IBM Human Ability and Accessibility Center for more information about the commitment that IBM has to accessibility.
Appendix D. Associating a mouse click with the Enter key

Many 3270 emulators support an option to associate a mouse click with the Enter key.

About this task

You might prefer to associate a mouse click with the Enter key in your 3270 emulator session. After you make this association, in contexts where you normally “click and enter”, you can instead “double click.”

Procedure

Locate point and select or mouse click configuration options for your emulator. For example, in an IBM Personal Communications emulator window, select Edit > Preferences > Hotspots. The Hotspots Setup window opens. Select ENTER at cursor position and click OK.

Results

You can now “double click” with your mouse in place of clicking and pressing Enter for your 3270 emulator session.
Documentation library

This appendix contains information about the publications related to IBM Tivoli Monitoring and to the commonly shared components of Tivoli Management Services.

These publications are listed in the following categories:

- IBM Tivoli Monitoring library
- Related publications


To find a list of new and changed publications, click What’s new on the Welcome page of the IBM Tivoli Monitoring and OMEGAMON XE Information Center. To find publications from the previous version of a product, click Previous versions under the name of the product in the Contents pane.

Shared OMEGAMON XE publications

The publications in this library provide information common to OMEGAMON XE products that are installed on z/OS.

- IBM Tivoli OMEGAMON XE Monitoring Agents on z/OS: Quick Start Guide, GI13-2314
  Summarizes the installation and setup of an OMEGAMON XE monitoring agent on z/OS.

- IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: Common Planning and Configuration Guide, SC22-5484
  Gives instructions for planning and configuration tasks common to the components of Tivoli Management Services on z/OS and the OMEGAMON XE monitoring agents on z/OS.

- IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: Upgrade Guide, SC22-5486
  Gives instructions for complete and staged upgrades to V4.2.0 and V5.1.0 of the OMEGAMON XE products.

- IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: Common Parameter Reference, SC22-5482
  Provides reference information on parameters used for setting up runtime environments and configuring hub and remote Tivoli Enterprise Monitoring Servers on z/OS, including detailed descriptions of the PARMLIB parameters.

- IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: PARMGEN Reference, SC22-5483
  Provides detailed instructions and common configuration scenarios for creating and maintaining runtime environments using the PARMGEN configuration method.

- IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: Tivoli OMEGAMON Enhanced 3270 User Interface Guide, SC22-5487
  Describes the features of the OMEGAMONenhanced 3270 user interface and provides operating instructions and reference material.

- IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: End-to-End Response Time Feature Reference, SC27-2303
  Provides instructions and reference information for the End-to-End Response Time Feature, which supplies response time data to several OMEGAMON XE products.
IBM Tivoli OMEGAMON XE and Tivoli Management Services on z/OS: Reports for Tivoli Common Reporting, SC27-2304

Explains how to use the Tivoli Common Reporting tool to create reports from data displayed in the Tivoli Enterprise Portal and stored in the Tivoli Data Warehouse database.

**IBM Tivoli Monitoring library**

The publications in this library provide information about the components of Tivoli Management Services (IBM Tivoli Monitoring) that are installed on distributed platforms.

- **Quick Start Guide**
  Introduces the components of IBM Tivoli Monitoring.

- **Installation and Setup Guide, SC22-5445**
  Provides instructions for installing and configuring IBM Tivoli Monitoring components on Windows, Linux, and UNIX systems.

- **High Availability Guide for Distributed Systems, SC22-5455**
  Gives instructions for several methods of ensuring the availability of the IBM Tivoli Monitoring components.

- **Administrator’s Guide, SC22-5446**
  Describes the support tasks and functions required for the Tivoli Enterprise Portal Server and clients, including Tivoli Enterprise Portal user administration.

- **Command Reference, SC22-5448**
  Provides detailed syntax and parameter information, as well as examples, for the commands you can use in IBM Tivoli Monitoring.

- **Messages, SC22-5450**
  Lists and explains messages generated by all IBM Tivoli Monitoring components and by z/OS-based Tivoli Management Services components (such as Tivoli Enterprise Monitoring Server on z/OS, the OMEGAMON enhanced 3270 user interface, and TMS:Engine).

- **Troubleshooting Guide, GC22-5449**
  Provides information to help you troubleshoot problems with the software, including Tivoli Management Services on z/OS components.

- **Tivoli Enterprise Portal online help**
  Provides context-sensitive reference information about all features and customization options of the Tivoli Enterprise Portal. Also gives instructions for using and administering the Tivoli Enterprise Portal.

- **Tivoli Enterprise Portal User’s Guide, SC22-5447**
  Complements the Tivoli Enterprise Portal online help. The guide provides hands-on lessons and detailed instructions for all Tivoli Enterprise Portal features.

- **Agent Builder User’s Guide, SC32-1921**
  Explains how to use the Agent Builder for creating monitoring agents and their installation packages, and for adding functions to existing agents.

- **Tivoli Universal Agent User’s Guide, SC32-9459**
  Introduces you to the IBM Tivoli Universal Agent, an agent of IBM Tivoli Monitoring. The IBM Tivoli Universal Agent enables you to use the monitoring and automation capabilities of IBM Tivoli Monitoring to monitor any type of data you collect.

- **Performance Analyzer User’s Guide, SC27-4004**
  Explains how to use the Performance Analyzer to understand resource consumption trends, identify problems, resolve problems more quickly, and predict and avoid future problems.

- **IBM Tivoli Universal Agent API and Command Programming Reference Guide, SC32-9461**
Explains the procedures for implementing the IBM Tivoli Universal Agent APIs and provides descriptions, syntax, and return status codes for the API calls and command-line interface commands.

**Documentation for the base agents**

If you purchased IBM Tivoli Monitoring as a product, you received a set of base monitoring agents as part of the product. If you purchased a monitoring agent product (for example, an OMEGAMON XE product) that includes the commonly shared components of Tivoli Management Services, you did not receive the base agents.

The following publications provide information about using the base agents.

- **Operating system agents:**
  - *UNIX OS Agent User’s Guide*, SC22-5452
- **Agentless operating system monitors:**
- **Warehouse agents:**
- **System P agents:**
- **Other base agents:**
  - *Systems Director base Agent User’s Guide*, SC27-2872

**Other sources of documentation**

You can obtain technical documentation about OMEGAMON XE and related products from a number of additional sources.

- **Service Management Connect (SMC)**
  
  For introductory information about SMC, see [IBM Service Management Connect](http://www.ibm.com/developerworks/servicemanagement).

  Connect, learn, and share with Service Management professionals. Get access to developers and product support technical experts who provide their perspectives and expertise. Using SMC, you can:
  - Become involved with transparent development, an ongoing, open engagement between external users and developers of Tivoli products where you can access early designs, sprint demos, product roadmaps, and pre-release code.
- Connect one-on-one with the experts to collaborate and network about Tivoli and Integrated Service Management.
- Benefit from the expertise and experience of others using blogs.
- Collaborate with the broader user community using wikis and forums.

The [System z community](https://www.ibm.com/developerworks/servicemanagement/z/index.html) should be of particular interest.

- **IBM Integrated Service Management Library**
  IBM Integrated Service Management Library is an online catalog that contains integration documentation and other downloadable product extensions.

- **Redbooks®**
  IBM Redbooks and Redpapers include information about products from platform and solution perspectives.

- **Technotes**
  Technotes provide the latest information about known product limitations and workarounds. You can find Technotes through the IBM Software Support Web site at [http://www.ibm.com/software/support/](http://www.ibm.com/software/support/)
Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be displayed.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information was published. Such trademarks may also be registered or common law trademarks in other countries. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Windows is a trademark of Microsoft Corporation in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
each user’s user name for purposes of session management, authentication, and single sign-on
configuration. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, See
IBM’s Privacy Policy at [http://www.ibm.com/privacy] and IBM’s Online Privacy Statement at
Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at
## Index

### Special characters

- `<ALIASEND>` tag 96
- `<WORKSPACE>` tag 96
- `<WORKSPACEEND>` tag 96
- `&varname` 124

### A

About this publication
- who should read this publication 1
- accessibility features for this product 133
- action codes 18
- `ACTION` keyword 103
- `ACTIONBAR` stanza 74

Administration
- Hub connectivity administration 67
- profiles 67
- RTE viewing 67
- Workspace source viewing 67

Administrative workspaces
- browsing workspaces 37
- cloning a profile 71
- cloning a workspace 36
- cloning thresholds 59
- profile viewing and cloning 70
- threshold viewing and cloning 56
- user profile customization 27
- viewing workspace source 69
- workspace viewing and cloning 35

Administrative workspaces hub connectivity 75
- `ALIASCOMMANDS` tag 96
- all known hubs workspace 83
- auto update 25
- `AUTOSELECT` keyword 104

### B

- `BOXBOTTOM` 104
- `BOXTOP` 104

### C

- changing a hub server connection 81
- cloning a profile 71
- cloning a workspace 36
- cloning thresholds 59
- closing subpanels 24
- `COLHEADERS` 105
- collapsing subpanels 24
- colors, workspace 16, 17
- `COLUMN` 105
- `COLUMN132` keyword 105
- `COLUMN160` keyword 105
- commands
  - Take Action 18
  - comparators 22
  - Compare field 22

### D

- default locale profile 74
- `developerWorks` 139
- `DISPLAYCOLS` keywords 106
- displaying the data retrieval agents 91
- displaying the hub overview status 87
- displaying the installed products 88
- displaying the managed system lists 90
- displaying the managed system names 89
- `DISPLAYOPTION` keyword 108

### E

- emulators
  - mouse click to enter key 135
  - emulators, supported 4
  - `EXPANDCOLAPS` keyword 109
  - expanding subpanels 24

### F

- fastpath navigation 26
- `FILTERCOLS` keyword 109
- `FILTERNULLVAL` keyword 110
- filters 22
- `FILTERSTRIP` keyword 110
- `FILTERVIEW` keyword 110
- `FILTERVIEWS` keyword 111
- `FILTERWHERE` keyword 111
- `FOOTER` keyword 112
- formatting tags 131

### G

- guidelines for panel definitions 99

### H

- `HEADER` keyword 101, 112
- `HOME` command 26
- Hub connectivity administration 67
  - context, changing 25
  - cookies 142
  - correcting a failed connection 31, 76, 78
  - creating custom workspaces 35
  - creating interface profiles 70
  - creating locale profiles 74
  - `CUASITE` profiles 69
  - `CURSOR` keyword 100
  - `CURSORREFRESH` keyword 100
  - custom profiles 69
  - Customization 35
  - customize thresholds 35
  - customize workspaces 35
  - customizing thresholds 56, 57
  - `hub Tivoli Enterprise Monitoring Server` 31, 76, 78, 81, 83, 87, 88, 89, 90, 91, 92
  - validating 75
  - hub topology 92

### I

- `IF` keyword 62
- `IMBED` keyword 101
- initial workspace
  - `KOBSITEC` 29
  - initial workspace, customizing 42
  - Integrated Service Management Library 139
  - interface profiles 69
  - creating 70
  - `ISPF` variables 124

### J

- `JOINPREV` keyword 112

### K

- `KEYCOLS` 112
- keyword, `IF` 62
- keywords 100
  - `COLUMN132` 105
  - `COLUMN160` 105
  - `FILTERVIEWS` 111
  - locale profile 74
  - `MODE` 102
  - `NAME` 114
  - `NAV1TEXT` 102
  - `NAV2TEXT` 102
  - `PARTIALCOLS` 114
  - `popup panel` 124
  - `SCROLLCOLS` 116
  - `SCROLLROWS` 117
  - `TEXT` 119
  - `KOBSCUA` 69
  - `KOBSCUA Profile` 69
  - `KOBGENUS` 69
  - `KOBSCUA` 29

### L

- lateral scrolling 20
- libraries
  - `OMEGAMON` XE shared publications 137
  - `LINES` keyword 113
  - locale profile
    - `ACTIONBAR stanza` 74
    - `keywords` 74
    - `LOCALE` stanza 74
    - locale profiles 74
    - creating 74

© Copyright IBM Corp. 2012, 2013
maximizing subpanels 23
menus 13
minimizing subpanels 23
MINMAX keyword 113
MODE keyword 102
MODE keyword (subpanel) 114
modifying thresholds 56
NAME keyword 114
NAV1TEXT keyword 102
NAV2TEXT keyword 102
scolling 26
scroll sizes, supported 4
SCROLLBAR keyword 116
SCROLLCOLS 116
scrolling, lateral 20
SCROLLROWS 117
scrolling, lateral 20
service 1
service management connect 1
Service Management Connect 139
setting the auto update interval 25
shared publications 137
SHOWNAV command 26
SHOWNAV command 26
SKIP 117
SMC 1, 139
SORTCOLUMNS keyword 117
SORTCOLUMNS keyword 117
sorting 21
SPACE keyword 117
STARTCOLUMNS keyword 117
STARTMIN keyword 118
STATICCOLUMNS keyword 118
status lights 15
status lights 15
subpanel keywords
MODE 114
subpanels
closing 24
collapsing 24
expanding 24
maximizing 23
minimizing 23
support 1
system variables 124
Take Action commands 18
Technotes 139
TEXT keyword 119
threshold viewing and cloning 56
thresholds (continued)
acceptable formats 61
customizing 56, 57
disabling 61
modifying 56
parameter definitions 62
parameters 61
syntax 61
TOFROMHEADER keyword 119
TYPE keyword 120
User Preferences 27
user profile customization 27
user-defined profiles 69
user-defined variables 127
Value field 22
variable representation 124
variables 124
user-defined 127
viewing workspace source 69
VSEPARATORS 122
WHENDATA keywords 122
WHENNOTDATA keywords 123
WHENNOTHEADER keyword 103
WHENNOTTEXT keyword 103
WHEREAMI command 26
workspace customization 41
adjusting the filterable columns 51
Allotted subpanel row count 53
change a column caption and
width 48
change a workspace and subpanel header 45
change the order of displayed columns 47
customizing a workspace 43
further workspace customization 52
Local or agent filter definitions 54
Number and order of workspace subpanels 55
Number of columns displayed 53
remove a subpanel 50
Statically defined columns 53
Workspace initial and refresh cursor position 52
Workspace sort columns 54
workspace keywords
IMBED 101
workspace operations
sorting data 21
workspace panel definitions 96
Workspace source viewing 67
workspace viewing and cloning 35
workspace customization 41
workspaces parts of 9